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Растр и вектор 

Существуют два принципиально различных способа работы с графикой. 
В векторной графике изображение представляется в виде набора объектов или 
фигур, геометрия которых описывается математическими формулами. Множество 
возможных объектов (их называют иногда примитивами), из которых строятся 
изображения ограничено. В этот набор входят простые геометрические фигуры: 
линии, треугольники, прямоугольники, многоугольники, овалы и некоторые другие 
формы. Оперируя примитивами и их атрибутами оформления, можно получать 
изображения различного содержания и сложности. Такой подход к рисованию, 
который по своей технике обращения с элементами напоминает конструирование, 
реализован в так называемых векторных редакторах. Среди современных 

программ этого типа наибольшее распространение получили редактор Corel 

Draw производства канадской фирмы Corel и пакет Illustrator, 

разработанный корпорацией Adobe. 

Трудно составить исчерпывающий перечень применений векторной графики. 
Логотипы, эмблемы, фирменные знаки, стилизованные рекламные надписи, 
планы, схемы, чертежи, денежные знаки, ценные бумаги, эскизы одежды и многое 
другое - все эти объекты графики целиком или в значительной степени являются 
продуктами векторных редакторов. 

Если провести инвентаризацию достоинств и недостатков векторной графики, то у 
нее обнаружится множество преимуществ: хорошая масштабируемость, 
небольшие размеры графических файлов, независимость от среды визуализации, 
высокая скорость обработки, невысокие требования к вычислительным ресурсам и 
многое другое. Всего лишь два принципиальных недостатка мешают присудить 
этому способу описания графики победу за явным преимуществом. Это 
невозможность создания реалистичных изображений и сложность описания 
геометрии. 



Есть и иной подход к описанию графики. В растровой графике любое изображение 
представляется в виде совокупности точек небольшого размера - растра. Эти 
элементарные частички изображения называются пикселями (от английского 
picture element или picture cell). Множество пикселей небольшого размера на 
некотором удалении воспринимается наблюдателем как целостный образ, а не как 
массив точек. 

Не существует ограничений на применения этого способа описания графики. В 
виде совокупности точек можно представить пейзажный снимок, фотопортрет, 
оцифрованный рисунок и многое другое. 

Потребительские свойства вектора и растра удивительным образом дополняют 
друг друга: сильные стороны одного способа описания - это слабости другого и 
наоборот. 

Примитивный способ организации растровых рисунков нисколько не мешает их 
способности представлять сложные композиции и образы предельной 
реалистичности, например, натурные фотографии. Растровые рисунки легко 
интерпретируются компьютерными программами. Эта стало одной из причин 
широкого распространения растровых форматов во всемирной сети Интернет.  

В точных науках существует формула "при прочих равных условиях". Она 
позволяет автору провести сравнение в приблизительно равных условиях, 
которые часто не достижимы в реальности, воспроизводимы только в мыслимом 
эксперименте. Если применить эту формулу для сравнения размеров векторных и 
растровых файлов, то окажется, что растр - это более громоздкая структура, 
которая требует для своего хранения и обработки больших вычислительных 
ресурсов. 

Точечная графика отличается высокой чувствительностью к геометрическим 
преобразованиям. Этот тезис легко подтвердить в следующем простом мысленном 
испытании. Представим себе, что на некоторый носитель (например, холст из 
резины), обладающий неограниченной способностью к растяжению, нанесена 
сетка из точек небольшого размера, которая в своей совокупности образует 
некоторый образ. 

 



 

Рис. 1.1. Деградация качества растрового изображения при значительном 

увеличении 

Что произойдет, если этот носитель подвергнуть значительному растяжению? 
Размеры точек увеличатся и, при достижении некоторого коэффициента 
масштабирования, ранее незаметная точечная структура станет очевидной для 
наблюдателя (рис. 1.1). Это приведет к потере качества изображения. Некоторые 
растровые оригиналы претерпевают определенную деградацию при повороте, 
наклоне и других геометрических преобразованиях. 

Развернутое обсуждение недостатков растровой графики не должно стать 
основанием для вывода об ущербности этого направлении информатики. Это 
отрасль компьютерной графики, которая продолжает постоянно развиваться. 

Принципы синтеза цвета 

Информация о цвете и яркости точек растрового изображения хранится в 
двоичном виде. Чтобы правильно интерпретировать эти данные одних кодовых 
значений недостаточно. Действительно, пусть некоторый пиксел описывается 
числом 24, заданным в двоичной системе счисления. Это может означать величину 
тона, значение цвета и номер краски в некоторой библиотеке стандартизованных 
цветов. Для правильной расшифровки кодов точек, составляющих изображение, 
требуется договориться о правилах их интерпретации. Такие соглашения вводятся 
при помощи задания цветовых моделей. Цветовая модель фиксирует правила 
расшифровки и обработки кодовых слов растровой картинки. 

Все распространенные цветовые модели в зависимости от их особенностей и 
области применения можно разделить на три группы: 

 аппаратно-зависимые - модели, используемые в технических средствах ввода-
вывода графической информации; 

 аппаратно-независимые - модели, не связанные с конкретным воспроизводящим 
устройством, они описывают цвет в абстрактных колориметрических терминах. 
Эти модели предложены международной комиссией по 

освещению CIE (Commission Internationale d'Eclairage), их широко 

применяют в теоретических исследованиях и системах управления цветом; 

 интуитивные - модели, построенные на основе субъективного восприятия цвета 
человеком. 

В технических средствах используются два типа цветных объектов 
- самосветящиеся, излучающие объекты (экраны электронно-лучевых трубок, 
плазменные панели, матрицы светодиодов) и несамосветящиеся объекты, 
отражающие или преломляющие падающий на них свет (бумажные оттиски, 
светофильтры и т.п.). 

Для излучающих объектов используется аддитивный принцип синтеза, когда 
требуемый цвет формируется за счет смешения основных (несводимых) цветовых 
оттенков. В этом случае целесообразно использовать модель, основанную на 



принципе сложения цветов, которая называется аддитивной моделью. Самой 

известной моделью такого типа является модель RGB. Ее название образовано по 

первым буквам базовых цветовых 

координат Red (красный), Green (зеленый), Blue (синий). 

Цвет несамосветящихся объектов формируется по субтрактивному принципу 
синтеза. Этот цвет образуется как сумма непоглощенных составляющих 
светового потока некоторого внешнего источника. Корректное описание данного 

цветового феномена дает так называемая субтрактивная цветовая модель CMY. 

Ее название образовано по первым буквам цветовых 

координат Cyan (голубой), Magenta (пурпурный), Yellow (желтый). 

 
 

Рис. 1.2. Аддитивный и субтрактивный принципы синтеза цвета 

На рис. 1.2 слева показаны результаты смешения цветов в аддитивной модели для 
трех самосветящихся площадок чистых цветов (красного, зеленого и синего). С 
правой стороны этого рисунка представлены результаты смешения цветов в 
субтрактивной модели для трех несамосветящихся площадок чистых цветов 
(голубого, пурпурного и желтого). 

Приведем основные правила сложения цветовых координат, которые описывается 
восемью простыми формулами: 

1. Желтый = Красный + Зеленый; 

2. Белый = Красный + Зеленый + Синий; 

3. Пурпурный = Красный + Синий; 

4. Голубой = Синий + Зеленый; 

5. Красный = Желтый + Пурпурный; 

6. Зеленый = Желтый + Голубой; 

7. Черный = Желтый + Пурпурный + Голубой; 

8. Синий = Пурпурный + Голубой. 



Цвета одной модели являются дополнительными к цветам другой модели. 

Дополнительными (комплиментарными) называется цвета, которые в своей сумме 
дают чистый белый цвет, чистый черный или оттенок серого. Дополнительным для 
красного служит голубой, поскольку голубой получается смешением зеленого и 
синего. Дополнительным для зеленого является пурпурный (пурпурный = красный 
+ синий), для синего - желтый (желтый = красный + зеленый). 

Растровый редактор Photoshop способен обрабатывать изображения, заданные 
при помощи восьми цветовых моделей. Шесть из них способны хранить 
информацию о цвете, остальные предназначены для черно-белых или 
полутоновых изображений. 

Рассмотрим самые востребованные из этих моделей. Названия моделей 

приводятся по их версии в Photoshop. Иногда цветовые модели называют 

цветовыми системами. 

Модель Bitmap 

Моделью Bitmap называется такой способ представления растровой графики, 
когда на каждую точку изображения отводится только по одному двоичному 
разряду. Средствами такого короткого кодового слова можно представить только 
два состояния пиксела. Обычно такими состояниями являются черный и белый 

цвет, поэтому изображения, записанные в Bitmap, называются черно-белыми 

или монохромными (рис. 1.3). Модель не дает возможности представить цвет и 

плавные тоновые градации. Иногда ее называют Black and White, B&W, B&W 

Document, LineArt, и др. 



 
 

Рис. 1.3. Изображение в системе Bitmap. Фрагмент картинки показан с 

четырехкратным увеличением 

Возможности редактирования изображений в режиме Bitmap существенно 
ограничены. Они не могут быть сглажены, к ним не применяются фильтры и 
инструменты размытия, они не могут быть обработаны средствами тонирования и 
настройки резкости. Наконец, что очень важно, такие изображения не могут 
раскладываться на отдельные слои. 

Изобразительные возможности однобитовой модели предельно ограничены. Она 
подходит для ограниченного числа графических примеров и ситуаций. В таком 
виде обычно хранятся текстовые документы, планы, чертежи, штриховая графика, 
некоторые виды карандашных рисунков и пр. 

Редактор Photoshop позволяет свободно менять цветовые модели цифровых 

изображений, но он не разрешает прямой переход в режим Bitmap. Для решения 

этой задачи требуется предварительно перевести картинку в режим Grayscale. 

Модель Grayscale 

Изображения, представленные различным градациями серого, принято назвать 
полутоновыми. Для хранения информации о полутоновых образах используется 

обычно модель Grayscale (рис. 1.4). В ней на каждую точку картинки 

http://www.intuit.ru/EDI/27_04_15_5/1430086749-14056/tutorial/1047/objects/1/files/01-03.jpg


выделяется восемь двоичных разрядов (один байт). В особых случаях для 
изображений высокого качества используется шестнадцать двоичных разрядов 
(два байта) или более. При помощи кодового слова длины 8 можно 

представить  различных состояний или тоновых градаций. Нулевое 
значение соответствует черному цвету, максимальная величина кодового слова, 
равная 255, представляет белый цвет. Промежуточные значения кодируют 
различные по плотности оттенки серого. Максимальный диапазон значений 16-
разрядных изображений намного больше; при помощи двухбайтовой кодировки 

можно представить  градаций серого цвета. 

 
 

 

Рис. 1.4. Изображение в системе Grayscale 

В некоторых растровых редакторах для изображений в градациях серого 
разрешается выбирать количество двоичных разрядов, приходящихся на один 

пиксел. Photoshop разрешает работать только с 8, 16 и 32-битовыми 

изображениями. Все изображения, содержащие менее 8 бит на пиксел, 
автоматически преобразуются в восьмибитовые, а оригиналы с большей глубиной 
- в 16 или 32-битовые. 

Восьмибитовые изображения могут быть сохранены в любом растровом формате; 
для 16-битовых такой свободы нет. Такие оригиналы можно сохранить в 

форматах TIFF, PSD, PDF, RAW и PNG. 

Изображения модели Grayscale обрабатываются в редакторе Photoshop как 

полноценные графические объекты. К ним могут быть применены любые 
инструменты и средства преобразования программы, которые имеют смысл для 
полутоновой графики. 

Модель Indexed Color 

http://www.intuit.ru/EDI/27_04_15_5/1430086749-14056/tutorial/1047/objects/1/files/01-04.jpg


Способ представления точек изображения, принятый в модели Indexed Color 
(Индексированный цвет), отчасти напоминает модель Grayscale. Здесь каждую 
точку представляет кодовое слово длиной восемь битов, но в нее записывается не 
информация о градациях серого, а данные о цвете. Набор всех доступных цветов 
образует палитру из 256 элементов, которые представляют собой выборку из 

полноцветного цветового пространства, которое иногда называют True Color. 

 
 

Рис. 1.5. Примеры цветовых таблиц 

В некоторых ситуациях даже ограниченный набор из 256 цветов оказывается 
избыточным, поэтому встречаются палитры и с меньшим множеством цветов (64, 
32 и пр.). Для выбора цветов палитры используются самые разнообразные 
соображения и правила. Это могут быть стандартные цвета представления 
интерфейсных элементов в некоторой операционной среде или цвета, которые 
правильно отображаются определенными устройствами вывода и др. Часто 
палитру системы Indexed Color называют цветовой таблицей. 

Набор в 256 цветов по сравнению 16-миллионным пространством True Color - это 
совсем немного, но для представления многих мультимедийных объектов и работы 
во всемирной сети достаточно и этой весьма ограниченной палитры. 

Редактор Photoshop поддерживает модель Indexed Color, но накладывает ряд 

серьезных ограничений на операции с такими объектами. Так, к ним не могут быть 
применены фильтры и инструменты тонирования, недоступны все операции со 
слоями и каналами и пр. 

Существуют проблемы, связанные с передачей таких файлов формата Indexed 

Color, в другие приложения. Если цветовые таблицы программ обработки 

графики не совпадают, то возможно частичное или полное рассогласование 
цветов. 



В программах сканирования и обработки растровой графики эта модель может 

именоваться Paletted, 256 Colors, Web Colors и др. 

Модель RGB 

Модель RGB - это самый популярный способ представления графики. По этому 

принципу работают телевизоры, компьютерные мониторы, видеопроекторы и 
многие другие устройства графического вывода. В этой системе все цветовое 

разнообразие формируется сочетанием красного (Red, R) зеленого (Green, G) и 

синего (Blue, B) цветов различной интенсивности. 

 
 

Рис. 1.6. Принцип синтеза цветов в системе RGB 

Цветовое пространство модели RGB можно представить в виде куба в декартовой 
системе координат (рис. 1.6). Каждый цвет в этом кубе задается точкой и 
определяется как сумма трех основных цветов: красного, зеленого и 
синего. Главная диагональ куба с равными количествами каждого основного цвета 
представляет ахроматические (серые) цвета: черному цвету соответствует 
точка (0, 0, 0), а белому - точка (1, 1, 1). Нулевое значение соответствует 
отсутствию светимости цветовой координаты, единичное значение описывает ее 
максимальную интенсивность. Так, белый цвет дает смешение трех цветовых 
координат предельной силы. 

Красный, зеленый и синий принято называть первичными цветами или 
цветовыми координатами, а их представление в программах обработки 
графики - каналами. Каналы, по сути дела, представляют собой 
полутоновые версии изображения, где градации серого цвета 
показывают вклад или интенсивность каждой цветовой координаты. 

Как и изображения в системе Grayscale, каналы описываются 8 двоичными 

разрядами. Поскольку в системе RGB три канала, то на один пиксел 

приходится  двоичных разрядов. Иногда говорят, что глубина 



цвета в этой системе составляет 24 бита. Это позволяет представить более 16 

миллионов цветов ( ) - этого количества вполне достаточно для 
точной передачи полноцветных фотографий или художественных полотен. 

Изображения, заданные системе RGB с глубиной цвета в 24 бита, - это 

полноценные объекты, которые не имеют ограничений на обработку в растровых 
редакторах.  

 Внешний вид изображения не предопределяет выбор цветовой модели; он 
служит только предпосылкой для этого. Текстовый документ, где присутствуют 
только черная и белая краски, может быть сохранен в любой из перечисленных 
цветовых моделей. Выбор способа представления зависит от тех мероприятий, 
которые будут проводиться с изображением. Например, если требуется 
распознать некачественный текстовый документ, то иногда целесообразно 

сканировать его в режиме RGB. К таким оригиналам могут быть применены 

любые инструменты и средства растрового редактора, поэтому плохой образец 
можно подготовить для успешного распознавания. 

Модель HSB 

Цветовая модель HSB возникла как попытка преодолеть аппаратную зависимость 

модели RGB. В модели HSB все цвета определяются тремя координатами: оттенком 

(Hue), насыщенностью (Saturation), и яркостью (Brightness). Название 

модели образовано по первым буквам английских названий цветовых координат. 

Необходимо различать цветность и яркость света. Эту разницу должны хорошо 

понимать опытные пользователи цветных телевизионных приемников, у которых 
за эти настройки отвечают различные органы настройки. Цветовым тоном или 

оттенком (Hue) называется спектрально-чистый цвет определенной длины волны, 

например, чистый красный или чистый зеленый. Цветовой тон - это объективная 
характеристика, поскольку ее можно измерить по длинам преобладающих в 
световом пучке волн. 

Яркость (Brightness) характеризует интенсивность, энергию 
цвета. Изменение яркости можно представить как смешение чистого тона и 
черного цвета. Большое содержание черного делает цвет затененным, 
неинтенсивным. С уменьшением процента черного освещенность увеличивается. 
Солнечный луч - это пример яркого света, свечение, исходящее от светлячка, 
имеет очень низкую яркость. Черный цвет имеет нулевую яркость, а белый - 
абсолютную. 

Насыщенность (Saturation) описывает чистоту цвета. Один и тот же тон 
может быть тусклым или насыщенным. Изменение насыщенности можно 
представить как разбавление чистого цвета белым или серым. Чем больше 
содержание белого, тем более блеклым становится цвет. Насыщенность иногда 
называют хроматической гаммой. 

Существует несколько разновидностей системы HSB, в которых яркостная и 

цветовая характеристики рассматриваются отдельно, например, HSI, HLS, YUV. 



Во всех этих моделях цвет задается не как смешение трех цветов, а по значениям 
цветового тона, насыщенности и интенсивности. Например, в 

модели HISиспользуется тон (Hue), .насыщенность (Saturation) и 

интенсивность (Intensity), в модели HLS - тон (Hue), насыщенность 

(Saturation) и светлота (Lightness). 

Photoshop поддерживает систему HSB в ее классическом исполнении; эта 

модификация получила наибольшее распространение в различных программах 
растровой и векторной графики. 

Модель HSB дает оператору графической программы очень удобный и интуитивно 

ясный способ синтеза цветов, поэтому рассмотрим ее более подробно. Для 
описания ее свойств воспользуемся наглядной геометрической аналогией в 
виде цветового круга (рис. 1.7). 

 
 

Рис. 1.7. Цветовой круг 

Пусть цвета видимого спектра располагаются по кругу, как цифры на циферблате 
часов. Каждому оттенку соответствует точка на окружности. Чтобы указать 
положение спектрального цвета достаточно задать угол поворота радиуса-
вектора (см. рис. 1.7). В большинстве графических программ принято начинать 
отсчет от красного цвета и располагать основные и дополнительные цвета с 
приращением в 60 градусов. Величина насыщенности описывается как 
длина радиуса-вектора. Чем менее насыщенным является цвет, тем ближе к 
центру окружности располагается представляющая его точка. Центр круга 
соответствует черному цвету. 



Обычно насыщенность измеряется в процентах: минимальная насыщенность равна 
0, максимальная - 100. Чтобы учесть в нашей модели яркость, надо добавить 

третью координату. Тогда все цветовое пространство системы HSB можно 

представить в виде стопки цветовых кругов, каждый из которых соответствует 
своему значению яркости. Яркость в большинстве графических программ 
изменяют в процентах в диапазоне от 0 (минимальная) до 100 (максимальная). 

Модель HSB очень удобна для пользователя. В ней можно синтезировать новые 

цвета и получать различные варианты заданного цвета, опираясь на интуицию. 
Например, мы знаем, что чистый синий цвет лежит на цветовом круге под углом 
240 градусов. Если требуется сместить тон в сторону пурпурного оттенка, то для 
этого достаточно увеличить угол поворота. Цвет кажется слишком насыщенным? 
Решение известно. Надо сместить точку в радиальном направлении ближе к 
центру. Велика яркость? Уменьшаем соответствующую координату. Подобную 

стратегию синтеза цвета невозможно реализовать в системе RGB, поскольку 

трудно предвидеть последствия даже небольших изменений цветовых координат. 

Еще одним несомненным достоинством системы HSB является ее независимость от 

аппаратуры. 

Модели CMY и CMYK 

Модель CMY описывает способ получения цветов не сложением, как в 
RGB, а вычитанием базовых цветовых координат. В этой модели 
опорными являются краски голубая (Cyan, C), пурпурная (Magenta, M), 
желтая (Yellow, Y). Принцип действия этой модели показан на рис. 1.8. 

 
 

Рис. 1.8. Синтез цветов в системе CMY 

Если, как это часто делается, измерять интенсивность цвета числами в диапазоне 
от 0 (минимальная интенсивность), до 1 (максимальная интенсивность), то в 

модели RGB черный цвет получит координаты (0,0,0), а белый - (1,1,1). 

Координаты одного цвета в моделях RGB и CMY - взаимно зависящие величины, 

соотношение между ними задается простой формулой:  

В частности, в CMY белый цвет кодируется вектором (0,0,0), а черный - (1,1,1). 



Цветовые координаты модели CMY являются дополнительными к 

координатам RGB, т. е. сложение каждой дополнительной пары дает чистый 

белый. Поэтому модель CMY можно представить в виде куба, начало отсчета 

которого находится в точке, соответствующей белому цвету (рис. 1.9). 

 
 

Рис. 1.9. Цветовой куб модели CMY 

Если нанести на белый лист бумаги красители пурпурного, желтого и голубого 
цветов, то они поглотят все три составляющие падающего света и такой лист 
должен выглядеть черным. В это теоретически правильное заключение практика 
вносит свои поправки. Существующие красители по своим химическим свойствам 
далеки от идеала и часто содержат примеси. Смешение таких красителей дает не 
черный цвет, а грязно-коричневый темного оттенка. Свой вклад вносит и бумага, 
поверхность и цвет которой никогда не бывают идеальными. Для повышения 
качества печати применяется специальный черный краситель, позволяющий 
получить ровный и глубокий черный цвет. Большинство современных 
репродуцирующих устройств (принтеров и типографских машин) печатают в 
четыре краски, и только самые дешевые струйные принтеры, сегодня практически 
вышедшие из употребления, используют только три краски. 

Модель CMY с дополнительной черной составляющей называется 

моделью CMYK. Черный цвет (Black) представлен в названии последней буквой 

для того, чтобы не путать его в сокращениях с синим (Blue). Эта система служит 

теоретической основой цифровой печати. Во многих графических пакетах 
цветовые координаты рассматриваются как красители, которые наносятся на 
поверхность бумаги, поэтому интенсивность каждой координаты измеряется в 
процентах от 0 (отсутствие краски) до 100 (максимальная интенсивность краски). 

Любая модель является идеализацией. Даже самое точное формальное описание 
представляет реальные процессы и ситуации лишь приблизительно, передавая 
суть явления, она отбрасывает многие второстепенные детали. Практика 

показала, что модель CMYK адекватно описывает принцип действия классической 



типографской печати, где цветные изображения получаются нанесением на 
бумажный лист четырех красок разной плотности. 

Философские споры по поводу преимуществ и недостатков систем RGB и CMYK не 

получили своего окончательного разрешения. На страницах специализированных 
журналов до сих пор ведется оживленная полемика по этому вопросу. Можно дать 
только самые общие рекомендации по выбору цветовой модели. Для отображения 

на экране компьютерного монитора или телевизора лучше подходит система RGB. 

Для передачи в типографию или вывода на цветное печатающее устройство 

высокого класса следует предпочесть систему CMYK. 

Если RGB-изображение можно сохранить в любом формате, то для CMYK эта 

свобода значительно ограничена. Перечислим все форматы, доступные для CMYK-

изображения в редакторе Photoshop: PSD, EPS, DCS, JPEG, PDF, RAW, 

Scitex CT, TIFF. Изображения в модели CMYK занимают больше места по 

сравнению с их полными аналогами в модели RGB. 

Цветовая модель LAB 

В этой цветовой модели цвет состоит из: 

Luminance - освещенность. Это совокупность понятий яркость (lightness) и 
интенсивность (chrome) 

A - это цветовая гамма от зеленого до пурпурного 

B - цветовая гамма от голубого до желтого 

То есть двумя показателями в совокупности определяется цвет и одним 
показателем определяется его освещенность. 

LAB - Это аппаратно-независимая цветовая модель, то есть она не зависит от 
способа передачи нам цвета. Она содержит в себе цвета как RGB так и CMYK, и 
grayscale, что позволяет ей с минимальными потерями конвертировать 
изображение из одной цветовой модели в другую. 

Еще одним достоинством является то, что она, в отличие от цветовой модели HSB, 
соответствует особенностям восприятия цвета глазом человека. 

 

Ключевые термины 

Аддитивный принцип цветового синтеза - способ генерации, когда 
производные цвета и оттенки получаются в результате сложения базовых цветов 

разной интенсивности. Модели RGB и HSB основаны на этом принципе. 

Аппаратно-зависимая цветовая модель - цветовая модель, описывающая 
технику генерации цвета устройствами выбранного типа или вида. 



Аппаратно-независимая цветовая модель - цветовая модель, описывающая 
технику синтеза цвета в абстрактных колориметрических терминах, не зависящих 
от устройства воспроизведения. 

Векторная графика - раздел компьютерной графики, в котором изображение 
строится из набора простых геометрических фигур, называемых примитивами. 

Геометрический примитив - фигура простой формы (линия, прямоугольник, 
овал и пр.), которая служит неразложимым первичным элементом двумерного или 
трехмерного изображения в векторной графике. 

Дополнительные цвета - цвета, сложение которых дает белый, черный или 
серый тон. 

Интуитивная цветовая модель - цветовая модель, описывающая цвет в 
терминах которые согласуются с психологией человеческого цветовосприятия. 

Канал - представление растрового изображения в градациях одной цветовой 
координаты. Белые точки канала соответствуют максимальной интенсивности 
данного цвета. Черные точки описывают области нулевой интенсивности. Пикселы 
промежуточной яркости представляют промежуточные значения интенсивности 
цветовой координаты. 

Комплиментарные цвета - см. Дополнительные цвета. 

Модель Bitmap - цветовая модель (система) растровых изображений, у которой 
состояние каждой точки кодируется одним двоичным разрядом. Изображения в 
этой системе называются черно-белыми или монохромными, если передаются 
предельные интенсивности любого цвета, отличного от белого и черного. 

Модель CMY - субтрактивная цветовая модель, где производный цвет получается 

вычитанием базовых цветовых координат голубого (Cyan, C), пурпурного 

(Magenta, M) и желтого (Yellow, Y). 

Модель CMYK - субтрактивная цветовая модель, где производный цвет 

получается вычитанием базовых цветовых координат голубого (Cyan, C), 

пурурного (Magenta, M), желтого (Yellow, Y) и черного (Black, K). 

Модель Grayscale - цветовая модель, предназначенная для хранения различных 

оттенков серого. Для растровых изображений в редакторе Photoshop- это 

одноканальная модель с глубиной цвета 8 двоичных разрядов или более. 

Модель HSB - цветовая модель, у которой производные цвета получаются в 

результате синтеза трех координат оттенка (Hue, H), насыщенности 

(Saturation, S) и яркости (Brightness, B). 

Модель Indexed Color - цветовая модель, в которой цвет точки или фигуры 
может принимать значение из фиксированного множества оттенков, которое 
называется палитрой или цветовой таблицей. 



Модель RGB - аддитивная цветовая модель, где каждый цвет получается 

сложением трех базовых цветов разной интенсивности: красного (Red, R), 

зеленого (Green, G) и синего (Blue, B). 

Насыщенность - чистота светового потока. 

Оттенок - спектрально-чистый свет определенный длины волны. 

Пиксел - наименьший логический элемент растрового изображения, точка 
однородного прямоугольного массива - растра. 

Растр - регулярный однородный массив независимых точек (пикселов), который 
служит для генерации и хранения изображений в растровой графике. 

Растровая графика - раздел компьютерной графики, где изображение 
формируется из однородного и изотропного массива точек - растра. 

Субтрактивный принцип цветового синтеза - способ синтеза, когда 
производные цвета и оттенки получаются в результате вычитания базовых 

хроматических координат. На этом принципе основаны модели CMY и CMYK. 

Хроматическая гамма - см. Насыщенность. 

Хроматическая координата - см. Цветовая координата. 

Цветовая координата - первичный (базовый, основной) цвет модели, не 
сводимый в ней к другим краскам или оттенкам. 

Цветовая модель - формальный способ описания координат цветового 
пространства. 

Цветовая система - см. Цветовая модель. 

Цветовое пространство - абстрактное пространство, каждая точка которого 
представляет собой цвет или оттенок. Цветовое пространство задается цветовой 
моделью и характеризуется числом хроматических координат и мощностью. Так, 

цветовое пространство, порождаемое моделью RGB, является трехкоорди-натным. 

При глубине цвета 8 бит на одну хроматическую координату (канал) это 
пространство включает в себя более 16 млн. цветов. 

Цветовой круг - графический способ представления модели HSB. 

Цветовой куб - наглядный способ представления моделей RGB и CMY. 

Цветовой тон - см. Оттенок. 

Яркость - интенсивность светового потока. 
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Интерфейс 

Штатным способом запуска команд в пакете Photoshop является главное меню. 

Это стандартный элемент, который присутствует в любом редакторе. В силу своей 
сложности такие управляющие средства организуются обычно по иерархическому 
принципу, когда частное объявляется элементом общего. Если командное 
меню имеет большую глубину вложения, то поиск искомого средства может стать 
трудоемкой задачей, требующей от пользователя утомительной навигации по 
многочисленным разделам и подразделам. Для ускорения работы самые 
востребованные средства снабжаются оперативными средствами запуска - 
горячими клавишами, контекстными меню и др. 

Этот общий принцип проектирования современных программных средств 

полностью выдержан в редакторе Photoshop. Основным средством управления 

является командное меню, некоторые средства запускаются при помощи 
дополнительных экранных палитр, главные креативные инструменты (кисти, 
фигуры, текст) представлены в панели инструментов. 

Интенсивное обращение к командному меню, панелям и палитрам программы 
требует значительных накладных расходов. Опыт показывает, что заметная часть 
рабочего времени цифровых ретушеров или дизайнеров уходит на 
простейшие операции: прокрутку экрана, изменение масштаба изображения, 
выбор инструментов, настройку параметров и прочие. Если для выполнения этих 
рутинных операций пользоваться штатными инструментами или командами, то 
результативность работы резко снижается. Разработчики снабдили основные 
команды пакета специальными клавиатурными сокращениями, знание которых 

способно значительно повысить эффективность работы в Photoshop. Число таких 

клавишных комбинаций, многие из которых даже не вошли в официальное 

описание фирмы Adobe, превышает шесть сотен. Все эти сочетания не помнит ни 

один, даже самый искусный, пользователь редактора. Среди 



этого множества можно выделить два-три десятка основных сочетаний. Беглое 
владение ими дает свободу от многих технических ограничений и позволяет 
сконцентрировать усилия оператора на основных творческих задачах. 

Рабочий стол 

Уже достаточно давно в информатике сложился определенный стереотип 
оформления программных продуктов. Этого неписанного стандарта 
придерживаются все производители софта, которые рассчитывают на 
коммерческий успех своих продуктов. Его можно назвать метафорой 
рабочего стола. Пространствопрограммы оформлено в виде окна, которое 
выполняет функции своеобразного виртуального верстака. Оно 
предоставляет место для размещения проекта и все необходимые инструменты 
для его обработки. 

 
 

Рис. 2.1. Рабочий стол редактора 

На рис. 2.1 показан рабочий стол редактора Photoshop. Рассмотрим его основные 

компоненты: 

1. Tools (Инструменты). Это собрание основных креативных средств редактора, 

представленное в виде инструментальной панели. Для выбора инструмента 
достаточно щелкнуть по соответствующей кнопке. Большинство кнопок 
панели служат для вызова нескольких инструментов, связанных отношением 
функционального подобия. Для активации скрытых инструментов следует 
нажать и некоторое время удерживать кнопку. Другим способом являются 
быстрые клавиши. В следующем разделе приведено подробное описание 
панели инструментов и дана сводка всех оперативных клавиатурных 
сочетаний; 

2. Панель приложений, которая в последней версии программы заняла место, 
ранее принадлежавшее заголовочной строке. Теперь эта часть рабочего окна 
не расходуется напрасно, а хранит кнопки вызова внешних приложений и 
некоторые важные настройки рабочей среды. 
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3. Main menu (Главное меню). Это основной пульт управления редактора. 

Главное меню объединяет средства обработки изображения и команды 
настройки программы. Оно построено по принципу вертикальной 
соподчиненности. Это значит, что основные разделы меню открывают доступ 
к подразделам, которые, в свою очередь, могут хранить команды низшего 
уровня. Самые востребованные команды главного меню поддержаны 
горячими клавишами. Команды, имеющие напротив своего имени многоточие, 
требуют для своей работы ввода дополнительных настроек, которые задаются 
при помощи диалоговых окон. Если это значок отсутствует, то данное 
средство обработки или настройки применяется немедленно; 

4. Рабочее окно документа. Это стандартный и относительно простой элемент 
оформления современных программ. Рабочее окно - это среда обитания 
документа. Это самая важная и, пожалуй, единственная функция этого 

элемента программы. Photoshop представляет собой многооконный 

редактор, в нем могут обрабатываться несколько документов, каждый из 
которых расположен в своем рабочем окне. Для перехода в другое рабочее 
окно документа достаточно выбрать его имя в нижней части 

раздела Window (Окно) главного меню или щелкнуть мышкой по любой его 

видимой части. Еще один удобный способ перехода дает клавиатурное 

сочетание Ctrl+Tab; 

5. Options (Панель свойств). Это один из самых полезных интерфейсных 

элементов программы Photoshop. Панель свойств выводит самые важные 

настройки активного инструмента или запущенной команды. Она обладает 
свойством контекстной чувствительности. Этим громоздким словосочетанием 
в информатике принято обозначать способность интерфейсного элемента 
изменять свое состояние в зависимости от ситуации, сложившейся на рабочем 
столе. Настройки активного инструмента не надо разыскивать в дебрях 
командного меню, они всегда на переднем плане и доступны оператору. В 
последних локализованных версиях программы эта панель называется 
"Управление". Традиционное название короче и точнее отражает суть дела, 
поэтому будем использовать преимущественно его; 

6. Palette (Палитра). Палитры - это еще один стандартный элемент 

оформления современных графических редакторов. Они выполняют в 
программе самые разнообразные функции, которые невозможно охватить 
единой формулой. При помощи палитр можно задавать настройки 
обрабатывающих команд, управлять слоями и каналами, выполнять 
навигацию в большом документе, получать справочною информацию о 
состоянии оригинала и многое другое. Так, под номером 6 на рис. 
2.1 показана одна из самых важных палитр программы - палитра 

слоев. Photoshop имеет в своем арсенале почти два десятка палитр. Если все 

их одновременно вывести на экран, то они покроют окно самого большого 
монитора. Поэтому опытные пользователи стараются открывать только 
необходимые палитры, остальные держать в латентном состоянии. Вызов 

палитр выполняется при помощи раздела главного меню Window. Самые 

ходовые палитры можно вызвать посредством стандартных или назначенных 
клавиатурных сочетаний. 

7. Группа свернутых палитр в припаркованном состоянии. Интерфейс программы 
очень гибок и допускает глубокую и разнообразную настройку. Большая часть 
задач управления палитрами и панелями выполняется при помощи 



элементарного приема буксировки. Панели разрешается объединять, 
разделять, раскрывать, сворачивать, перемещать и др. Все эти операции 
выполняются простым перетаскиванием. Позиции рабочего окна, 
разрешенные для парковки отдельных панелей и их групп изображаются 
синей подсветкой. 

8. Числовое поле, показывающее текущий масштаб документа. 

9. Status bar (Строка состояния). Строка состояния или статусная строка 

представляет собой своего рода информационное табло редактора. Она 
выводит важную справочную информацию о состоянии обрабатываемого 
документа, его размерах, затратах оперативной памяти, текущем 
коэффициенте масштабирования и др. 

Панель инструментов 

Панель инструментов Tools (рис. 2.2) - эта основная панель программы, без 

которой немыслима продуктивная работа с изображением. Поэтому большую часть 
сеанса работы с программой она открыта и располагается на переднем плане 
плане рабочего стола. 

 
 

Рис. 2.2. Панель инструментов 

В Photoshop панель инструментов объединяет базовые средства выделения, 

рисования и настройки различных атрибутов изображения. Большая часть 
элементов панели имеет специальные горячие клавиши, предназначенные для их 
активизации. Распределение клавиш выполнено на основе простого 
мнемонического правила: для выполнения команды следует набрать на 
клавиатуре первую литеру ее имени. Если одном разделе панели находится 
несколько инструментов, для выбора искомого средства следует несколько раз 

нажать горячую клавишу, удерживая при этом Shift. Все редкие исключения 



объясняются дублированием инициальных символов команд или объединением их 
в тематические группы. 

Приведем краткое описание инструментов панели и клавиш их быстрого вызова: 

1. Marquee (Область) - выделение регулярных областей различных размеров и 

форм. Раздел объединяет инструменты для создания прямоугольных, 
овальных выделений, а также помеченных областей в виде прямых линий. 

Клавиша быстрого вызова M; 

2. Move (Перемещение) - перемещение выделенной области или слоя. Клавиша 

быстрого вызова V; 

3. Lasso (Лассо) - выделение областей произвольной формы и размеров. В этот 

раздел входят три разновидности одного 

инструмента: Lasso (Лассо), Polygonal Lasso (Прямолинейное 

лассо), Magnetic Lasso (Магнитное лассо). Первое строит произвольную 

границу выделенной области от руки, второе предназначено для создания 
границ в форме ломаной линии, третье представляет собой 
полуавтоматическое средство, которое самостоятельно проводит границу, 
разделяя точки с максимальным контрастом. Клавиша быстрого вызова L; 

4. Magic Wand (Волшебная палочка) - выделение областей на основе близости 

яркостных характеристик пикселей. Инструмент строит выделение, в которое 
включаются все точки с яркостями, не выходящими за пределы 
установленного допуска. Другой инструмент выделения, расположенный в 

этом разделе, называетсяQuick Selection (Быстрое выделение). Это 

полуавтоматическое средство выделения, которое работает наподобие 
рисующей кисти. Пользователь должен мазком указать область выделения, а 
программа автоматически определит ее точные края. Клавиша быстрого 

вызова W; 

5. Crop (Рамка) - обрезание изображения. Средство предназначено для 

изменения размеров изображений. Кроме того, в этом разделе находятся 

кнопки вызова инструментов Slice (Раскройка) и Slice Select (Выделение 

фрагмента) - разрезание изображения на прямоугольные части и выделение 
этих частей. Инструменты используются для подготовки рисунков к 

публикации в Интернете. Клавиша быстрого вызова C; 

6. Eyedropper/Color Sampler/Ruler/Note/Count (Пипетка/Цветовой 

эталон/Линейка/Комментарий/Счетчик) - инструменты измерения и отбора 

цветовых проб. Eyedropper делает цвет пробной точки цветом переднего 

плана или цветом фона. Color Sampler служит для размещения на 

изображении цветовых датчиков. Это своеобразные виртуальные 
измерительные приборы, показания которых позволяет контролировать 

процесс обработки оригинала. Ruler - это средство измерения линейных и 

угловых размеров. Результаты измерений двух последних инструментов 

выводятся в специальной палитре Info. ИнструментCount служит для 

подсчета числа различных объектов. Активизация средств этой группы 

выполняется при помощи клавиши I; 

7. Spot Healing Brush/Healing Brush/Patch/Red Eye (Точечная 

восстанавливающая кисть/Восстанавливающая кисть/Заплатка/Красные глаза) 



- средства технической ретуши и восстановления дефектных фрагментов 

изображения. Инструмент Spot Healing Brush служит для удаления пятен. 

Инструменты HealingBrush/Patch предназначены для технической ретуши 

поврежденных или загрязненных фрагментов изображений. Инструмент Red 

Eye предназначен для коррекции красных глаз - известного дефекта 

фотопортретов, сделанных со вспышкой. Клавиша быстрого вызова J; 

8. Brush/Pencil/Color 

Replacement/Mixer Brush (Кисть/Карандаш/Замена цвета/Микс-кисть). 

Первые два инструмента - это основные средства рисования программы, а 

третий служит для выборочной замены цвета. Клавиша быстрого вызова B; 

9. Clone Stamp/Pattern Stamp (Штамп/Узорный штамп) - клонирование 

фрагментов изображения. Первый инструмент выполняет перенос донорских 
фрагментов на поврежденные. Используется для решения задач технической 
ретуши и очистки изображений. Второй штамп используется для 
закрашивания областей графическими образцами. Клавиша быстрого 

вызова S; 

10. History Brush/Art History Brush (Архивная кисть/Архивная 

художественная кисть) - инструменты позволяют восстановить (частично или 
полностью) одно из предыдущих состояний изображения. Работают совместно 

со специальной палитрой History, которая запоминает действия пользова-

теля и состояния изображения. Для активизации инструментов этой груп-пы 

служит клавиша Y ; 

11. Eraser/Background Eraser/Magic Eraser (Ластик/Фоновый 

ластик/Волшебный ластик) - стирание фрагментов изображения. Все средства 
этого раздела по своему назначению напоминают обычный ластик, но 

работают с некоторыми ограничениями и уточнениями. Инструмент Eraser - 

это кисть, которая окрашивает точки изображения цветом фона. В 

большинстве ситуаций это означает стирание. Инструмент Background 

Eraser представляет собой полуавтоматическое средство, предназначенное 

для отделения фигур от фоновых фрагментов. Magic Eraser - это 

инструмент с еще более сложным поведением. Он стирает или перекрашивает 
все точки, подобные пробной. Сходство устанавливается по принципу 

цветовой близости. Клавиша быстрого вызова всех средств этого раздела E; 

12. Gradient/Paint Bucket (Градиент/Заливка) - средства закраски областей 

цветом или непрерывным цветовым переходом - градиентом. Клавиша 

быстрого вызова G; 

13. Blur/Sharpen/Smudge (Размытие/Резкость/Палец) - инструменты для 

изменения фокусировки фрагментов изображения. Инструменты этого раздела 
представляют собой кисти, которые меняют фокусировку обрабатываемых 
фрагментов. Первое средство выполняет локальное размытие, второе 

увеличивает резкость. Принцип действия инструмента Smudge отличается от 

изложенного. Он перемешивает соседние точки растрового изображения, его 
результаты напоминают мазок пальцем по холсту с невысохшей краской. За 
это очевидное сходство он получил название, которое отличается от точного 
перевода (мазать или пятно). Быстрый вызов всех перечисленных средств 

выполняется посредством клавиши R; 



14. Dodge/Burn/Sponge (Осветлитель/Затемнитель/Губка) - инструменты 

тонирования. Это кисти, предназначенные не для рисования, а для локальной 
настройки тоновых характеристик изображения. Первое средство служит для 
осветления обрабатываемых областей, второе выполняет их затемнение, 

третье меняет цветовую насыщенность. Клавиша быстрого вызова O; 

15. Pen (Перо). Этот раздел палитры инструментов объединяет многочисленные 

средства и редактирования векторных объектов и контуров. Быстрый вызов 

выполняется при помощи клавиши P; 

16. Type (Текст) - инструменты, предназначенные для набора текста разного 

вида. Активизация средств этой группы выполняется при помощи клавиши T; 

17. Path Selection (Выделение контура) - выделение и редактирование 

векторных объектов. Клавиша быстрого вызова A; 

18. Rectangle/Ellipse/Polygon/Line/Custom 

Shape (Прямоугольник/Эллипс/Многоугольник/Линия/Произвольная фигура) - 

инструменты рисования векторных объектов различной формы. Быстрый 

вызов при помощи клавиши U; 

19. Инструменты управления трехмерными объектами (только в 

версии Extended); 

20. Инструменты управления камерами (только в версии Extended); 

21. Hand/Rotate View (Рука/Поворот вида) - перемещение изображения в окне 

документа. Эта техническая операция иногда называется панорамированием 
или скроллингом. Для выбора этого инструмента достаточно нажать 

клавишу H. Поскольку при работе с большими изображениями приходится 

часто обращаться к этому средству, то разработчики программы 
предусмотрели более удобный способ ее запуска. Для этого достаточно 
нажать и удерживать пробельную клавишу; 

22. Zoom (Масштаб) - изменение масштаба изображения. Одна из самых 

востребованных операций является операция масштабирования. Для нее 
разработчики программы предусмотрели множество оперативных способов 
выполнения. Одно из самых удобных клавиатурных сочетаний - 

это Ctrl+плюс для увеличения масштаба и Ctrl+минус для его уменьшения. 

Штатный способ активизации инструмента Zoom - это клавиша Z; 

23. Foreground Color (Основной цвет) - выбор активного цвета. Этот цвет 

иногда называется цветом переднего плана (основным цветом) и используется 
всеми рисующими инструментами программы; 

24. Background Color (Фоновый цвет) - выбор цвета фона. Цветом фона 

закрашивают стираемые области инструмент Eraser. Некоторые средства 

редактора используют его для определения результатов обработки; 

25. Default (По умолчанию) - выбор стандартной раскладки для цвета фона и 

переднего плана. В качестве таковой принимаются черный цвет для 
рисования и белый цвет для фона. Для задания стандартной раскладки 

цветов достаточно нажать клавишу D; 

26. Quick Mask (Быстрая маска) - переход в режим быстрой маски. Это особый 

режим работы редактора, когда его средства рисования воздействуют не на 
оригинал, а создают специальную маску изображения. После возвращения в 
нормальный режим редактирования маска превращается в выделение. 



Рисование в режиме быстрой маски - это один из самых мощных способов 
создания выделений сложной формы. Переход в режим быстрой маски и 
возвращение в нормальный режим редактирования выполняются по нажатию 

клавиши Q. 

Палитры 

Палитры - это важная часть системы управления программы. С помощью этих 
интерфейсных элементов выполняется контроль изображения, настройка команд, 
управление процессом ретуши или рисования. Любую палитру можно 

активировать командой Window - Имя палитры. 

 
 

Рис. 2.2. Составные палитры 

Вызов самых ходовых палитр поддержан специальными горячими клавишами. Это 

функциональные клавиши, расположенные в верхнем ряду клавиатуры: Actions 

(F9), Brushes (F5), Color (F6), Layers (F7), Info (F8). Простые 

палитры можно объединять в составные. Этот прием получил широкое 
распространение в современных программах; техника подобного монтажа хорошо 
знакома любому искушенному пользователю. Для объединения достаточно 
перетащить ярлычок одной палитры на другую, как показано на рисунке рис. 2.2. 
Сблокированная палитра отчасти теряет свою самостоятельность - ее вызов при 



помощи команды или горячей клавиши выводит на экран составную палитру 
целиком. 

Разбирается составная палитра в порядке обратном ее сборке. Для этого 
достаточно зацепить ярлычок палитры и перетащить его на любое 
свободное место рабочего стола. 

Палитры выполняют в программе самые разнообразные функции, поэтому они 
различаются по своему внешнему виду (незначительно) и по содержимому (иногда 
очень сильно). Некоторые объекты такого вида выводят на экран справочную 
информацию и не позволяют изменить изображение или его часть. Существуют 
палитры, используемые для запуска команд и операций. Примером таких средств 

является палитра Layer Comps (Композиция слоев). Она позволяет просмотреть 

варианты изображения, которые получаются при различных сочетаниях слоев и их 
параметров. Управления этим процессом выполняется посредством кнопок 
нижнего ряда или команд выпадающего меню. Для вызова этого меню достаточно 
щелкнуть по кнопке треугольной формы, расположенной в правом верхнем углу 
палитры. Подобными средствами управления располагает любая 
производительная палитра. Все информационные палитры имеют выпадающее 
командное меню. 

 
 

Рис. 2.4. Уп равляющие элементы палитры 

На номера на этом рисунке обозначают: 

1. управляющие кнопки палитры; 

2. кнопка вызова выпадающего командного меню. 

Интенсивная работа с палитрами и инструментами способна создать на рабочем 
столе ситуацию, которую принято называть рукотворным хаосом. Приведем 
несколько простых рецептов, позволяющих поддержать порядок в рабочем окне 
программы. 

Нажатие клавиши Tab убирает все открытые палитры и панели с экрана. 

Повторное нажатие этой клавиши восстанавливает исходную ситуацию. 

 Комбинация клавиш Shift+Tab убирает с экрана все палитры, за исключением 

самых главных: Toolbar (Инструменты) и Options (Панель свойств). 



 Все неиспользуемые палитры можно объединить в одну составную и убрать с 
экрана. Для сокращения размеров палитры достаточно два раза подряд щелкнуть 
по ее заголовочной строке. 

 Редактор располагает несколькими простыми средствами, которые позволяют 
создать и сохранить на экране удобную рабочую среду. Так, программа 
запоминает расположение палитр на экране. Достаточно один раз разместить все 
необходимые для работы средства на свободных местах экрана - и эта 
конфигурация будет воспроизводиться при каждом новом запуске программы. 

 У правой и левой границ окна программы расположены специальные 
"парковочные зоны". Для привязки простой или составной палитры достаточно 
перетащить и некоторое время подержать возле границы (рис. 2.5). 

 
 
 
Рис. 2.5. Палитры в связанном состоянии 

 В программе есть специальный раздел главного меню Window 

- Workspace (Окно - Рабочая среда), управляющий конфигурациями рабочего 

стола. При помощи команд этого раздела можно сохранить текущее состояние 
рабочего стола и восстановить его в следующем сеансе работы с программой. 

Панель свойств 

Большинство инструментальных средств программы могут работать в различных 
режимах или имеют настроечные параметры, уточняющие способ применения 
команды. Например, у инструментов рисования - это размер кисти, прозрачность, 
жесткость, характеристики нанесения краски и т.д. Средства тонирования могут 
применяться с различным нажимом, инструменты выделения фрагментов дают 
различные результаты, в зависимости от выбранных размеров граничной области. 

Ветераны программы, работающие с пакетом много лет, привыкли к тому, что все 
настройки инструментов совершаются посредством дополнительных палитр, 
которые выводились на экран по двойному щелчку на кнопке инструмента. 
Начиная с шестой версии редактора, это, казавшееся незыблемым, соглашение 
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было изменено. Теперь изменение режимов работы инструментов выполняется 

при помощи специальной панели Options (Панель свойств), расположенной в 

верхней части окна программы. 

Это средство обладает свойством контекстной зависимости. Панель выводит на 
экран основные настроечные параметры активного инструмента, актуальные в 
данной проектной ситуации. Теперь пользователю программы не нужно 
продираться сквозь интерфейсные дебри в поисках нужной команды или опции - 
основные характеристики выбранного инструмента всегда находятся на переднем 
плане рабочего окна и доступны для внесения изменений. 

Photoshop не имеет патента на использование интерфейсных средств, подобных 

панели свойств. Аналогичные решения, под разными названиями, стали в наше 
время обязательными элементами оснащения любых графических редакторов 
профессионального уровня. Панель свойств облегчает доступ к важным 
настройкам инструментальных средств и делает процесс ретуширования и 
рисования более свободным. 

 
 

Рис. 2.6. Настройки инструмента Magic Wand 

На рис. 2.6 показан вид панели свойств после выбора инструмента Magic 

Wand (Волшебная палочка). Самую левую позицию панели свойств занимает 

стандартный элемент, который присутствует в большинстве ее состояний. Это 
управляющая кнопка, открывающая доступ к коллекции предустановленных 
наборов параметров для инструмента выбранного типа. В терминологии авторов 

программы эти наборы именуются Presets. Если приходится использовать 

некоторый инструмент несколько раз с одной комбинацией настроечных 

параметров, то имеет смысл занести ее в состав Presets. 

Каждая запись коллекции стандартных настроек имеет собственное отличительное 
имя. При последующих обращениях к инструменту пользователь избавлен от 
необходимости повторения процедуры задания параметров, достаточно выбрать 
имя соответствующей записи. Остальные поля и переключатели - это 

специфические настройки инструмента Magic Wand. 

Контекстные меню 

Контекстные меню - это еще один способ оформления интерфейса, который 
принят в качестве стандарта дефакто разработчиками программного обеспечения. 
Подобные меню представляют собой коллекцию параметров или команд, 
актуальных в данной проектной ситуации или связанных с активной 
областью рабочего стола. Устоялись и приемы работы с контекстными меню. Для 
их вызова следует выполнить щелчок правой кнопкой мыши по объекту или 
области рабочего стола. Все остальные управляющие действия выполняются при 
помощи левой кнопки (обычно) или посредством управляющих клавиш (редко). 



Подавляющее большинство инструментов программы допускают настройку 
посредством контекстных меню. На рис. 2.7 показано контекстное меню, 

связанное с инструментом Brush (Кисть). 

 
 

Рис. 2.7. Контекстное меню инструмента Brush 

Электронную кисть можно с полным правом назвать естественным инструментом. 
Работа с ней во многом напоминает настоящую кисть, знакомую каждому по 
урокам рисования в начальной школе. Может быть, по этой причине эта техника 
используется не только для решения изобразительных задач, но для 
редактирования и технической ретуши изображений. 

Кистями являются все графические инструменты программы, 

например Brush (Кисть), Pencil (Карандаш), Eraser (Ластик). Как кисти 

работают и многие неизобразительные инструменты программы, 

например Blur (Размытие), Sharpen (Резкость), Sponge (Губка), Smudge (Палец),

 Clone Stamp (Штамп),History Brush (Архивная кисть) и др. 

Контекстное меню всех этих средств полностью совпадает 

с меню инструмента Brush, которое показано выше. Одним из немногих примеров 

инструментов рисования, который основан на отличных принципах действия, 

является Gradient (Градиент). Его контекстное меню показано на рис. 2.8. 

 
 

Рис. 2.8. Контекстное меню инструмента Gradient 

Следует отметить, что вид и содержание контекстного меню инструмента иногда 
зависит от ситуации, которая сложилась в процессе работы с программой. Один и 



тот же инструмент может вызывать меню разного состава, в зависимости от 
наличия или отсутствия выделенного фрагмента изображения, применения 
фильтров и других причин. 

На рис. 2.9 показаны два различных состояния контекстного меню, которое 

выводится на экран инструментами выделения (Marquee, Lasso и др.). Слева 

показано меню, которое появляется, если на экране нет помеченных областей. С 
правой стороны представлен тот же объект для оригинала, содержащего 
помеченные фрагменты. 

 
 

Рис. 2.9. Контекстные меню инструментов выделения 

Следует отдать должное разработчикам Photoshop. Система 

контекстных меню программы глубоко продумана и тщательно выверена. В 
большинстве проектных ситуаций, тот перечень ресурсов, который вызывается 
щелчком правой кнопкой мыши, обычно содержит искомую команду или средство. 

Масштабирование 

Изменение масштаба и прокрутка изображения - это базовые технические приемы, 
свободное владение которыми совершенно необходимо любому пользователю 

пакета Photoshop. В процессе работы с изображением особенно часто 

приходится чередовать содержательный операции (например, ретушь или 
рисование) и оценку их последствий для изображения в целом. Это требует 
постоянной смены планов и изменения области 

обзора. Программа Photoshop располагает развитыми средствами навигации, 

большинство из которых поддержано несколькими горячими клавишами или 
клавиатурными комбинациями. 



В процессе ретуши могут использоваться различные планы и масштабы 
изображения. Критически важная часть работы выполняется, когда изображение 
представлено на экране своими действительными габаритами или для его 
отображения используется вся доступная область рабочего окна программы. 

Штатным средством изменения масштаба в Photoshop является 

инструмент Zoom (Масштаб). Клавиша быстрого вызова Z. Операция 

масштабирования имеет множество альтернативных способов исполнения. Это 
разнообразия настолько велико, что редко возникает необходимость прямого 

использования инструментаZoom. 

Перечислим основные возможности: 

1. временный выбор лупы выполняется удержанием клавиши Z. После 

освобождения этой клавиши активность возвращается к ранее выбранному 
инструменту; 

2. для быстрого перехода к увеличивающей лупе достаточно нажать и 

удерживать клавиши Ctrl+Пробел; 

3. выбор уменьшающей лупы выполняется при помощи более громоздкой 

комбинации. Для этого следует нажать и удерживать Ctrl+Alt+Пробел; 

4. для увеличения масштаба можно воспользоваться комбинацией Ctrl+Плюс; 

5. клавиатурное сочетание Ctrl+Минус уменьшает масштаб. 

6. числовое поле в левой части статусной строки показывает текущий масштаб и 
служит для его изменения. 

Некоторые экранные размеры имеют особое значение в процессе подготовки 
изображений. Таковыми являются представление оригинала в натуральную 
величину, масштабирование его на все доступное пространство рабочего окна и 
размеры печатной версии изображения. Программа предлагает дополнительные 
приемы для решения этих задач. 

Чтобы включить масштаб изображения 100%, требуется: 

 выполнить двойной щелчок по кнопке инструмента Zoom (Масштаб); 

 воспользоваться комбинацией клавиш Ctrl+1; 

 удерживая пробельную клавишу щелкнуть правой кнопкой мыши на изображении 

и выбрать в выпадающем меню пункт Actual Pixels (Реальные пикселы). 

Чтобы использовать под изображение всю доступную часть рабочего окна, 
требуется: 

 выполнить двойной щелчок по кнопке инструмента Hand (Рука); 

 воспользоваться комбинацией клавиш Ctrl+0 (ноль); 

 нажать кнопку панели свойств Fit on Screen (Подогнать), которая становится 

доступной при работе с инструментами Zoom и Hand. 

 удерживая пробельную клавишу, щелкнуть правой кнопкой мыши на 

изображении и выбрать в выпадающем меню пункт Fit on Screen. 



Для показа изображения в подлинных печатных размерах требуется: 

 выполнить команду главного меню View - Print Size (Просмотр - Размер 

оттиска); 

 удерживая пробельную клавишу, щелкнуть правой кнопкой мыши на 

изображении и выбрать в выпадающем меню пункт Print Size. 

Панорамирование и прокрутка 

Если размеры изображения превышают габариты рабочего окна, то приходится 
выполнять операцию панорамирования. Линейки прокрутки - штатное средство 

просмотра, которым располагает едва ли не каждое приложение Windows - часто 

не обеспечивает необходимой скорости и точности позиционирования. Эту задачу 

в Photoshop намного удобнее выполнять с помощью специализированного 

инструмента Hand (Рука). Быстрый вызов этого средства выполняется при помощи 

клавиши H. 

Было бы странно, если в редакторе не нашлось иных технических приемов для 
прокрутки изображения. Они есть, и количество этих средств весьма значительно. 
Это объясняется не леностью разработчиков, просто в редакторе есть настолько 
удобная техника выполнения этой операции, не возникает необходимости в 
использовании альтернативных способов. 

Для выбора инструмента Hand достаточно нажать и удерживать пробельную 

клавишу. Пока она находится в нажатом состоянии, буксировка любой точки 
документа выполняет прокрутку. После ее освобождения 
пробела программа автоматически возвращается к ранее активному инструменту. 
Этот прием можно применять для любого средства инструментальной панели, за 

исключением средства Text (Текст). 

Просматривать большое изображение можно и с помощью специальных горячих 
клавиш: 

 клавиша Home служит для быстрого перехода в верхний левый угол 

изображения; 

 клавиша End перемещает точку обзора к правому нижнему углу; 

 клавиша PgUp прокручивает изображение вверх на расстояние, равное размеру 

одного экрана (рабочего окно документа); 

 клавиша PgDn прокручивает изображение вниз на расстояние, равное размеру 

одного экрана; 

 сочетание Ctrl+PgUp смещает изображение на один экран влево; 

 сочетание Ctrl+PgDn смещает изображение на один экран вправо. 

Кроме перечисленных средств масштабирования и панорамирования, в программе 

есть специальная палитра Navigator (Навигатор), которая позволяет решить обе 

эти задачи едиными средствами. Для ее вызова достаточно выполнить 

команду Window => Navigator (Окно => Навигатор). 



Это очень простое средство с совершенно прозрачными органами управления 
(рис. 2.10). Палитра показывает эскиз обрабатываемого изображения. 
Красный прямоугольник означает область обзора экрана. Для панорамирования 
оригинала достаточно сместить эту рамку в искомую область палитры. Кнопки 
нижнего ряда палитры служат для изменения масштаба. 

 
 

Рис. 2.10. Палитра Navigator 

В процессе восстановления изображений часто требуется работать одновременно 
с несколькими видами, например, выполнять корректирующие операции при 
большом увеличении и контролировать общий результат, просматривая картинку 

целиком. Photoshop располагает средствами отображения одного изображения 

одновременно в нескольких окнах. Самый простой способ решения этой задачи 

- команда главного меню Window => Arrange => New Window (Окно => 

Упорядочить => Новое окно). Каждое из окон позволяет выбрать собственный 

масштаб изображения, Все изменения, сделанный в одном окне, немедленно 
переносятся в другое окно. 

Выбор цвета 

Понятие активного цвета играет важную роль в любом графическом редакторе, 
независимо от его отраслевой принадлежности и внутренней системы 

представления графики. Photoshop оперирует с двумя активными цветами: один 

из них называется цветом фона (Background color), другой - цветом переднего 

плана, или основным цветом (Foreground color). 

Цвет переднего плана используется всеми рисующими инструментами в качестве 
активного. Любой мазок рисующей кистью оставляет за собой трассу, которая 
будет окрашена заданным цветом переднего плана. Некоторые более сложные 
инструменты окраски, например, градиент, могут использовать его в качестве 
одного из элементов цветового перехода или узора. 



Это совершенно естественное соглашение, которое прекрасно сочетается с 
традиционной практикой рисования. Немного более сложным образом 
определяется в программе цвет фона. Считается, что это цвет, в который 
перекрашивают изображение инструменты, предназначенные для стирания, 
например, ластик. Данное, отчасти озадачивающее соглашение, принято во 
многих пакетах растровой графики, где средства стирания представляют собой 
кисти, которые не удаляют цвет, а рисуют фоновой краской. Кроме того, цвет 
фона используется некоторыми инструментами для создания сложных цветовых 
узоров и градиентов. 

Рассмотрим технику выбора цветов в Photoshop. Заданные для фона и переднего 
плана краски изображаются в нижней части панели инструментов (рис. 2.2). 
Верхний левый образец представляет цвет рисования, нижний правый задает цвет 
заднего плана. 

Оба этих образца служат одновременно и кнопками, нажатие любой из них 

вызывает диалоговое окно Color Picker (Палитра цветов), предназначенное 

для выбора цветов (рис. 2.11). 

 
 

Рис. 2.11. Ресурсы диалогового окна Color Picker 

Рассмотрим содержание этого диалога. 

1. Представление выбранного фрагмента цветового пространства. Большая 
часть этого диалогового окна занимает представление области цветового 
пространства, которую выбрал пользователь. 



2. Маркер, предназначенный для выбора цвета. Перемещая этот интерфейсный 
элемент, можно сделать активным требуемый цвет или оттенок в заданном 
фрагменте пространства. 

3. Шкала чистых хроматических цветов. Выбор определенной позиции на этой 
шкале влечет за собой изменение содержания левого прямоугольного поля, в 
котором отображаются все возможные варианты заданной хроматической 
координаты. 

4. Образец, который показывает выбранный цвет. 

5. Образец, представляющий первоначальный цвет. 

6. Предупреждение о выходе за пределы цветового охвата систему CMYK. 

Пиктограмма в виде восклицательного знака говорит о том, что данный цвет 
не может быть отпечатан точно. Ниже приводится цветовой эквивалент, 
который может быть воспроизведен на печати. 

7. Предупреждение о выходе за пределы Web - безопасной палитры. Ниже 

приводится подходящая для текущего цвета замена, которая принадлежит 
этой палитре. 

8. Color Libraries (Библиотеки цветов). Кнопка переключает цветовую 

палитру на работу с цветовыми библиотеками. 

9. Only Web Colors (Только Web - цвета). Выбор этой опции меняет состав 

цветовой палитры, в которой представляются только Web - безопасные цвета 

и оттенки. 

10. Ползунки, предназначенные для выбора области на хроматической цветовой 
шкале. 

11. Координаты выбранного цвета в различных цветовых системах. Существует 
множество способов задания активного цвета. Его можно выбрать на глазок. 
Удобнее всего это делать в следующей последовательности. Сначала задать 
требуемый диапазон на хроматической шкале, а затем указать искомый 
вариант в левом цветовом поле. При наличии достаточных оснований 
допустимо точное указание цвета по его координатам в одной из 

моделей: RGB, CMYK, Lab или HSB. 

Самые употребительные действия с цветом поддержаны в редакторе удобными и 
легко запоминающимися клавиатурными комбинациями: 

 чтобы установить стандартную раскладку цветов (черный цвет рисования, белый 
цвет фона), которая принята в редакторе по умолчанию, требуется просто 

нажать клавишу D; 

 чтобы поменять местами цвета рисования и заднего плана, следует нажать 

клавишу X; 

 нажатие клавиш Alt+Backspace окрашивает текущий слой или выделенную 

область цветом переднего плана; 

 нажатие клавиш Ctrl+Backspace окрашивает текущий слой или выделенную 

область фоновым цветом. 

Ключевые термины 

Главное меню - основное командное меню программы, с помощью которого 
вызываются большая часть ее ресурсов: команд, инструментов, настроек и опций. 



Диалоговое окно - специальный элемент графического интерфейса, 
предназначенный для реализации взаимодействия пользователя и прикладной 
программы. Обычно это взаимодействие реализуется в виде диалога, 
когда пользователь вводит данные по запросу системы. Этим объясняется 
название данного интерфейсного элемента. 

Контекстное меню - актуальное меню, содержащее самые востребованные в 
данной проектной ситуации программные ресурсы. Обычно вызывается щелчком 
правой кнопки мыши. 

Масштабирование - изменение масштаба экранного изображения. 

Модальное диалоговое окно - диалоговое окно, которое приостанавливает 
работу других интерфейсных элементов на время своей активности. Это значит, 
что оператор не может воспользоваться иными ресурсами программы, до тех пор, 
пока не уберет модальное окно с рабочего стола. 

Немодальное диалоговое окно - диалоговое окно, которое в своем активном 
состоянии не блокирует работу остальных ресурсов программы. 

Основной цвет - цвет рисующих инструментов и команд в редакторе Photoshop. 

Палитра - вспомогательная панель, которая обычно содержит настройки одного 
инструмента или параметры отдельного режима программы. 

Панель - немодальное диалоговое окно, которое объединяет функционально 
подобные программные средства, например инструменты рисования или ретуши. 

Панель инструментов - элемент графического интерфейса, предназначенный 
для размещения других интерфейсных элементов, которыми чаще всего бывают 
кнопки вызова инструментов или команд. 

Панель свойств (option bar) - управляющая панель, содержащая самые 
необходимые настройки и режимы активного инструмента или команды. Это 
контекстно-зависимая панель, ее содержимое меняется в зависимости от 
ситуации, сложившейся на рабочем столе. 

Панорамирование - изменение области обзора экранного изображения. Иногда 
эту операцию называют также скроллингом. 

Рабочее окно документа - окно, предназначенное для хранения объекта 
обработки (изображения, текстового документа, модели, чертежа и пр.). 

Рабочий стол - основное окно прикладной программы, в котором располагаются 
обрабатываемые объекты (изображения, документы и пр.) и средства обработки 
(инструменты, команды и др). 

Строка состояния - часть рабочего окна документа, в которой выводится 
справочная информация о текущем состоянии изображения. 



Фоновый цвет - цвет базового слоя. Цвет, который наносят стирающие 
инструменты и команды удаления. 
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Основные положения 

Слои по праву считаются одними из важнейших инструментов ретуши и 
рисования. В наше время даже трудно представить те технические сложности, 
которые приходилось преодолевать пользователям первых версий растрового 
редактора, лишенных возможности разбивать изображение на 
независимые страты. 



 
 

Рис. 3.1. Типы слоев 

С выходом новых версий программы постоянно растет разнообразие слоев, с 
которыми приходится иметь дело в процессе обработки растровых изображений. 
Перечислим основные типы слоев, которые способен обрабатывать редактор 
(см. рис. 3.1). 

1. Фоновый слой или слой заднего плана (Background). Это основной слой 

любого изображения. Любой отсканированный рисунок или цифровая 
фотография первоначально состоят из одного слоя заднего плана. Фон - это 
особый слой. Он накладывает определенные ограничения на применение 
отдельных команд и инструментов пакета. В частности, он не имеет режимов 
наложения, не допускает изменения прозрачности и в многослойном 
изображении может занимать только самую нижнюю позицию. 

2. Изобразительные слои. Это слои, которые порождаются командами редактора 
и предназначены для хранения фрагментов изображения. Изобразительные 
слои свободны от ограничений, которые связывают обработку фонового слоя. 



Для них разрешается задавать различные режимы наложения, менять 
прозрачность и выполнять вертикальные перестановки. 

3. Корректирующие слои (Adjustment Layers). Это новаторское средство, 

которыми так богата история программы, впервые появилось в четвертой 

версии Photoshop. Корректирующий слой хранит не графические 

данные, а сведения о настройках тона или цвета. Во всех остальных 
отношениях они ничем не отличаются от изобразительных слоев. 
Корректирующие слои очень эффективный инструмент обработки: им 
доступна и тонкая настройка изображения, и сложные задачи глобальной 
коррекции. 

4. Слои заливки (Fill Layers). С его помощью можно создавать области, 

закрашенные цветом, градиентом или узором, и объявлять эти области 
отдельным слоем. 

5. Текстовые слои. Объекты этого типа представляют собой хранилища 
редактируемого текста. 

6. Векторные слои. Эти слои предназначены для размещения векторных фигур 
(прямоугольников, овалов и др.). В программе есть несколько центров 

управления "слоевым хозяйством". Во-первых, это раздел Layer (Слой) 

главного меню, все ресурсы которого посвящены слоям. Во-вторых, многие 
команды данного раздела поддержаны горячими клавишами. Наконец, 

оперировать слоями можно при помощи специальной палитры Layers (Слои). 

Для ее вызова достаточно воспользоваться командой Window => Layers или 

просто нажать клавишу F7. 

Палитра слоев 

Многие пользователи всем остальным техникам предпочитают палитру слоев, 
поскольку она обеспечивает большую наглядность и естественность работы. 

 
 

Рис. 3.2. Палитра Layers 

Номера на рис. 3.2 обозначают: 



1. Link Layers (Связать слои). Кнопка связывания. Связывание фиксирует и 

сохраняет взаимное положение слоев. 

2. Add a layer style (Добавить стиль слоя). Выбор слоевых эффектов. Со 

слоем можно связать один или несколько изобразительных эффектов, 
например тень, сияние, рельеф и др. Эти эффекты действую только на точки 
данного слоя и допускают глубокую настройку. 

3. Add layer mask (Добавить маску слоя). Создание маски слоя. Маска -это 

вспомогательное слоевое образование, основной задачей которого 
является управление видимостью. Рисование черным цветом на маске 
позволяет скрывать соответствующие области изобразительного или 
корректирующего слоя. Это средство активно используется в методиках этого 
курса. Далее будут подробно рассмотрены свойства масок и основные приемы 
работы с ними. 

4. Create a new fill or adjustment layer (Создать новый слойзаливку 

или корректирующий слой). Создание нового корректирующего слоя или слоя 
заливки. После выбора типа слоя, он будет располагаться над активным слоем 
и действовать на все нижележащие точки изображения. 

5. Сreate a new group (Создать новую группу). Создание группы. Группа 

представляет собой папку, в которую по выбору пользователя можно занести 
изобразительные и корректирующие слои изображения. 

6. Create a new layer (Создать новый слой). Создание нового 

изобразительного слоя. Сразу после своего образования новый слой содержит 
только прозрачные точки и является активным. Это значит, что любой 
растровый объект, созданный инструментами программы, располагается на 
этом слое. 

7. Delete layer (Удалить слой). Удаление активного слоя, маски слоя или 

набора. 

8. Индикатор видимости слоя. Щелчок по индикатору отключает видимость слоя, 
повторный щелчок восстанавливает исходное состояние слоя. Невидимый 
слой является защищенным от любых изменений, к нему неприменима 
никакая операция программы. 

9. Защита прозрачных точек. Активизация режима защиты прозрачных точек 
слоя. После выбора этого режима прозрачные области слоя не могут быть 
закрашены. 

10. Выбор режима наложения. Все слои, кроме фонового, могут иметь 
различные режимы наложения. В режиме, который называется в 
программе Normal, слои ведет себя привычным образом, когда точки 
верхних уровней перекрашивают нижние пикселы. Во всех 
остальных случаях совокупный цвет получается в результате 
сложного взаимодействия точек соседних слоев. 

11. Выбор режима защиты всех точек слоя. Это означает блокировку всех точек 
слоя от обработки от окраски и изменения тоновых характеристик. 

12. Закрепление позиции. Блокировка слоя от геометрических изменений. 

13. Фиксация всех параметров слоя. После выбора этого режима все параметры 
слоя блокируются. Он остается видимым, но недоступным для всех 
обрабатывающих команд редактора. 

14. Opacity (Непрозрачность). Настройка прозрачности слоя. Чем меньше 

значение этого параметра, тем более прозрачными становятся точки слоя. 



Изменение прозрачности при помощи этого средства влечет за собой 
побочные эффекты. Во-первых, меняется прозрачность все стилей, 
назначенных данному слою, во-вторых, эта операция косвенно воздействует и 
на эффект, получаемый от режима наложения. 

15. Fill (Заливка). Этот параметр предназначен для изменения прозрачности 

самого слоя. Он не влияет на стили, связанные с данным слоем. 

16. Управляющая кнопка, предназначенная для вызова командного меню 
палитры. 

Перемещение по слоям 

При работе с многослойным изображением очень важно иметь точную 
информацию о выбранном или активном слое. В редакторе есть определенные 
средства, которые действуют избирательно, только на активный слой. К таким 
средствам относятся все рисующие инструменты, команды выделения и пр. 

Удобный способ перемещения по слоям предоставляет палитра Layers (Слои). В 

ней активный слой выделяется, синим цветом. Для выбора активного слоя 
достаточно пометить его имя в палитре слоев. Эта лаконичная техника имеет 
несколько альтернативных способов исполнения. Перечислим некоторые из них. 

 Если щелкнуть на изображении правой кнопкой мыши, одновременно удерживая 

клавишу Ctrl, то появится выпадающее меню с названиями слоев, действующих 

в данной точке изображения. Чтобы перейти к искомому слою, достаточно 
выбрать в этом меню имя нужного слоя. 

 Для перехода на слой выше можно воспользоваться комбинацией 

клавиш Alt+] (закрывающая квадратная скобка). Если текущим является самый 

верхний слой изображения, будет выполнен переход к нижнему слою. 

 Чтобы сделать активным слой, расположенный под текущим, достаточно 

нажать Alt+[ (открывающая квадратная скобка). 

Создание нового слоя 

Эта весьма востребованная операция может быть выполнена в редакторе 
несколькими разными способами: 

 Команда главного меню Layer => New => Layer (Слой => Новый => 

Слой); 

 Щелчок по кнопке Create a new layer (Создать новый слой) палитры слоев; 

 Сочетание клавиш Ctrl+Shift+N. 

Новый слой изображения не содержит никакой информации и сразу после своего 
создания становится активным. 

Дублирование слоя 

Дублирование создает новый слой, который является точной копией оригинала и 
располагается над своим родителем. Для выполнения этой операции следует 
предварительно пометить родительский слой: 



 Выполнить команду главного меню Layer => Duplicate Layer (Слой => 

Создать дубликат слоя); 

 Перетащить пиктограмму слоя-родителя на кнопку Create a new 

layer палитры слоев; 

 Воспользоваться комбинацией клавиш Ctrl+J, при условии что на родительском 

(активном) слое нет выделенных областей. 

Создание слоя на основе выделения 

Иногда требуется создать новый слой и перенести на него все выделенные точки 
изображения. Будем считать, что выделение существует и родительский слой 
является активным. Рассмотрим возможные варианты выполнения этой операции: 

 Команда главного меню Layer => New => Layer via Copy (Слой => Новый 

=> Скопировать на новый слой); 

 Сочетание клавиш Ctrl+J. 

Эти команды создают копию выделенной области на новом слое. Если требуется 
создать новый слой посредством вырезания содержимого помеченной области, то 
техника исполнения немного меняется. Для этого требуется создать пометку, 
выбрать слой и: 

 Запустить команду Layer => New => Layer via Cut (Слой => Новый => 

Вырезать на новый слой); 

 Воспользоваться сочетанием Ctrl+Shift+J. 

Слияние слоев 

Невозможно только создавать слои. Во-первых, в программе есть ограничения 
сверху на максимальное количество уровней изображения. Во-вторых, обработка 
даже самого сложного изображения когда-нибудь заканчивается и перед 
публикацией его приходится упрощать. Объединение слоев часто является 
финальной операцией технологического процесса в растровой графике. 
Рассмотрим основные возможности, которые предоставляет программа для 
объединения слоев многослойного изображения. Самый удобный способ 
выполнения этой операции дает палитра слоев. Все команды слияния 
расположены в нижней части выпадающего командного меню, которое 
вызывается щелчком по треугольной кнопке палитры. Перечислим эти команды: 

 Merge Down (Объединить с нижним). Команда выполняет объединение 

активного слоя с соседним слоем, расположенным на один уровень ниже. 
Обязательным условием является видимость обоих слоев. 

 Merge Visible (Объединить видимые). Простая команда с очевидными и легко 

предсказуемыми последствиями. Она объединяет все видимые слои 
стратифицированного изображения. 

 Flatten Image (Выполнить сведение). Команда объединяет все видимые слои 

изображения в один слой. 

Настроечные параметры слоев 



Почти все параметры слоя, выбранные при его создании, можно изменить. Это 
относится к его названию, режиму наложения, стилю и прочему. Все изменяемые 

опции слоев распределены по двум диалоговым окнам: Layer 

Properties (Параметры слоя) и Layer Style (Стиль слоя). Для вызова этих 

диалогов в редакторе есть одноименные команды главного меню. Как это часто 
бывает альтернативные способы оказываются удобнее основных. Так, для вызова 

первого окна достаточно, удерживая клавишу Alt, два раза подряд 

щелкнуть по названию слоя в палитре слоев. 

Диалог Layer Properties - это очень простой интерфейсный элемент. С его 

помощью можно сделать немногое: изменить название слоя и назначить ему 
особый цвет представления в палитре слоев (рис. 3.3). 

Для вызова диалогового окна Layer Style достаточно два раза подряд 

щелкнуть по пиктограмме слоя в палитре слоев. Это намного более сложное и 
громоздкое интерфейсное образование. Этот изобилующий 
настройками объект можно претендовать на титул самого сложного окна 
редактора. С его помощью можно назначит слою большие число различных 
параметров, например, изменить режим наложения, настроить прозрачность, 
присвоить оформительский стиль, выбрать его параметры и много другое. 

 
 

Рис. 3.3. Диалоговое окно Layer Properties 

Обсуждать содержание этого окна без примеров - это малопродуктивное занятие. 
Все необходимые теоретические сведения о нем будут вводиться по мере 
необходимости, по ходу описания практических методик. 

Уже говорилось о том, что фоновый слой накладывает множество ограничений 
на операции обработки. Преобразование фона в обычный слой снимает большую 
часть этих ограничений. Для этого достаточно выполнить двойной 
щелчок мышкой по имени фонового слоя в палитре слоев и в появившемся 
диалоговом окне ввести новое название. После переименования фоновый слой 
теряет свою исключительность, приобретая взамен возможность изменения 
прозрачности, режима наложения и некоторых других атрибутов. 



Изображение может существовать и без фонового слоя. Чтобы добавить новый 
фоновый слой в документ, который его не имеет, следует выполнить 

команду Layer => New => Background From Layer (Слой => Новый => 

Преобразовать в задний план). 

В одном документе совокупное число слоев всех типов не может превышать 8 000. 
Это ограничение имеет номинальный характер, поскольку трудно себе 
представить изображение с таким изобилием слоев, количество которых 
приближается к этому порогу. 

Корректирующие слои 

Корректирующие слои появились в четвертой версии пакета. Новинка оказалась 
весьма удачной, она была принята пользователями и подхвачена сторонними 
разработчиками программного обеспечения. В настоящее время это мощное 
средство тоновой и цветовой коррекции утвердилось в качестве отраслевого 
стандарта. Ни один профессиональный пакет растровой графики не может 
успешно конкурировать на рынке графических программных средств, не обладая 
возможностью оперировать с корректирующими слоями 

Определение 

Корректирующие слои - это слои специального назначения, несущие 
информацию об изменения цвета или тона, сделанные в процессе 
ретуши. Их главное преимущество над традиционными инструментами 
состоит в том, что управляющая информация отделяется от самого 
изображения. Это позволяет проводить эксперименты по настройке 
изображения, подбирать рациональное сочетание управляющих 
параметров, не опасаясь за оригинал, который в данном случае не 
подвергается прямому воздействию корректирующих инструментов. 

"Сегрегация" объекта и управляющего средства предоставляет множество 
преимуществ по сравнению с традиционными инструментами прямого действия. 
Так, появляется возможность настраивать корректирующие параметры, 
перемещать слой на различные уровни изображения, регулировать интенсивность 
воздействия при помощи изменения его прозрачности, настраивать области 
применения при помощи маски слоя и многое другое. 

Корректирующий слой действует на все слои изображения, расположенные ниже 
него. Это принятое в программе соглашение позволяет вносить общие изменения 
в любые нижележащие наборы и отдельные слои. Корректирующие слои - это не 
только мощное средство ретуши и цветокоррекции; их можно использовать в 
качестве средства накопления и обмена управляющей информацией. Поправки, 
внесенные в одно изображение, можно распространить на другой документ при 
помощи простого перетаскивания корректирующего слоя. При этом графические 
файлы не обязаны иметь один единый формат и общий размер. 

Для создания корректирующего слоя можно воспользоваться разделом 

главного меню Layer => New Adjustment Layer (Слой => Новый 



корректирующий слой) или щелкнуть по кнопке с длинным названием Create 

new fill or adjustment layer (Создать новый слой-заливку или 

корректирующий слой), расположенной в нижней части палитры Layers (Слои). 

 
 

Рис. 3.3. Пример корректирующего слоя 

На этом рисунке показана слоевая палитра с одним корректирующим слоем. 

1. Корректирующий слой; 

2. Маска корректирующего слоя. 

Одним из очень немногих отличий корректирующих слоев от изобразительных 
является то, что они создаются сразу с маской слоя. Большая часть остальных 
операций (перемещение, блокировка, изменение режимов наложения и пр.) 
выполняется для корректирующих слоев подобно обычным слоям. 

Виды корректирующих слоев 

Программа предоставляет доступ к пятнадцати корректирующим слоям различного 
типа: 

 Black & White (Черно-белое). Преобразование цветных изображений в черно-

белую форму; 

 Brightness/Contrast (Яркость/Контрастность). Управление уровнем яркости и 

контрастности; 

 Channel Mixer (Микширование каналов). Настройка изображения канала при 

помощи смешивания других цветовых каналов; 

 Color Balance (Цветовой баланс). Регулировка общего цветового баланса 

изображения; 

 Curves (Кривые). Настройка тонового баланса с помощью градационных кривых; 

 Exposure (Экспозиция). Настройка экспозиции; 



 Gradient Map (Карта градиента). Служит для создания и настройки градиентов; 

 Hue/Saturation (Цветовой тон/Насыщенность). Изменение цветового тона, 

насыщенности и яркости; 

 Invert (Инверсия). Инверсия цветов изображения. Эта операция выполняется 

по следующему правилу. Яркости точек каналов заменяются на противоположное 
значение. Например, если точка имела первоначально яркость, равную 20, то 

после инверсии она будет иметь яркость, равную 255-20 = 235. В частности, 

черные точки, яркость которых равна нулю, превратятся в белые с максимальной 
яркостью (равной 255) и наоборот; 

 Levels (Уровни ). Настройка тонового баланса с помощью гистограмм; 

 Photo Filter (Фотофильтр). Коррекция цветовой температуры, имитирующая 

действие фильтров используемых при фотографической съемке; 

 Posterize (Постеризация). Представление изображения в ограниченном числе 

тональных уровней. Их количество является параметром данной команды и 
выбирается пользователем. Например, если для изображения в 

модели RGB заказать только два уровня яркости, то оно будет представлено при 

помощи шести красок - по две на каждый цветовой канал. 

 Selective Color (Выборочная коррекция цвета). Изменение процентного 

содержания цветовых координат в аддитивной или субтрактивной цветовых 
моделях; 

 Threshold (Изогелия). Команда превращает цветные и полутоновые 

изображения в черно-белые. Основанием для принятия решения о цвете точки 
служит заданный пользователем порог. Все точки, яркость которых превосходит 
пороговую величину, превращаются в белые, пикселы с меньшей яркостью 
окрашиваются в черный цвет; 

 Vibrance (Вибрация). Регулировка сочности цветов. Этот корректирующий слой 

выполняет нелинейную настройку насыщенности цветов и оттенков. Он 
повышает насыщенность слабонасыщенных областей и, одновременно, 
контролирует перенасыщение цветов, близких к чистым хроматическим тонам. 

Перечисленные корректирующие слои - это средства с разной областью 
применения, эффективностью и популярностью. Так, некоторые из них 

(например, Levels, Color Balance) представляют собой мощнейшие средства 

цветовой и тоновой коррекции, получившие широкое распространение при 
решении самых разнообразных задач художественной и технической ретуши. 
Отдельные слои представляют собой вспомогательные инструменты, 
предназначенные для решения частных художественных проблем или редких 
технических задач. 

Особенности использования 

Номенклатура корректирующих слоев почти полностью совпадает с составом 

команд раздела главного меню Image => Adjustments (Изображение => 

Коррекция). Какие же преференции дает работа с корректирующим 

слоем по сравнению с командой аналогичного названия и эквивалентной областью 
применения? Эти преимущества весьма значительны и заслуживают упоминания. 



 Подобно обычным слоям Photoshop корректирующие слои располагают 

различными режимами наложения (Blending Modes). Они позволяют менять 

способ композиции точек соседних слоев. Яркость и цвет точек результирующего 
изображения рассчитываются по определенным правилам и могут значительно 
отличаться от обычного сложения пикселов. Это мощнейший ресурс, который 
дает эффективное решение многих трудных задач тоновой и цветовой 
коррекции. 

 Корректирующие слои могут иметь различную прозрачность. В программе она 

задается параметром Opacity (Непрозрачность). Изменение прозрачности дает 

возможность управлять силой воздействия корректирующего слоя на 
нижележащие слои. 

 Корректирующий слой, как и любой объект такого типа в Photoshop, можно 

перемещать по уровням изображения, управлять его видимостью, объединять в 
тематические и макетные группы, блокировать от изменений и прочее. 

 В отличие от корректирующих команд, действие слоя является легко обратимым. 
Если применение слоя оказалось неудачным, то его можно отменить простым 
отключением режима визуализации. Для этого достаточно щелкнуть на 

пиктограмме, изображенной в палитре Layers (Слои) в виде глаза. 

 Корректирующий слой разрешает не только вертикальное (через прозрачность), 
но горизонтальное управление. Это значит, что можно менять силу воздействия 
на различные точки одного физического слоя. Подобные задачи решаются при 
помощи такого мощного средства, как маска корректирующего слоя. Маска 
представляет собой специальный канал, точки которого управляют 
интенсивностью применения корректирующего слоя. Черный цвет 
маски полностью его блокирует, белый цвет снимает все ограничения 
на его применение, серый цвет в разной степени ограничивает действие 
корректирующего слоя. После создания слоя маска целиком окрашена в 
белый цвет. Создавая в маске различные градации серого, можно управлять 
интенсивностью воздействия корректирующего слоя на точки нижележащих 

слоев. Пиктограмма, расположенная в палитре Layers правее иконки слоя, 

принадлежит его маске. Чтобы ее отредактировать, надо щелкнуть по этой 

пиктограмме, удерживая клавишу Alt. 

 Выбранные параметры корректирующего слоя допускают изменение в любой 
момент работы над изображением. Некоторые из них, например режим 
наложения или прозрачность, можно модифицировать непосредственно на 

палитре Layers. Чтобы получить доступ к остальным параметрам, надо два раза 

подряд щелкнуть на пиктограмме слоя, что открывает доступ ко всем установкам 
диалогового окна слоя данного типа. Функциональные возможности 
корректирующих слоев намного превосходят потенциал аналогичных команд. Им 
следует отдать предпочтение во всех случаях, когда требуется выполнить 
большой объем сложных операций по технической ретуши или обработать 
несколько оригиналов со сходными дефектами. 

Группы слоев 

Существует множество объективных оснований для создания новых слоев. Любую 
часть изображения, которая может потребовать внесения изменений, следует 
располагать на отдельном слое. Свой вклад в "стратификацию" картинки вносят и 
слои с корректировками, заливками и специальными эффектами. 



Для поддержания порядка в "слоевом хозяйстве" изображения можно 

использовать специальное средство под названием Layer 

Group (Группа слоев). По сути дела, эти группы представляют собой папки, 

объединяющие совокупности слоев по признаку тематического или 
технологического единства. Как и обычные папки операционной 

системы Windows, содержимое наборов слоев в Photoshop можно формировать 

при помощи перетаскивания. Наборы раскрываются и закрываются щелчком левой 
кнопкой мыши на пиктограмме. Раскрытие делает доступным для обработки все 
слои, принадлежащие данному набору, закрытие маскирует его содержимое. 

На рис. 3.5 показан пример палитры Layers (Слои) с двумя группами слоев, одна 

из которых является раскрытой (2), а другая находится в свернутом состоянии (1). 
Пиктограммы групп изображаются в виде стилизованных папок. Треугольные 
кнопки служат для сворачивания и раскрытия групп. 

Чтобы создать новую группу, требуется: 

 выполнить команду главного меню Layer =>New => Group (Слой => Новый 

=> Группа). Содержимое новой группы можно сформировать простым 

перетаскиванием существующих слоев изображения на пиктограмму набора; 

 щелкнуть по кнопке Create a new group, расположенной в нижней части 

палитры слоев. 

 
 
Рис. 3.5. Наборы слоев 

Программа предлагает несколько технических приемов для удаления наборов 
слоев. Для этого можно: 



 пометить набор и выполнить команду главного меню Layer => Delete => 

Group (Слой => Удалить => Группа). 

 вывести на экран палитру Layers и перетащить набор на пиктограмму корзины, 

расположенную в правом нижнем углу палитры. 

Группы слоев - это простое и, вместе с тем, очень удобное средство 
структуризации многослойных изображений. С их помощью можно отделять 
отработанные фрагменты от незавершенных набросков, формировать 
тематические группы, разделять текстовую информацию и графическую. 

Слои освобождают пользователя от многих обременительных ограничений, 
присущих всем растровым редакторам и объясняемых самой природой точечных 
изображений. Какую же цену приходится платить пользователю за использование 
слоев в процессе ретуширования или рисования? В общем случае, многослойное 
изображение требует большей памяти для своего хранения на диске и в 
оперативной памяти, нежели его "плоский аналог". Сложная техническая ретушь и 
цветокоррекция полноцветных изображений - это одна из самых развитых 
областей компьютерной графики. Серьезные задачи требуют для своего решения 
профессионального подхода и развитых технических средств. Прогресс 
современных вычислительных средств стремительно сокращает дистанцию между 
любительскими и профессиональными приложениями персонального компьютера. 

Опытные операторы стараются сохранить все слои изображения до полного 
окончания процесса обработки. Финальной операцией, завершающей 
установленную процедуру сдачи-приемки работы, целесообразно сделать 
сведение слоев. Подобный консерватизм можно считать вполне оправданным, 
поскольку объединениеслоев является операцией, последствия которой не всегда 
легко отменить. 

Маска слоя 

Маска слоя (layer mask) - это один из самых удобных способов управления 

видимостью изобразительных и корректирующих слоев изображения. Она 
позволяет частично скрыть содержимое редактируемого слоя. Маскирование 
пикселов изображения выполняется на основе информации дополнительного 
канала, который автоматически порождается программой после создания маски 
слоя. 

Основные положения 

Cовершенно корректное определение маски слоя, приведенное в предыдущем 
абзаце, мало дает для понимания сути происходящего. Приведем определение, 
использующее аналогию. 

Действие маски слоя можно сравнить с пленкой, которая закрывает изображение 
данного слоя. Если нанести на пленку черную краску, то будут полностью скрыты 
все части оригинала, расположенные под закрашенными областями. Для 
непосвященного наблюдателя это равносильно стиранию изображения. 



Рисование на маске белой краской равносильно созданию областей прозрачности. 
Это значит, что в этих фрагментах сохранится видимость точек изобразительного 
слоя. Остальные цвета делают пленку полупрозрачной, в зависимости от своей 
близости к одному из граничных цветов белому или черному. 

Все изменения маски не затрагивают основной изобразительный слой. Фактически 
его пикселы остаются в неприкосновенности, меняется только их видимость, в 
зависимости от цвета соответствующих точек маски. 

 
 

увеличить изображение 

Рис. 3.6. Применение маски слоя 

Действие маски слоя можно продемонстрировать на примере, показанном на рис. 
3.6. Это однослойное изображение с хорошим контрастом фона и изображения 

фламинго. Важно, что слой не является фоновым (Background), иначе создать 

маску было бы невозможно. Маска слоя Layer 0 повторяет очертания фона, 

поэтому в рабочем окне можно видеть только изображения птиц. 

http://www.intuit.ru/EDI/27_04_15_5/1430086749-14056/tutorial/1047/objects/4/files/04-06.jpg


 
 

Рис. 3.7. Применение переходной маски слоя 

На рис. 3.7 показан еще один пример с маской слоя. В оригинале на нем 
нарисован эффектный желтый утенок на белом фоне. При помощи маски 
слоя получен эффект таяния образа, когда картинка плавно сливается с фоном, 
как бы перетекает в него. Маска, которая реализует этот эффект, представляется 
в виде градиента - плавного перехода от черного цвета к белому. Его черные 
точки полностью закрывают оригинал, белые точки маски делают 
изобразительный слой видимым, а все промежуточные градации серого цвета 
превращают его в полупрозрачный. 

Следует ясно понимать разницу между двумя состояниями обрабатываемого 
изображения. Работа на слое и на его маске влечет за собой совершенно 
различные последствия для изображения. В первом случае средства программы 
применяются к точкам изображения. Во втором случае обработка ведется на 
дополнительном объекте, который хотя и связан со слоем, но не эквивалентен 
ему. Многие особенности поведения масок можно предсказать и объяснить, если 
рассматривать их как дополнительный полутоновый слой, наложенный на 
основной пласт изображения. 

Техника обработки 

Маски слоя - это очень гибкий инструмент, их использование дает эффективное 
решение традиционно трудных для растровой графики задач, таких как создание 



"бесшовного" монтажа, ограничение области действия корректирующего слоя и 
других. 

Средства работы с масками слоев в программе многочисленны и 
разнообразны по технике исполнения. Для создания маски требуется пометить 

слой в палитре Layers (Слои) и выполнить команду главного меню Layer => 
Layer Mask => Reveal All (Слой => Маска слоя => Показать 

все) или Hide All (Скрыть все). Первый вариант команды создает маску белого 

цвета, которая никак не влияет на вешний вид изображения. Команда Hide 

All порождает маску черного цвета, которая полностью закрывает точки 

изобразительного слоя. Понятно, что однородные маски такого вида не имеют 
большого смысла. Обычно после создания, маски перекрашиваются так, как этого 
требует решаемая задача. 

Ситуация меняется, если на слое есть выделенная область. В этом случае команды 

создания масок меняют свое название: Reveal Selection (Показать 

выделенную область) и Hide Selection (Скрыть выделенную область). Кроме 

того, они создают неоднородные маски, которые по своей форме совпадают с 
выделенной областью или ее дополнением. 

 
 

Рис. 3.8. Маска, созданная командой Reveal Selection 

Продемонстрируем работу этих команд на очень примере изображения листочка 
на черном фоне. Будем считать, то существует выделенная область, которая 
включает в себя только листок. На рис. 3.8 показана маска, которая создается 

командой Reveal Selection. Она сохраняет изображение листочка, но скрывает 

фон. 



 
 

Рис. 3.9. Маска, созданная командой Hide Selection 

На рис. 3.9 представлен вариант картинки с маской, созданной командой Hide 

Selection. В этом случае ситуация обращается. Созданная маска прячет фигуру 

центрального плана и открывает изображение фона. 

Более наглядный и оперативный способ создания масок дает палитра слоев. Маску 

белого цвета можно создать щелчком по кнопке Add layer mask, 

расположенной в левой части нижнего ряда палитры. Если выполнить тот же 

прием, удерживая клавишу Alt, то новая маска получит черный цвет. 

Новая маска автоматически становится активной. Об этом свидетельствует 
дополнительная рамка вокруг пиктограммы маски и специальная метка в 

заголовочной строке рабочего окна документа (например, Layer Mask/ 8). 

Создание сложных графических проектов требует многочисленных экспериментов, 
когда приходится сравнивать варианты изображения с маской и без нее. Маску 
слоя можно временно отключить, как показано на рис. 3.10. Для этого следует 

выполнить команду главного меню Layer => Layer Mask => Disable (Слой 

=> Маска слоя => Выключить). Включить неактивную маску 

можно по команде Layer => Layer Mask => Enable. Необходимым условием 

этих операций является выделение обрабатываемого слоя. 



 
 

Рис. 3.10. Изображение с отключенной маской слоя 

Как обычно, более удобный способ дает палитра слоев. Для включения или 

отключения маски требуется щелкнуть, удерживая клавишу Shift, щелкнуть 

кнопкой мыши по ее пиктограмме в палитре Layers. 

Маска и изобразительный слой связаны между собой не только по вертикали 
(отношением маскирования), но и по горизонтали (отношением геометрических 
преобразований). Если смещать, поворачивать, наклонять слой и пр., то 
аналогичные преобразования претерпит и маска. Эту связь можно разорвать, если 
убрать значок цепи, который расположен между пиктограммами слоя и маски в 
палитре слоев. Для этого достаточно один раз щелкнуть мышкой по этому значку. 
Повторный щелчок восстанавливает разрушенную связь между слоем и его 
маской. 

Завершенную или ненужную маску можно удалить. Для этого можно 

воспользоваться командами Layer => Layer Mask => Apply (Применить 

маску) или Layer => Layer Mask => Delete (Удалить маску) из 

контекстного меню, которое вызывается щелчком правой кнопкой мыши. Другой 
способ избавится от маски - это перетащить ее на пиктограмму корзины в палитре 

слоев и выбрать нужную реакцию (Apply или Delete) на это действие. 

Маска корректирующего слоя 

Напомним, что корректирующими в редакторе называются слои, предназначенные 
для хранения не графических данных, а информации о различных процедурах 
обработки. Разница определений между изобразительными и корректирующими 
слоями не означает значительных расхождений в технике их обработки. Большая 



часть операций выполняется совершенно одинаково для обоих типов объектов. 
Это относится и к технике обработки масок корректирующих слоев. 

Любой новый корректирующий слой по умолчанию получает маску сразу после 
своего создания. Если изображение не содержало выделенных областей, то 
создается маска, полностью закрашенная белым цветом, которая не накладывает 
никаких ограничений на действие корректирующего слоя. 

Иная ситуация складывается в том случае, когда изображение имеет выделенные 
фрагменты. Теперь воздействие корректирующего слоя должно быть ограничено 
помеченной областью. Для этого вновь созданный слой получает маску, 
которая по форме совпадает с существующим выделением. Все точки за 
пределами ее границы окрашиваются в черный цвет, внутренние области маски 
становятся белыми. При помощи такого распределения цветов достигается 
требуемая локализация корректирующего слоя. 

Подчеркнем еще раз небольшую разницу, которая существует между масками 
изобразительных и корректирующих слоев. Черные фрагменты маски для 
изобразительного слоя означают области прозрачности, где маска скрывает точки 
данного пласта оригинала. Маски корректирующих слоев ограничивают область 
действиясоответствующей команды. Белые области маски разрешают 
исправляющее воздействие, черные блокируют от него нижние слои. 

Ключевые термины 

Векторный слой - слой растрового изображения, предназначенный для 
размещения векторных объектов. 

Группа слоев - набор слоев, объединенных под одним именем. 

Изобразительный слой - слой растрового изображения, предназначенный для 
размещения растровых фрагментов изображения. 

Корректирующий слой - слой растрового изображения, хранящий не пикселы, а 
корректирующие команды или изобразительные эффекты. 

Маска слоя - способ управления видимостью изобразительного слоя или силой 
воздействия корректирующего слоя. Представляет собой отдельный канал, в 
котором хранится информация о видимости каждой точки изобразительного или 
корректирующего слоев. 

Режим наложения - способ взаимодействия соседних слоев растрового 
изображения. В нормальном режиме наложения точки верхнего слоя просто 
перекрашивают соответствующие пикселы нижнего слоя. В других режимах 
наложения видимый цвет и тон получается в результате более сложного 
взаимодействия соседних слоев, когда результат вычисляется по цветовым 
координатам одноименных точек. 

Слой - независимая часть растрового изображения, расположенная на одном 
вертикальном уровне. 



Слой заливки - слой растрового изображения, предназначенный для создания 
сплошных заливок, узоров или градиентов. 

Текстовый слой - слой растрового изображения, хранящий текст в 
редактируемой форме. 

Фоновый слой - первый, базовый слой растрового изображения. Средства 
обработки программы применяются к этому слою с некоторыми важными 
ограничениями. Так, он не может иметь прозрачных областей, к фоновому слою 
не применяются команды трансформации и слоевые маски. 
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Форматы шрифтовых файлов 

Компьютерные шрифты делятся на два основных типа по способу построения 
символов: растровые и векторные. Разница та же, что и между точечными и 
векторными изображениями. 

Растровый шрифт представляет собой набор точек, образующих символы 
(т.е. литеры описываются как совокупности точек). В связи с этим не существует 
эффективного способа изменять размеры шрифта и приходится для каждого кегля 
хранить отдельные наборы символов. Попытка масштабирования такого шрифта 
при ощутимом коэффициенте увеличения приводит к появлению так называемого 
лестничного (ступенчатого) эффекта, когда символы кажутся созданными из 
крупных блоков без сглаживания стыков. 

В векторном шрифте каждый символ состоит из набора точек, соединенных 
линиями таким образом, что они образуют контур символа. Поэтому такие шрифты 
иногда называют контурные (масштабируемые) и описывают их с помощью каких-
либо математических средств (векторов, дуг, сплайнов и т.п.). 

Векторные шрифты могут легко масштабироваться путем изменения пропорций 
между точками, которые в свою очередь, изменяют длину линий, соединяющих 
эти точки. При увеличении размера векторные шрифты не теряют плавность 
линий. 

Наиболее популярны векторные шрифты корпорации Adobe Systems, 
разработавшей стандарт Adobe Type 1 (или Post Script), и Microsoft Corp., 
создавшей формат Microsoft Тruе Туре. Оба стандарта имеют свои достоинства, 
что привело к их параллельному сосуществованию. 

Шрифт Microsoft True Type состоит из одного файла *.ttf. 
В Windows шрифты True Type размещаются в папке Windows\Fonts. Установить, 
удалить, просмотреть такой шрифт без особого труда сможет 
любой пользователь ОС Windows. 



Шрифт Adobe Type 1 (Post Script) состоит из двух компонентов: растрового 
*.pfm (экранного) и векторного *.pfb (принтерного) файлов (либо из файлов *.pfb, 
*.afm и *.inf). С такими шрифтами обычно работают только профессионалы, а 
управлять ими удобнее при помощи специальной программы - Adobe 
Type ManagerDelux (АТМ). 

Использование кривых более высокого порядка и обуславливает основные 
преимущества PostScript шрифтов перед TrueType. Иначе говоря, символы 
PostScript шрифта являются более гладкими, чем TrueType. Из сказанного выше 
следует, что для полиграфических работ шрифты Adobe Type 1 (или Post Script) - 
лучше. ДляInternet - документов предпочтительнее использование Microsoft Тruе 
Type. 

Операционная система Windows поддерживает два формата шрифтов - растровый 
(*.FON), и векторный TrueType (*.TTF). В Windows формату True Type отдается 
предпочтение. 

Как уже говорилось выше, растровые шрифты (*.FON) - это точечные 
изображения, хорошо приспособленные для быстрого вывода на экран. Обычно 
это служебные шрифты, которые использует для своих нужд сам компьютер. В 
составе Windows, по умолчанию, поставляется пять базовых растровых шрифтов: 
MS Serif, MSSans Serif, Courier, Small Fonts и Symbol. При желании их число можно 
увеличить путем установки дополнительных fon-шрифтов. 

Векторные шрифты True Type (*.TTF) шрифты хранятся в виде математических 
линий (векторов), и эту информацию Windows может использовать для построения 
шрифта произвольного масштаба. Даже будучи увеличенными, во много 
раз, векторные шрифты не теряют своего внешнего вида и остаются гладкими. 

В составе Windows по-умолчанию поставляется большое количество 
шрифтов True Type, включая такие популярные группы как Arial, Courier New, и 
Times New Roman, каждая из которых содержит несколько шрифтов различных 
стилей (обычный, курсив, полужирный и полужирный курсив). 

Что касается источников появления шрифтов на вашем ПК, то шрифты, как и 
прочие программные продукты, продаются изготовителями. Основные 
производители шрифтов: Adobe, Bitstream, The International Typeface Corporation, 
Microsoft, Monotype, Letraset Online, Linotype, Type Market, ParaType. Часто 
большие коллекции шрифтов поставляются вместе с некоторыми графическими, 
издательскими или офисными программами. 

Классификация шрифтов 

Все компьютерные шрифты условно можно разделить на 4 группы: 

 шрифты с засечками (антиква - serif), 

 шрифты без засечек (гротески - sans serif), 

 шрифты декоративные (decorative), в том числе и рукописные (script), 

 шрифты символьные (symbol). 



Российская классификация по ГОСТ 3489-71 и 72 разделяет шрифты на 6 групп, 
однако фактически все гарнитуры снова можно представить в 4 основные, уже 
упомянутые, группы. 

Группа 1. Шрифты с засечками (serif) 

Засечки, или серифы - горизонтальные элементы окончания основных (иногда 
соединительных) штрихов имеют самую разнообразную форму: прямоугольную, 
изогнутую, клювообразную и т.п. Эти шрифты воспринимаются глазом наиболее 
быстро, и поэтому часто используются для набора большого, объемного текста. 
Характерный шрифт из этой группы - Times. Шрифты с засечками также называют 
антиквенными, то есть античными. 

Группа 2. Шрифты без засечек (sans serif - гротески, рубленые или брусковые) 

В шрифтах без засечек (sans-serif) отсутствуют завершающие элементы на концах 
штрихов. Название sans-serif происходит от французского sans - без. Типичный 
представитель этой группы шрифтов - шрифт Arial. Рубленые заголовочные 
шрифты обычно имеют более толстые, чем серифы, штрихи и хорошо смотрятся в 
крупном кегле. Шрифты без засечек, читаются медленнее антиквенных, 
однако заголовки, набранные этими шрифтами смотрятся более эффектно, кроме 
того, на устройствах с низкой разрешающей способностью (например - на 
мониторах) такой шрифт читается легче. 

Группа 3. Шрифты декоративные или свободного стиля (Decorative) 

К этому классу относятся все остальные шрифты. К ним можно отнести 
рукописные, специальные, рекламные, художественные и прочие шрифты, 
которые нельзя отнести к первым двум группам. Декоративные шрифты имеют 
произвольный рисунок символов и применяются в основном как элементы 
дизайна. Чаще всего декоративные шрифты используют в заголовках. 
Использование подобных шрифтов в качестве основного текста является 
дизайнерской ошибкой, так как они неудобочитаемы. 

Группа 4. Символьные шрифты (Symbol) 

Особое место занимают так называемые символьные шрифты, которые вместо 
букв содержат различные знаки, рисунки и т. д. и применяются, конечно, не для 
набора текста, а для создания графических объектов или формул. 

Атрибуты шрифта и текста 

При рассмотрение не отдельных букв, а их совокупности (образующей текст), 
появляются новые термины. 

Текст (от лат. textus ткань, соединение) - любая записанная посредством шрифта 
речь (литературное произведение, сочинение, документ). 

Стиль текста - совокупность всех параметров оформления текста, присущих 
данному его отрезку. 



Атрибуты стиля текста включают следующие понятия, как: гарнитура шрифта, 
начертание, кегль, интерлиньяж, межбуквенный просвет, междусловный пробел, 
выключка, отступ первой строки, втяжка (отступы справа и слева), межабзацные 
отбивки, другие приемы оформления ( рис. 3.1). 

 
 

Рис. 3.1. Пример нескольких атрибутов шрифта 

Примечание 

Кегль и интерлиньяж оценивают в пунктах. 1 пункт равен 1/72 дюйма, то есть 
0,352 мм. 

Гарнитура и начертание шрифта 

Гарнитура шрифта (Type family) - совокупность шрифтов, объединенных общими 
стилевыми признаками, отличными от других шрифтов. Это как бы семья 
шрифтов, т.е. совокупность вариантов шрифта с общими стилевыми 
особенностями знаков, имеющее собственное наименование и отличающиеся 
различной насыщенностью, пропорциями, наклоном и стилем. Шрифты одной 
гарнитуры могут иметь различные начертания. 

Начертание (Type face) - комплект строчных и прописных знаков, цифр, знаков 
препинания, спецзнаков и символов шрифта в пределах одной гарнитуры, но 
отличные насыщенностью, пропорциями, контрастностью и наклоном знаков. Для 
каждого конкретного шрифта существует несколько вариантов начертания: 
светлое (light), суперсветлое (extra light), полужирное (demi bold), супержирное 
(extra bold), сжатое (compressed или condensed) и так далее. Наиболее 
распространенные начертания - Normal (обычный), Bold (полужирный), Italic 
(курсив или наклонный). 



При наборе математических, химических и других формул часто используются 
индексы. Индекс - это атрибут символа и он может быть задан, как и прочие 
атрибуты текста. Кнопки Superscript (верхний индекс) и Subscript (нижний индекс) 
изменяют кегль символа и перемещают его в положение соответствующего 
индекса. 

При работе с текстом важную роль играет понятие абзац - часть текста, связанная 
смысловым единством и выделенная отступом первой строчки. От больших 
блоков, не расчлененных на абзацы, читательское восприятие притупляется. 
Выделяя значимые части текста, абзац выполняет роль своеобразного акцента, 
активно воздействующего на внимание человека. Обычно новый абзац текста 
начинается отступом первой строки, при котором перед первой буквой строки 
вставляется пробел определенной величины. Отступ первой строки (абзацный 
отступ) может быть положительным (в этом случае первая строка сдвигается 
вправо относительно всех остальных строк абзаца) или отрицательным (первая 
строка выходит влево за край основного текста, то есть все строки абзаца, 
начиная со второй, смещаются относительно первой строки вправо на некое 
фиксированное расстояние). Кроме того, абзац может вовсе не иметь абзацного 
отступа. 

Выключка (Justified) или выравнивание отражает расположение текста 
относительно вертикальных границ листа. Наиболее часто используется выключка 
по левому краю, по правому краю, по центру или по ширине. Отметим, что 
выравнивание не имеет смысла для отдельных символов, так как это атрибут 
абзаца. Выравнивание может быть задано для каждого абзаца отдельно. Для того 
чтобы придать абзацу нужное выравнивание, текст нужно предварительно 
выделить. 

Советы по работе со шрифтами 

Эмпирически установлено, что при работе с текстом и шрифтами рекомендуется 
придерживаться следующих правил: 

 в цветных публикациях назначайте фону и тексту контрастные цвета: темные 
буквы на темном фоне, равно как и светлые буквы, на светлом фоне читаются с 
трудом; 

 проверяйте контрастность текста и фона, переключаясь в градации серого; 

 стиль шрифта должен соответствовать содержанию шрифтового документа. Так, 
глупо использовать в наборе детских книг старославянские шрифты; 

 избегайте раздражающего сочетания ярких цветов в деловых документах. 
Например, сочетание желтого с красным очень эффектно для продукции с 
ярлыком "New!", но такое цветовое решение для оформления повседневных 
надписей неуместно; 

 общепринятым стандартом является применение гарнитур с засечками для 
основного текста и рубленых или декоративных - для заголовков; 

 избегайте одинаковых гарнитур для заголовков и основного текста: для 
выделения заголовков и подзаголовков применяйте более жирное начертание; 



 длинные строки имеет смысл верстать в две или более колонок. Для 
удобочитаемости текста, оформленного кеглем 10, оптимальная длина строки 
примерно 85 мм; 

 для удобочитаемости текста важную роль играют поля. Например, в 
классическом книгопечатанье поля занимают около 50% площади страницы. 

Инструменты для работы с текстом в Photoshop 

Для ввода текста используется специальный инструмент Text (Текст), 
активизируемый нажатием соответствующей кнопки в панели инструментов или 
путем нажатия клавиши T. Однако в большинстве случаев работа с надписями 
состоит не только из их непосредственного ввода, а также из задания параметров 
(атрибутов) вводимого вами текста. Для этих целей используется панель свойств 
инструмента Text (Текст), отображаемая сразу же после выбора этого 
инструмента - рис. 3.2. 

 
 

 

Рис. 3.2. Панель свойств инструмента Текст 

Ниже приведены пояснения к названиям элементов управления этой панели. 

Выбор установок инструментов позволяет задавать следующие параметры: 

Horizontally Orient 

Text (Горизонтальный 

текст) 

Для создания слоя обычного 

текста, направленного по 

горизонтали. Данный режим 

установлен по умолчанию. Пишем 

тем цветом, который установлен в 

качестве основного (цвета 

переднего плана); 

Vertically Orient Text 

(Вертикальный текст). 

Позволяет создавать обычный 

текст, написанный сверху вниз; 

Create a horizontally 

mask or selection 

(Горизонтальный 

текст-маска). 

Применяется для создания 

выделений из литер текста, 

написанного по горизонтали; 

http://www.intuit.ru/EDI/17_08_15_4/1439763591-611/tutorial/1023/objects/5/files/05_02.jpg


Create a vertically mask 

or selection 

(Вертикальный текст-

маска). 

Инструмент создает выделенный 

текст, направленный по 

вертикали. 

Список Set the font family (Установить гарнитуру шрифта) содержит набор 
всех доступных шрифтов. Чтобы изменить гарнитуру шрифта, выделите 
текстовый объект, а затем выберите из списка другую гарнитуру. 

Список Set the font style (Установить начертание) предназначен для выбора 
стиля написания текста (полужирный, курсив, подчеркнутый или другой). 

Список Set the font size (Установить размер) служит для установки кегля 
(размера) шрифта выбором из набора значений или путем непосредственного 
ввода в числовое поле. В том случае, если имеющиеся размеры вам не подходят, 
то можно воспользоваться командой Edit (Редактирование) | Free Transform 
(Свободная трансформация) и изменить как размер, так и отражение шрифта 
- рис. 3.3. 

 
 

Рис. 3.3. Свободная трансформация текста 

Список Set the anti-aliasing mode (Установить сглаживание) используется 
для улучшение качества отображения литер мелкого текста. Иначе говоря, здесь 
вы указываете способ избавления от ступенчатости шрифтов. По умолчанию, 
предлагается вариант Smooth (Плавное), что вполне приемлемо. 

Выключка текста предлагается в трех вариантах: 

Left align text 

(Выравнивание по 

левому краю). 

Выравнивает выделенный 

абзац текста или отдельную 

строку текста по левому краю; 



Center text 

(Выравнивание текста по 

центру). 

Выравнивает выделенный 

абзац текста или отдельную 

строку текста по центру; 

Right align text 

(Выравнивание текста по 

правому краю). 

Выравнивает выделенный 

абзац текста или отдельную 

строку текста по правому краю. 

Поле с образцом цвета Set the text color (Установить цвет 
текста) необходимо для выбора цвета текста. По умолчанию используется тот 
цвет, который у вас определен основным цветом или цветом переднего плана 
(Foreground color). 

Кнопка Warp Text (Деформация текста) - инструмент искривления текста, 
предлагающий 15 вариантов его искажений (рис. 3.4). 



 
 

 

Рис. 3.4. Пример деформации текста дугой 

Пользоваться инструментом Warp Text (Деформация текста) достаточно 
просто: наберите текст, затем нажмите на кнопку для вызова окна диалога Warp 
Text (Деформация текста) и установите в нем атрибут Style (Стиль) - стиль 
искривления текста. Все стили деформации текста поддаются настройке с 
помощью трех ползунков: 

Bend (Изгиб) настраивает степень 

закругления текста; 

http://www.intuit.ru/EDI/17_08_15_4/1439763591-611/tutorial/1023/objects/5/files/05_04.jpg


Horizontal Distortion 

(Горизонтальное 

искривление) 

искажение текста в 

горизонтальном 

направлении; 

Vertical Distort 

(Вертикальное искривление) 

искажение текста в 

вертикальном направлении. 

Если при наборе текста вы на Панели свойств нажмете на кнопку Show the 
Character and Paragraph Palettes (Включить 

палитры) , то осуществляется вызов двух палитр 
- Character (Символ) и Paragraph (Абзац), предназначенных для 
форматирования текста ( рис. 3.5). 

 
 

Рис. 3.3. Палитра Символ/Абзац 

Точно такие палитры имеются во многих издательских пакетах (Page Maker, 
InDesign), поскольку они существенно расширяют возможности пользователя в 
работе с текстом, дополняя панель свойств новыми возможностями. 
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Обтравочная маска 

Несколько смежных слоев могут образовывать так называемую 
макетную группу (clipping group), в которой точки нижнего слоя, 
называемого базовым, управляют видимостью верхних слоев. В этой 
ситуации изображение базового слоя называется обтравочной маской 
(clipping mask). Прозрачные пикселы базового слоя скрывают соответствующие 
области верхних слоев изображения, входящих в макетную группу. Непрозрачные 
точки базового слоя образуют области видимости, полупрозрачные области дают 
промежуточные градации отношения маскирования. 



 
 

Рис. 4.1. Пример макетной группы 

Сказанное можно проиллюстрировать примером, приведенным на рис. 4.1. Два 
слоя изображения образуют макетную группу, в которой текст нижнего слоя 
служит маской для узора верхнего слоя. В результате, верхнее изображение 
проявляется только в областях непрозрачности базы, т.е. на буквах надписи. 
Прямоугольная фоновая сетка на этом рисунке - это стандартный способ 

представления областей прозрачности в Photoshop. 

Рассмотренный пример хорошо иллюстрирует способ представления макетных 
групп в редакторе. Название нижнего слоя, который выполняет функции 
обтравочной маски, подчеркивается. Названия всех элементов группы, кроме 
базы, сдвигаются в правую сторону и помечаются специальной пиктограммой виде 
ломаной стрелки. 

В программе почти нет ограничений на состав макетных групп. В частности, в нее 
могут входить и корректирующие слои. В обычном состоянии корректирующий 
слой действует на точки всех изобразительных слоев, расположенных ниже. Это 
разумное соглашение, принятое в программе, иногда требуется изменить. Часто 
требуется создать слой с ограниченной зоной действия, в область 
определения которого входят только несколько нижележащих уровней. Эту задачу 
проще всего решает образование макетной группу, в которую вместе с 
исправляющим слоем входят только те изобразительные слои, которые должны 
подвергнуться корректировке. 

Для создания макетных групп редактор предлагает несколько различных 
способов: 



 Удерживая клавишу Alt, щелкнуть мышкой на линии, разделяющей слои в 

палитре Layers (Слои). В состоянии готовности курсор мыши должен принять 

форму стилизованной цепи со стрелкой. 

 Пометить слой в палитре Layers и выполнить команду главного меню Layer => 

Create Clipping Mask (Слой => Создать обтравочную маску). 

 Пометить слой в палитре Layers и воспользоваться комбинацией 

клавиш Alt+Ctrl+G. 

Для разделения макетной группы на составляющие можно: 

 Удерживая клавишу Alt, щелкнуть на разделительной линии в 

палитре Layers (Слои); 

 Пометить любой слой макетной группы (не базовый) и выполнить команду 

главного меню Layer => Release Clipping Mask (Слой => Отменить 

обтравочную маску); 

 Пометить слой (не базовый) и воспользоваться комбинацией 

клавиш Alt+Ctrl+G. 

Приведем краткую сводку правил образования макетных групп. В макетную 
группу могут входить несколько смежных слоев. Самый нижний из них, который 
называется базовым слоем, действует как маска на все верхние слои группы. 
Прозрачные области базового слоя блокируют видимость, а окрашенные области 
разрешают визуализацию соответствующих частей изображения. 

Кисти 

Первые версии редактора располагали ограниченными средствами работы с 
кистями, что ограничивало конкурентоспособность программы в области чистого 
рисования. Начиная с седьмой версии пакета это ограничение преодолено и 
пользователю предлагается такое изобилие разнообразных настроек кистей, 
которое способно смутить даже самых стойких ветеранов растровой графики. 
Кажется, разработчики предусмотрели все возможные варианты формы и 
поведения рисующих инструментов. Теперь кисть может наносить мазки 
произвольной формы и имитировать множество нюансов поведения рисовальщика 
и художника: дрожание руки, неравномерность истечения краски, неоднородность 
материала и пр. 

Может ли технологическая свобода хотя бы отчасти заменить недостаток 
способностей к рисованию? Трудно сказать. Может быть, тут будет 
уместна аналогия с шахматами. Усердный шахматист, который прилежно 
штудирует руководства по теории дебютов и назубок изучил типовые окончания, 
может рассчитывать на самую высокую спортивную квалификации, но ему никогда 
не стать чемпионом или великим игроком без того качества, которое принято 
называть искрой божьей. 

Настройки кисти 



Основные настройки кистей расположены в палитре Brush (Кисть), показанной 

на рис. 4.2. Для вызова этого средства можно выполнить команду 

главного меню Window => Brush (Окно => Кисть) или нажать кнопку, 

расположенную в левой части панели Options (Панель свойств). 

 
 

Рис. 4.2. Палитра Brush 

Подробное описание всех ресурсов этого содержательного интерфейсного 
средства можно уложить, разве что, в отдельную главу. Овладеть тонкостями 
создания кистей можно только методом проб и ошибок. Никакое, даже самый 
обстоятельный рассказ об этом множестве настроек не может дать ту 
квалификацию, которая приобретается только опытом. Поэтому, приведем только 
общее описание основных опций, оставляя глубокое изучение темы 
экспериментам с редактором. 

Левая колонка палитры объединяет названия разделов, посредством которых 
выполняется выбор кисти и задаются ее многочисленные настройки: 

 Brush Presets (Наборы кистей). Раздел содержит библиотеку стандартных 

кистей. Все библиотечные кисти представлены в правой части палитры трассами, 
которые они оставляют в процессе рисования. Размеры выбранной кисти можно 
изменить при помощи интерактивного ползунка или прямым указанием 



требуемого диаметра. Все необходимые для этого интерфейсные элементы 
расположены в нижней части палитры; 

 Brush Tip Shape (Форма отпечатка кисти). В этом разделе объединены 

базовые настроечные параметры, позволяющие изменить диаметр кисти, угол 
наклона, жесткость, форму, интервалы между смежными мазками; 

 Shape Dynamics (Динамика формы). Данный раздел предлагает 

многочисленные настройки, предназначенные для внесения случайных 
изменений в форму кисти. При правильном сочетании параметров можно 
получить изображение трассы, напоминающей след натурального инструмента - 
кисти или мягкого карандаша. Гладкость и прямизна - это признаки абстрактных 
форм, которые никогда не встречаются в живой природе. Поэтому дозированная 
случайность позволяет внести в композицию факторы естественности; 

 Scattering (Рассеивание). Объединяет настройки, которые вносят случайность 

в пространственное расположение мазков кисти. Отличие настроек этого раздела 
от предыдущего проще всего показать на примере. Пусть выбрана круглая форма 

кисти. В разделе Shape Dynamics можно задать параметры случайных 

изменений этой формы. В этом случае, вдоль трассы, проведенной кистью, 
программа разместит мазки круглой формы, диаметр которых меняется по 
некоторому стохастическому правилу. При помощи параметров 

раздела Scattering можно задать некоторую область, в пределах которой 

будут расположены мазки кисти. Их частота и положение также подчиняются 
некоторому случайному закону. В технике области такого вида принято называть 

трубками. Размеры трубки зависят от параметра Scatter. С ростом этого 

параметра, увеличивается размер трубки и след кисти теряет связность, 
постепенно превращаясь в хаотично расположенный набор отдельных штрихов. 
При максимальных установках разброса и кисти маленького диаметра след, 
который оставляет за собой этот инструмент, напоминает раскраску холста 
пульверизатором с большого расстояния; 

 Texture (Текстура). Средствами этого раздела палитры можно связать с кистью 

некоторую текстуру и выбрать ее параметры. Использование кисти с подобными 
свойствами напоминает рисование на материале с хорошо выраженным 
рельефным рисунком, например мешковине или грубом брезенте. 

 Dual Brush (Двойная кисть). Включает режим рисования сдвоенной кистью и 

позволяет выбрать параметры второго инструмента. Установки первой кисти 

выполняются в разделе Brush Tip Shape. Этот режим рисования открывает 

перед пользователем очень большие возможности по созданию самых 
разнообразных художественных эффектов, но обилие настроек и трудно 
предсказуемые последствия сочетания многочисленных параметров затрудняют 
работу в режиме сдвоенной кисти; 

 Color Dynamics (Динамика цвета). Средствами этого раздела можно внести 

случайность в раскраску трассы, которую оставляет за собой кисть. Необычные 
цветовые сочетания, создаваемые кистью в этом режиме, очень интересны и 
иногда напоминает работу гипотетического генератора иллюзий; 

 Transfer (Передача). В этом разделе можно задать случайные изменения 

непрозрачности кисти и скорости переноса краски; 

 Noise (Шум). Включение этого переключателю вносит в след, оставляемой 

кистью небольшие флуктуации случайного характера. Этот эффект особенно 



заметен для кистей с мягкими краями. Шумовой эффект отчасти напоминает 

рисование кистью в режиме Dissolve (Растворение); 

 Wet Edges (Влажные края). Переключатель управляет специальным эффектом 

"влажные края кисти". Это тот редкий случай в техническом переводе, когда 
подстрочник точно передает смысл английского оригинала. Действительно, в 
этом режиме неравномерность распределения краски создает иллюзию мокрых 
краев рисующего инструмента. Для некоторых цветов и кистей определенных 
размеров и конфигураций этот эффект напоминает рисование акварельными 
красками; 

 Airbrush (Аэрограф). Выбор этой опции переключает кисть в режим аэрографа. 

Ранее это средство было оформлено, как самостоятельный инструмент и 
представлено собственной кнопкой на панели инструментов. По сравнению с 
обычной кистью аэрограф дает более воздушный мазок. Кроме того, он 
позволяет накапливать краску в обрабатываемой области. Это проще всего 
проверить следующим простым экспериментом. Надо просто нанести 
непрерывный мазок в одной точке изображения. Для этого требуется, не смещая 
кисти, удерживать левую кнопку мыши, в результате плотность закраске будет 
увеличиваться. 

 Smoothing (Сглаживание). Опция управляет режимом сглаживания трассы, 

проведенной кистью; 

 Protect Texture (Защита текстуры). Включает режим сохранения текстуры. 

Рисование и некоторые задачи локальной технической ретуши требуют 
интенсивного обращения к кистям и оперативного изменения их настроек. 

Приведем несколько клавиатурных сочетаний, позволяющих менять параметры 

кистей "на лету", не обращаясь к панели свойств и палитре Brush. 

Клавиша [ (открывающая квадратная скобка) служит для уменьшения размера 

рисующей кисти, клавиша ] (закрывающая квадратная скобка) выбирает кисть 

большего размера. Комбинация Shift+[ увеличивает мягкость кисти, сохраняя 

неизменными установленные размеры. Клавиатурное сочетание Shift+] делает 

кисть жестче, не меняя ее габаритов и прозрачности. Для изменения 
прозрачности служат клавиши цифровой секции. Если, например, нажать клавишу 

5, то значение опции Opacity (Непрозрачность) станет равным 50%, повторный 

выбор этой клавиши устанавливает значение опции равным 55%. Цифра 0 
означает выбор полной (100%) непрозрачности т.д. Это очень полезные 
клавиатурные сочетания, которые необходимо знать каждому практикующему 
дизайнеру или ретушеру. 

Создание кисти 

В состав программы входит весьма представительная коллекция кистей самых 
разнообразных форм и текстур. По этой причине необходимость создания новой 
кисти возникает не очень часто. Начинающих отпугивает мнимая сложность этой 
процедуры, опытные пользователи находятся во власти привычки, которая 
диктует работу со стандартным набором кистей. 



С точки зрения техники создание новой кисти - это простая процедура. Она 
требуется не только для рисования, многие задачи технической ретуши проще 
выполнить посредством специально разработанной кисти уникальной формы. 

Чтобы создать новую кисть, требуется выполнить следующую последовательность 
операций. 

1. При помощи средств выделения пакета пометим область растрового 
изображения, которая должна служить образцом для новой кисти. В общем 
случае искомое выделение может иметь любую форму, но для технической 
ретуши чаще всего применяют кисти овальной формы. Рисующие кисти могут 
иметь любую форму 

2. Выполним команду главного меню Edit => Define 

Brush Preset (Редактирование => Определить кисть). 

3. В диалоговом окне Brush Name (Имя кисти) введем имя для новой кисти и 

закроем диалоговое окно щелчком по кнопке OK. 

Собственно говоря, на этом процедура создания кисти заканчивается. Новый 
инструмент "на равных правах" будет включен в коллекцию кистей. Он будет 

записан в разделе Brush Presets палитры Brush на самой последней позиции 

Кистью может быть любая часть растрового изображения, если она вписывается в 
квадрат со стороной 2500 пикселей Область на основе которой создается новая 
кисть может быть построена любым средством выделения редактора. Если в 
качестве образца выбрано цветное изображение, то оно будет конвертировано 
программой в полутоновое. Белые точки образца не включаются в состав кисти. 
Самый плотный мазок дает кисть, созданная на основе фрагмента черного цвета. 
Цветные фрагменты образца превращаются в полупрозрачные части кисти. Чем 
выше яркость цветного эталона, тем менее плотный мазок будет иметь кисть в 
соответствующем месте. 



 
 

Рис. 4.3. Применения новой кисти 

В левой верхней части рис. 4.3 показано изображение, выбранное в качестве 
образца для новой кисти. Остальные три птичьих профиля получены применением 
новой кисти для красного, синего и зеленого цветов рисования. Во всех случаях 
самую высокую плотность краски дают фрагменты головы, которые на образце 
окрашены черным цветом. 

Исправление ошибок 

Разработчики программы снабдили ее разнообразными средствами подстраховки и 
защиты от некорректных действий оператора. 

Команда отмены 



Долгое время возможности программы по отмене ошибочных действий были 

представлены всего лишь одной командой Undo (Отменить), полномочия которой 

распространялись только на самую последнюю операцию. Это соглашение 
ограничивало творческую свободу пользователей пакета и заставляло их искать 
обходные пути повышения безопасности работы. Последние версии редактора 
получили богатый арсенал разнообразных средств отмены ошибочных действий 
пользователя. Рассмотрим основные способы исправления ошибок. 

Чтобы отменить последнее действие требуется выполнить стандартную 

команду Undo (Отменить), ставшую стандартной для многих редакторов на 

платформе Windows. Точный адрес этой команда в главном меню Edit => Undo 

(Редактирование => Отменить). Быструю отмену можно выполнить 

посредством комбинации клавиш Ctrl+Z. Повторное выполнение этой команды 

означает отмену отмены, то есть возврат к результатам последней 
содержательной команды. 

Это свойство команды, напоминающее работу двоичного переключателя, часто 
применяется искушенными пользователями для сравнения двух состояний 
изображения. Пусть, например, к изображению применен некоторый фильтр или 
она обработана командой. Чтобы принять решение о целесообразности обработки, 
требуется сравнить текущее и измененное состояния картинки. Нажатие 

комбинации клавиш Ctrl+Z разворачивает последовательность, состоящую из 

чередования двух состояний изображения и, тем самым, упрощает выбор. 

Полномочия команды отмены не безграничны: они распространяются на большую 
часть действий с оригиналом. Файловые операции, настройки инструментов и 
фильтров, манипуляции с содержимым буфера обмена, команда 

восстановления Revert, рассмотренная в следующем разделе, и некоторые 

другие действия отмене не подлежат. 

Команда восстановления 

Команда Revert (Восстановить) реализует очень простой и, вместе с тем, 

надежный способ страховки от ошибочных действий. По этой команде в редактор 
загружается последняя сохраненная версия графического файла. Понятно, что для 
обеспечения работоспособности команды изображение необходимо 
предварительно сохранить на диске. Команды будет недоступна, если в 
изображение не внесено никаких изменений. 

Процедура восстановления элементарна по технике исполнения. Для этого 

требуется выполнить команду главного меню File => Revert (Файл => 

Восстановить). Восстановление - это команда прямого действия; она не 

нуждается в настройках и подтверждении пользователя, кроме того, ее нельзя 
отменить. Быстрый запуск этой команды можно выполнить простым нажатием 

клавиши F12. 

Команда Revert позволяет реализовать простую, но эффективную стратегию 

разработки сложных цифровых композиций. Перед выполнением рискованного 
преобразования оригинала или цепочки команд, последствия которых являются 



трудно предсказуемыми, следует сохранить изображение на диске. Если операция 

оказалась неудачной, то посредством команды Revert можно вернуться к 

стартовой точке, с которой начинались эксперименты. 

Палитра History 

Палитра History (История) предназначена для записи и хранения состояний 

обрабатываемого изображения. Это своеобразный бортовой журнал программы, в 
котором отмечаются все значительные изменения оригинала: мазки кисти, 
применение фильтров, обработку командами и пр. Кроме хранения фактологии - 
этой стандартной функции для всех средств бумажных средств регистрации 
(бортовых журналов, табелей и протоколов) - палитра способна управлять 
состояниями объекта. С ее помощью можно выполнить отмену нескольких 
последних действий, запомнить ключевые состояния изображения, 
добиться сочетания фрагментом, заимствованных из различных стадий обработки 
одного оригинала. 

Первое появление в составе программы этого средства вызвало резкие 
возражения ветеранов пакета. Не желая расставаться с наработанными приемами 
подстраховки, они, с большим или меньшим основанием, отзывались о 
нововведении, как о бесполезном средстве, которое, потребляя значительные 
ресурсы компьютера, не выполняет ни одной полезной функции. Время 
опрокинуло возражения скептиков. Сейчас уже трудно представить себе 

комфортную работу в программе без использования палитры History. Создана 

целая технология ретуширования, основанная на применении этого средства. 
Многие из этих приемов будут рассмотрены в последующих разделах курса. 

Вызов палитры выполняется по команде главного меню Window => History 

(Окно => История). Внешний вид палитры показан на следующем рисунке. 

 
 

Рис. 4.4. Палитра History 

Это довольно простое и логично организованное средство. Каждое новое действие 
пользователя по обработке изображения заносится в нижнюю часть палитры под 



специальным именем. Обычно, запись в палитре совпадает с именем инструмента, 

фильтра или команды, например Open, Brush Tool, Magnetic Eraser и др. 

Палитра не только протоколирует действия пользователя, но и позволяет 
вернуться к любому сохраненному состоянию. Выбор любой записи палитры 
возвращает то состояние, которое имело изображение на момент применения 
данного инструмента или команды. 

Программа не накладывает никаких ограничений на выбор состояний, 
представленных в палитре. Это средство работает как своеобразная машина 
времени, позволяя отменять ранее сделанные действия и снова возвращаться к 
отмененным состояниям. Команды отмены и повторения поддержаны быстрыми 

клавишами. Для глубокого отката по палитре History можно воспользоваться 

комбинацией Ctrl+Alt+Z (перемещение вверх по цепочке состояний палитры). 

Для возврата к отмененным действиям достаточно несколько раз подряд 

нажать Ctrl+Shift+Z (перемещение вниз по стеку записей палитры). 

Емкость палитры является величиной ограниченной. По умолчанию она способна 
сохранять всего лишь 20 последних записей. Новые состояния, записанные сверх 
установленного лимита, вытесняют первые элементы палитры. Вместимость 
палитры задается в основных установках пакета. Чтобы изменить 

этот параметрследует выполнить команды Edit => Preferences 

(Редактирование => Установки), перейти в раздел Perfomance и 

в поле History States ввести число в диапазоне от 1 до 1000. 

Состояния изображения особой важности можно сохранить в специальной форме, 

которая называется в программе Snapshot (Снимок). Множество снимков 

оригинала представлено в верхней части палитры History. 

Снимки состояний хранятся в течение всего сеанса работы с изображением. Их 
множество не является упорядоченным во времени, подобно совокупности 
состояний изображения. Старые снимки не вытесняются новыми, как это 
происходит с обычными записями состояний. Если оригинал нуждается в 
интенсивной обработке, включающей применение большого числа разнообразных 
средств, то ключевые состояния изображения целесообразно сохранить в качестве 
снимков. 

Если состояния обрабатываемого изображения автоматически заносятся в 
палитру, то для создания снимка требуется специальная команда пользователя. Ее 

можно запустить из командного меню палитры History, а также при помощи 

управляющей кнопки, расположенной в самой середине нижней части палитры. 

Для снимков и записей состояний используется нефайловая форма хранения 
данных. Эти объекты размещаются в оперативной памяти компьютера со всеми 
вытекающими из этого последствиями. Во-первых, разрастание палитры 
загромождает память, поэтому может привести к замедлению работы компьютера. 
Во-вторых, данные палитры не сохраняются вместе с изображением. При 
повторном открытии картинки все записи и снимки палитры сбрасываются. Это 



значит, что сервис палитры доступен только в течение одного сеанса работы с 
изображением. 

Для управления содержимым палитры можно использовать средства, 
расположенные в ее командном меню. Вызов управляющего меню выполняется 
щелчком по треугольной кнопке, расположенной в верхней правой части палитры 
(рис. 4.5). 

 
 

Рис. 4.4. Командное меню палитры History 

Рассмотрим эти простые команды: 

 Step Forward (Шаг вперед). Выбор состояния, следующего за текущей записью 

палитры. 

 Step Backward (Шаг назад). Выбор состояния, предшествующего текущей 

записи палитры. 

 New Snapshot (Новый снимок). Создает новый снимок, в который записывается 

текущее состояние изображения. 

 Delete (Удалить). Удаляет текущую запись палитры и все состояния, следующие 

за ней. 

 Clear History (Очистить палитру). Удаляет все состояния изображения, 

записанные в палитру. 

 New Document (Новый документ). Создает новый документ на основе текущего 

состояния изображения. 

 History Options (Настройки палитры). Вызывает диалоговое окно с 

настройками палитры History. 

Оперативное управление палитрой выполняется посредством трех кнопок, 
расположенных в ее нижней части. Назовем их функции: 

 Create new document from current state (Создать новый документ на 

основе текущего состояния). Создает новый документ, в который записывает 
текущее состояние обрабатываемого изображения. Эта команда до некоторой 



степени компенсирует недостатки палитры History, связанные с ее 

темпоральной ограниченностью. 

 Create new snapshot (Создать новый снимок). Является полным 

функциональным аналогом команды управляющего меню с тем же названием. 

 Delete current state (Удалить текущее состояние). Удаляет помеченное 

состояние и все записи палитры, расположенные ниже на ее временной шкале. 

Снимки и состояния палитры History можно передавать в другие документы. Эта 

операция по технике исполнения ничем не отличается от обмена слоями. 
Достаточно просто зацепить мышкой запись палитры и перетащить ее в 
любое место рабочего окна другого документа. Операция буксировки состояний и 
снимков почти не знает ограничений. Подобные обмены разрешены даже для 
документов, имеющих разный размер, разрешение и цветовую модель. 

Инструмент History Brush 

В коллекции страховочных возможностей пакета инструмент History 

Brush (Архивная кисть). Это кисть, обладающая необычными свойствами. К двум 

пространственным измерениям, которыми ограничены все стандартные средства 

рисования программы, инструмент History Brush фактически добавляет 

третьюразмерность, которой является время. Восстанавливающая кисть позволяет 
обмениваться графическими данными между различными состояниями одного 
оригинала, объединять на одном изображении фрагменты, заимствованные из 

разных снимков и записей палитры History. 

Хотя работа восстанавливающей кисти основана на информации, хранящейся в 

палитре History, в большинстве остальных отношений она является обычным 

инструментов программы, чей вызов и настройки выполняются стандартным 

способом. Для его служит кнопка History Brush, расположенная 

инструментальной панели (рис. 4.2). Быстрая активизация инструмента 

выполняется нажатием клавиши Y. 

Кроме обычных для любых кистей настроечных параметров, представленных на 
панели свойств, для работы инструмента следует указать области определения и 
действия. Первая указывает то состояние изображения, откуда будет 
заимствована графическая информация, вторая область представляет собой 
состояние оригинала, которое выбрано для переноса данных. Областями могут 

быть любые записи или снимки палитры History, независимо от их 

расположения на временной шкале. 

Областью действия восстанавливающей кисти всегда является текущее состояние 

палитры History, которое выделяется в ней подсветкой синего цвета. Чтобы 

указать область определения следует щелкнуть мышкой на пиктограмме, 
расположенной с левой стороны от выбранной записи или снимка. 

Так, на рис. 4.6 показаны два состояния палитры History. В левом примере 

выполняет перенос данных в состояние Clone Stamp из состояния Open. В 



правом примере источником данных служит снимок Snapshot1, а целевым 

является состояние Brush Tool. 

 
 

Рис. 4.6. Схема действия инструмента History Brush 

Появление в программе инструмента History Brush дало толчок развитию 

новых подходов к решению изобразительных и технических задач растровой 
графики. Многие сложные проблемы ретуши и коррекции изображений, которые 
ранее решались применением громоздких многошаговых методик, теперь 
получили короткое и эффективное решение. В этом курсе мы будет неоднократно 
обращаться к данному инструменту. 

Ранее отмечалось, что снимки и состояния палитры History не сохраняются вместе 
с изображением. При каждом последующем открытии оригинала ее содержимое 
"обнуляется". Оставим без оценки это странное обстоятельство для программы, 
которая позволяет сохранить на диске множество самых разнообразных объектов, 
связанных с изображением только косвенно (настройки, установки инструментов, 
параметры фильтров и пр.). Частичное решение проблемы дает команда Create 
new document from current state (Создать новый документ на основе текущего 
состояния), которая представлена в управляющей кнопкой и разделом командного 
меню палитры History. 

Ключевые термины 

Архивная кисть (history brush) - инструмент, позволяющий переносить 
фрагменты изображения из прошлых состояний в последующие или наоборот. 

Используется вместе с палитрой History, которая запоминает состояния 

оригинала после применения команд и инструментов. 

Базовый слой - первый слой макетной группы, содержащий обтравочную маску. 



Команда Revert (Восстановление) - важнейшая команда отмены. Позволяет 
вернуться к последней сохраненной на диске версии изображения после 
последовательности операций любой длины. 

Макетная группа (clipping group) - совокупность последовательно 
расположенных слоев, в которой первый слой содержит обтравочную маску для 
всех верхних слоев группы. 

Обтравочная маска (clipping mask) - изображение, расположенное на базовом 
слое макетной группы, маскирующее верхние слои по следующим правилам. 
Непрозрачные области маски определяют доступные для обозрения фрагменты 
группы. Ее прозрачные области распространяются на все верхние слои, делая их 
прозрачными. Остальные точки обтравочной маски меняют видимость в 
зависимости от своего положения на шкале прозрачность-непрозрачность. 

Рассеивание (scattering) - группа настроек кисти, которая вносит случайность в 
пространственное наложение мазков и распределение краски. Служит для 
имитации естественного стиля рисования. 

Снимок (snapshot) - состояние изображения в процессе обработки, сохраненное 
в палитре History по специальной команде пользователя. Снимки не стираются 

после переполнения палитры History, а хранятся в течении всего сеанса работы 

с изображением. 

Текстура - вспомогательное изображение, представляющее собой повторение 
простого узора или картинки. Используется для заливки фонов и в качестве 
образцов некоторых рисующих инструментов. 
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Базовая техника 

Защищенную область, расположенную за границей выделения, иногда 
называют маской. Выделение и маска - это взаимодополнительные 
множества точек. Выбор одной области полностью определяет положение и 
габариты дополнительной. В растровых редакторах существуют специальные 
команды, которые меняют статус выделений и масок, поэтому часто эти понятия 
употребляются в качестве синонимов. 

В концепции выделения нет ничего нового. Подробная техника используется в 
пакетах различного назначения. Если в векторных редакторах выделение - это 
относительно простая операция, для выполнения которой в большинстве случаев 
достаточно одного удачного щелчка, то в растровой графике 
удельный вес этойоперации значительно выше. Успех или неудача обработки 
изображения часто зависит от качества созданного выделения. 



Введение 

Среди цифровых ретушеров распространено мнение, что многие проблемы 
восстановления изображений не нуждаются в построении выделений. Более того, 
для некоторых задач по цветовой коррекции работа в изолированной локальной 
области изображения можно считать принципиально ошибочной. Эта точка зрения 
имеет право на существование. Нарушение цветового баланса или сдвиг цветов, 
как правило, бывает вызван некоторой общей причиной, действие которой 
распространяется на все изображение. Поэтому инструменты цветокоррекции 
следует применять ко всем пикселам растровой картинки. Подобная стратегия 
способна не только устранить локальный колористический дисбаланс, но и 
значительно улучшить тоновые и цветовые характеристики всего изображения. 

Тем не менее, существуют ситуации, когда невозможно избежать построения 
выделений или масок. Перечислим несколько типичных случаев: 

 Удаление фона. Эту операцию часто приходится выполнять в процессе 
ретуширования старых фотографий, при построении коллажей, при выполнении 
фотомонтажных работ. При помощи инструментов выделения центральная часть 
композиции отделяется от фона. После этого становятся возможными операции 
удаления старого фона и вставка нового заднего плана, согласующегося с 
целями и предпочтениями автора. 

 Защита соседних областей от случайного воздействия при выполнении 
восстановительных работ, требующих радикального вмешательства в оригинал. 
Пусть требуется устранить массивные повреждения или замаскировать заметные 
косметические недостатки на фотографическом снимке. Для выполнения этих 
работ часто используются такие инструменты 

как: Brush (Кисть), Smudge (Палец), Clone Stamp (Штамп) и др., которые 

требуют "прецизионного" ручного управления. Неосторожные мазки этими 
средствами могут внести заметные изменения в соседние области, если 
последние не являются защищенными. 

 Радикальное изменение цвета в локальных областях для достижения 
определенного художественного эффекта. Например, часто на снимках морского 
пейзажа изображение моря и неба бывают трудно отличимыми. Если подобная 
ситуация является недопустимой, то следует резко изменить цветовую 
характеристику одной из смежных стихий, предварительно защитив вторую 
маской. 

 Создание композиций. выполнение монтажных работ и построение коллажей. 
Чтобы правильно смонтировать составные части, заимствованные из разных 
источников следует точно задать область вставки. В этих случаях построение 
маски становится совершенно обязательной операцией. 

Созданное выделение изображается в редакторе в виде своеобразной 
пульсирующей линии, которая, за очевидное сходство с известным природным 
феноменом, получила у пользователей пакета ироническое наименование 
"марширующих муравьев". 



 
 

Рис. 5.1. Представление выделенных областей 

На рис. 5.1 выделены все точки изображения, за исключением белого фона. В 
данной ситуации изображение этой симпатичной птахи полностью доступно для 
внесения желаемых изменений. Его можно перекрасить, масштабировать, 
поставить на другой фон, смонтировать с другими фрагментами. 

Инструменты выделения 

Photoshop располагает всеми необходимыми средствами построения выделений 

и масок. Можно с уверенностью утверждать, что этот инструментарий программы 
является самым мощным среди всех растровых пакетов. Назовем основные 
инструменты и команды данного назначения: 

 Marquee (Область). Группа инструментов, предназначенная для выделения 

геометрических областей простой геометрической формы: прямоугольников, 

овалов и линий. Клавиша быстрого вызова M. 

 Lasso (Лассо). Группа инструментов, строящая выделения в форме 

произвольной замкнутой кривой или замкнутого многоугольника. Клавиша 

быстрого вызова L. 

 Magic Wand (Волшебная палочка). Это инструмент строит выделение не по 

геометрическому принципу, подобно Lasso и Marquee. Он работает на основе 

принципа яркостной близости. Инструмент включает в выделенную область 
пикселы изображения, сходные по яркости с пробной точкой. Основными 
настройками инструмента являются допуск и эталонный пиксел, выбранный при 
помощи щелчка палочкой по изображению. В выделение включаются все 
смежные точки, у которых сумма отклонений по основным цветовым координатам 

не превосходит заданного допуска. Клавиша быстрого вызова W. 



 Quick Selection (Быстрое выделение). Это мощное полуавтоматическое 

средство выделения. Для создания пометки этим инструментом нужно как кистью 
закрасить искомую область. Программа самостоятельно определит границы 
области и расширит (или сократит) обработанный пользователем фрагмент. 

Клавиша быстрого вызова W. 

 Color Range (Цветовой диапазон). Эта команда, принадлежащая разделу 

главного меню Select (Выделение), основана на расширенном принципе 

действия инструмента Magic Wand. Она позволяет создавать выделенные 

области на основе цветового диапазона. Это мощное и гибкое средство 
построения сложных выделений, обладающее рядом уникальных особенностей. 
Например, с ее помощью можно выбирать пикселы в границах ранее 
построенного выделения. Техника работы с этой полезной командой подробно 
рассматривается в данном разделе. 

 Pen (Перо). При помощи этого инструмента можно построить векторный контур 

по границе искомого выделения. Завершенный контур по специальной команде 
преобразуется в выделение. Этот мощный инструмент позволяет регулировать 
положение граничного контура с очень высокой точностью и строить выделения 
любой сложности. Но работа с пером требует знания достаточно громоздкой 
техники построения кривых Безье, которая свойственна более векторным, а не 

растровым редакторам. Клавиша быстрого вызова P. 

 Quick Mask (Быстрая маска). Это специальный режим работы программы, когда 

изобразительные средства программы продуцируют не растровое изображение, а 
отдельный его канал, называемый маской. Глубина цвета этого временного 
канала равна восьми битам. Это значит, что каждый пиксел маски может 
принимать 256 уровней яркости (от 0 до 255). На основе этих значений Photoshop 
принимает решение о включении точек изображения в состав выделения. 
Нулевая яркость маски соответствует точкам, не включенным в выделение 
(защищенным, маскированным). Полностью выбранные пикселы имеют в этом 
канале предельную яркость, равную 255. Все точки с промежуточными 
значениями попадают в переходную зону между выбранной и защищенной 

областями изображения. В режиме Quick Mask весь мощный изобразительный 

арсенал программы, включающий инструменты рисования, команды и фильтры, 
работает на создание маски. Это дает возможность добиваться таких эффектов, 

которые недостижимы для обычных инструментов выделения (Marquee, 

Lasso, Magic Wand и др.). Кроме того, процедура построения маски 

становится более наглядной. Пользователь способен видеть многие эффекты, 
которые невозможно отобразить при стандартном способе представления 
выделений. Например, размер переходной зоны-растушевки задается в 
программе при помощи специальной команды и не визуализируется на экране. В 
режиме быстрой маски растушевку строят при помощи фильтров размытия, 
действие которых пользователь может контролировать непосредственно. Для 

перехода в режим быстрой маски надо нажать клавишу Q. Эта же клавиша 

служит для его завершения. 

 



Редактирование выделений 

Выделенные области допускают разнообразное и глубокое редактирование. 
Приведем несколько основных технических приемов обработки владение 
которыми следует считать обязательным для любого пользователя пакета. 

Перемещение. 

Границы построенного выделения разрешается перемещать. Нажатие стрелочных 
клавиш перемещает выделение на один пиксел. Если при этом удерживать 

клавишу Shift, то процедура ускоряется ровно в десять раз. Для свободного 

перемещения достаточно зацепить мышкой любую внутреннюю точку выделенной 
области и сдвинуть ее. 

Сложение и вычитание 

Создание нового выделения автоматически удаляет границу, которая 
существовала ранее. Это соглашение можно изменить при помощи клавиш-

модификаторов Shift и Alt. Клавиша Shift переводит инструменты выделения 

в режим сложения. С ее помощью можно добавить новый фрагмент к 

существующему выделению. Клавиша Alt предназначена для вычитания нового 

выделения из существующего. Если в процессе создания выделения 

удерживать Alt и Shift, то будет построено пересечение нового выделения и 

ранее существовавшего. 

Визуализация границы 

Граница выделения иногда мешает точному исполнению некоторых тонких 
операций над точками изображения. Чтобы спрятать граничную линию, не снимая 

самого выделения, достаточно воспользоваться комбинацией клавиш Ctrl+H. 

Повторное нажатие этого сочетание восстанавливает визуализацию граничной 
линии. 

Обращение выделений 

Редактор разрешает менять статус выделенной и защищенной областей. Чтобы 
выделенные точки превратить в защищенные и наоборот достаточно выполнить 

команду главного меню Select => Inverse (Выделение => Инверсия). Как 

и всякое востребованное средство, эта команда поддержана быстрыми 

клавишами. Быстрая инверсия выполняется нажатием Ctrl+Shift+I. 



 
 

Рис. 5.2. Обращение выделения в режиме быстрой маски 

Смысл операции инверсии демонстрирует изображение, приведенное на рис. 5.2. 
На этом рисунке представлены два варианта одного изображения с выделениями, 
которые получены посредством обращения областей. Чтобы сделать операцию 
более наглядной, обе выделенные области показаны в виде маски, когда 
защищенные точки изображаются красным цветом половинной прозрачности. 

На левой картинке выбранными являются все точки белого фона, центральная 
фигура закрашена легким красным цветом - цветом маски. Правое изображение 
получено обращением выделения, в результате защищенными оказываются точки 
фона и выбранной становится центральная фигура. 

Отмена выделений 

Убрать отслужившее свое выделение можно по команде Select 

=> Deselect (Выделение => Снять выделение). Самый быстрый запуск этой 

команды дает клавиатурное сочетание Ctrl+D. 

Геометрические преобразования 

В редакторе есть несколько команд и инструментов для выполнения 
геометрических преобразований выделенных областей. Максимальными 

возможностями обладает команда Transform Selection (Преобразование 

выделения). Для ее запуска достаточно воспользоваться разделом главного 

меню Select => Transform Selection или комбинацией клавиш Ctrl+T. Это 

многофункциональное средство. С его помощью можно выполнить самые 
разнообразные преобразования геометрии выделенной области, например 
перемещение, масштабирование, поворот, наклон, искажение формы и пр. 

Команда предлагает простую и наглядную технику выполнения геометрических 
преобразований, основанную на перемещении маркеров специальной 
трансформационной рамки. Нажатие клавиши Enter завершает работу с командой 
и применяет все сделанные преобразования к выделенной области. 



Заслуживает упоминания одна тонкость, связанная с командой Transform 

Selection. Чтобы получить доступ к дополнительным средствам преобразования 

требуется запустить команду, а затем щелкнуть правой кнопкой мыши в любой 
внутренней точке трансформационной рамки. В результате появится выпадающее 
меню, в котором перечислены все возможности этого средства. 

 
 

Рис. 5.3. Трансформационная рамка команды Transform Selection и ее контекстное 

меню 

Рассмотрим содержание контекстного меню (рис. 5.3): 

 Free Transform (Свободное трансформирование). Операция с наибольшими 

возможностями. Результат преобразования границы выделенной области зависит 

от действий пользователя и клавиш модификаторов Ctrl, Alt, Shift; 

 Scale (Масштабирование). Выполняет масштабирование выделенной области; 

 Rotate (Поворот). Поворот выделенной области на произвольный угол; 

 Skew (Наклон). Наклон выделения вдоль горизонтальной или вертикальной осей; 

 Distort (Искажение). Свободное изменение формы выделения. Новая форма 

зависит от изменений трансформационной рамки, которая в данном режиме 
может принимать форму произвольного четырехугольника (рис. 5.4); 

 Perspective (Перспектива). Перспективное преобразование выделения; 

 Warp (Деформация). Свободное преобразование с ручным управлением; 

 Rotate 180° (Поворот на 180 градусов); 

 Rotate 90° CW (Поворот на 90 градусов по часовой стрелке); 

 Rotate 90° CCW (Поворот на 90 градусов против часовой стрелки); 

 Flip Horizontal (Отразить по горизонтали); 

 Flip Vertical (Отразить по вертикали). 



 
 

Рис. 5.4. Обработка выделенной области командой Distort 

В любой момент работы с командой свободного трансформирования можно 
отказаться от сделанных преобразований. Для этого достаточно нажать 

клавишу Esc. 

Растушевка 

Существуют знаковые слова, употребление которых свидетельствует о 
принадлежности автора к узкому кругу посвященных. Такие слова-метки есть в 
каждой отрасли человеческой деятельности. Так, термины обтравка, 
треппинг, растушевка, получившие широкое хождение в области предпечатной 
подготовки, звучат для непосвященного немного таинственно. Пожалуй, это 
справедливо только для треппинга, владение которым - прерогатива высоких 
профессионалов. Растушевка - это базовая техника растровой графики; ее должен 
знать любой пользователь, делающий первый шаги в освоении редактора. 

Растушевкой (feather) называется сглаживание границы выделенной 
области. Это сглаживание состоит в размывании границы в обе стороны 
от выделения. Первоначально четкая линия раздела превращается 
после растушевки в область с плавным переходом от внутренних, 
полностью выделенных точек к внешним точкам, не входящим в 
выделение. 

Какие же цели преследует эта техника? Трудно перечислить все случаи, 
когда растушевка оказывается полезной или даже необходимой. Скажем лишь о 
главном для цифровых композиций. Растушевка помогает замаскировать 
сборочные швы, которые могут стать заметными при создании фотомонтажа из 
объектов, заимствованных из различных источников. Если объект изолируется из 
своего источника без предварительно сглаженного выделения, то на новом фоне 
может стать видимым резкий переход - граница, разделяющая объекты 



различного происхождения. Растушевка приводит к появлению мягких кромок, при 
этом создается иллюзия растворения объекта в новом фоне. 

На рис. 5.5 рисунке показаны два варианта размещения цветка на новом фоне. 
Сверху расположен цветок, вырезанный из старого фона без растушевки, внизу 
показан вариант изоляции с растушевкой. Слишком резкая граница, особенно 
заметная на острых краях лепестков и листьев, с головой выдает искусственное 
происхождение верхней композиции. 

 
 

Рис. 5.5. Замена фона у изображения с растушевкой границы и и без нее 

Растушевать границу можно как до, так и после создания помеченной области. 
После активизации большинства инструментов выделения, 

например Lasso (Лассо) или Marguee (Область), на панели Options (Панель 

свойств) становится доступным поле Feather (Растушевка), в котором можно 

задать радиус переходной зоны. Растушевать уже созданный контур выделения 

можно с помощью команды Select => Modify => Feather или клавиатурным 

сочетанием Shift+F5. Команда требует ввода одного управляющего параметра - 

величины радиуса растушевки (feather radius). 



 
 

Рис. 5.5. Закраска сильно растушеванной области 

Редактор строит переходную зону в двух направлениях: внутрь и наружу от 
границы. В результате, область растушевки получает размеры, которые ровно в 
два раза больше заданного радиуса. Это соглашение хорошо иллюстрирует 
пример на рис. 5.5. На этом простейшем рисунке сильно растушеванное 
выделение прямоугольной формы закрашено красным цветом. Хорошо 
различимые градации плотности заливки в районе границы объясняются 
правилами создания переходных растушеванных зон. 

Сглаживание - это слово, которое несколько перегружено значениями. Так, 
например, превращение ступенчатых линий в гладкие, по-английски antialiasing, 
также называют сглаживанием. В основе этих приемов лежат совершенно 
различные алгоритмы, но одинаковое название и сходная область применения 
способна привести к путанице. Растушевка - это смягчение по ширине, в отличие 
от антиалиасинга, который представляет собой сглаживание по длине. 

Инструмент Magic Wand 

Создание выделенной области - это вспомогательное мероприятие; которое не 
создает новой художественной реальности, а только подготавливает будущие 
изменения изображения. Из этого очевидного факта не следует вывод о малой 
значимости или трудоемкости этих операций. Опыт показывает, что в растровых 
редакторах значительная часть времени цифрового дизайнера или ретушера 
уходит на построение сложных выделений. 

Редактор располагает самыми разнообразными средствами решения этой задачи: 
от простейших инструментов рисования, дающих искомое выделение за один шаг, 
до сложнейших многошаговых методик, использующих сложные операции с 
каналами. Техника использования инструментов, работающих по принципу 
обрисовки границы выделенной области, настолько элементарна, что не требует 
специального обсуждения. К таким средствам, прежде всего, относятся 

инструменты группы Marquee и различные модификации лассо. В этом разделе 

обсудим такие способы построения выделенных областей, которые обладают 
высокой универсальностью и неэлементарной техникой применения. 



Инструмент Magic Wand (Волшебная палочка) строит выделения по принципу 

цветового подобия или тоновой близости. Для работы инструмента требуется 
задать допуск и указать мышкой пробную точку. В результате, программа выберет 
все точки изображения, яркость которых отличается от выбранного эталона не 
более чем на величину допуска. 

Для выбора волшебной палочки достаточно щелкнуть по кнопке, которая 
расположена на второй сверху позиции правого ряда панели инструментов (рис. 

3.2). Быстрый вызов выполняется нажатием клавиши W. Все настройки этого 

средства расположены на панели свойств (рис. 5.7). 

 
 

Рис. 5.7. Настройки инструмента Magic Wand 

Рассмотрим их: 

1. Presets (Наборы). Кнопка служит служит для выбора стандартного набора 

настроек инструмента. 

2. Кнопки выбора режима работы инструмента. Это слева направо: 

o стандартный режим создания нового выделения; 

o режим сложения, когда новое выделение добавляется к существующему; 

o режим вычитания, когда новое выделение вычитается из существующего; 

o режим пересечения, когда формируется пересечение нового выделения и 
существующего. 

3. Tolerance (Допуск). Задает величину допуска. Это целое число в диапазоне 

от 0 до 255. От этого параметра зависят размеры выделенной области, 

которую создаст инструмент Magic Wand. Чем больше допуск, тем, при 

прочих равных условиях, большие размеры будет иметь выделение. 

4. Anti-alias (Сглаживание). Переключатель управляет сглаживанием 

границы выделения. Если он включен, то редактор автоматически убирает 
ступеньки небольшого размера и изломы границы выделения. 

5. Contiguous (Смежные пикселы). Переключатель, от состояния которого 

зависит связность выделенной области. Если он активизирован, то программа 
включает в состав выделения только смежные точки, удовлетворяющие 
критерию выбора. В противном случае выделение может состоять из 
нескольких раздельных фрагментов. 

6. Sample All Layers (Образцы со всех слоев). Переключатель задает способ 

обработки многослойного изображения. Если он выбран, то инструмент Magic 

Wand обрабатывает все слои, в противном случае в состав выделения 

включаются только точки текущего, активного слоя 

7. Refine Edge (Уточнить край). Вызов специальной команды, 

предназначенной для уточнения границ существующего выделения. Таковы 

несложные настройки, описывающие работу инструмента Magic Wand. А 

какие рекомендации дает теория по выбору значений параметров в каждом 



конкретном случае? Почти никаких. Это средство ориентировано интуитивный 
стиль работы. Это значит, что для построения выделения могут потребоваться 
несколько пробных попыток с разными значениями допуска и пробными 
точками. Даже не имея никакого опыта работы с этим средством можно 
уверенно предположить, что лучшие результаты даст обработка волшебной 
палочкой изображений с высокой контрастностью. 

 
 

Рис. 5.8. Пример для демонстрации инструмента Magic Wand 

Рассмотрим работу инструмента на конкретном примере. Попробуем отделить от 

фона изображение орла, взятое из библиотеки пакета Photoshop (рис. 5.8). 

Фигура центрального плана и фон достаточно сильно отличаются по яркости, что 
дает основания на успешное применение волшебное палочки. 

1. Выберем инструмент Magic Wand (W) и начнем испытания со значения 

допуска, равного 20. Будем считать, что включены все остальные опции 
панели свойств. 

2. Несколько пробных щелчков по голове и туловищу птицы не дают даже 
приличного приближения к результату. Попробуем, постепенно повышая 
значение допуска, искать лучшую пробную точку. Испытания показали, что 



после превышение допуском значения 70, выделение стало захватывать 
области фона. Что же, выбор инструмента был неудачен, и для решения 
поставленной задачи надо искать другое средство? Задача имеет простое 
обходное решение. Изображение орла расположено на сравнительно 
однородном фоне, которое выделить проще, чем изобилующее мелкими 
деталями оперение птицы. Воспользуемся этой догадкой, но сначала снимем 

ранее созданное выделение (Ctrl+D). 

3. Зададим невысокое значение допуска, примерно равное 20. Щелкнем мышкой 
по фоновой точке, расположенной над головой орла. Результат превосходит 
даже самые оптимистичные ожидания. Программа создала очень точную 
пометку, в которую вошли все точки фона, за исключением верхних углов 
(рис. 5.9). 

 
 
Рис. 5.9. Выделение фона 

4. Оставшиеся фрагменты можно включить в состав выделения тем же 
инструментом, если предварительно перевести его в режим сложения. Для 

этого достаточно просто нажать и удерживать клавишу Shift. Удерживая эту 

клавишу, щелкнем инструментом по невыбранным точкам верхних углов. В 
результате будут выделены все точки фона. 

5. На первый взгляд операция увенчалась полным успехом. Всего лишь тремя 
щелчками создана точная пометка фоновой области. Проверим границу при 

большом увеличении. Для этого нажмем несколько раз Ctrl++ (плюс) и 

зададим масштаб примерно равный 400 процентам. Зададим небольшое 
значение допуска в диапазоне от 5 до 10. Удерживая пробельную клавишу, 
будем прокручивать изображение и проверять границу выделения. В 
некоторых местах граница немного заходит на фигуру орла или наоборот не 

доходит до нее. Волшебная палочки вместе с клавшей Shift добавляет 



недостающие фрагменты, а совместно с клавишей Alt удаляет лишние 

захваченные области. Чередуя эти приемы, уточним поведение границы 
пометки. 

6. Чтобы преобразовать пометку фона в выделение орла, достаточно выполнить 
команду обращения. Для этого можно воспользоваться разделом главного 

меню Select => Inverse (Выделение => Инверсия) или клавиатурным 

сочетанием Ctrl+Shift+I. 

Теперь, после создания искомого выделения, оператор получил почти полный 
контроль над изображением птицы. Эту часть картинки можно сделать темнее или 
светлее, изменить ее размеры, настроить вклады отдельных цветов и много и 
другое. 

Легкий успех этого примера способен создать иллюзию всемогущества 

инструмента Magic Wand. Конечно, это средство не всесильно, у него есть свои 

сильные и слабые стороны. Приведем несколько советов, упрощающих работу с 
эти средством выделения. 

 Волшебная палочка успешно справляется с пометкой высококонтрастных 
областей, Чем сильнее различаются цвет или яркость объекта и фона, тем выше 
вероятность успешного срабатывания инструмента. Идеальными примерами 
являются надписи, логотипы, рисунки с однородной цветовой заливкой, 
расположенные на белом фоне. Инструмент сможет успешно сработать, но для 
этого потребуются многочисленные эксперименты с выбором оптимального 
допуска и поиском удачной пробной точки. 

 Совершенно не подходят для обработки волшебной палочкой пейзажные 
фотографии, содержащие плавные цветовые переходы, легкие градации цвета и 
тона. 

 Цветовая модель изображения накладывает свои ограничения на применения 

инструмента Magic Wand. Во-первых, это средство не работает с черно-белыми 

изображениями, записанными в режиме Bitmap. Во-вторых, оно может давать 

разные результаты при обработке одного оригинала, хранящегося в разных 

моделях, например RGB и CMYK. 

Инструмент Quick Selection 

Инструмент Quick Selection (Быстрое выделение) - это сравнительное новое 

средство в арсенале программы. Это мощный инструмент выделения с высокой 
степенью автоматизации работы. Он представляет собой кисть, но 
предназначенную не для рисования, а для создания помеченных областей. 

Инструмент располагается в панели инструментов в одной группе с волшебной 

палочкой. Для его вызова достаточно воспользоваться сочетанием клавиш Shift 

+W. 

 



 

Рис. 5.10. Настройки инструмента Quick Selection 

На рис. 5.10 показаны немногочисленные настройки этого средства: 

1. Presets (Наборы). Кнопка служит для выбора стандартного набора настроек 

инструмента. 

2. Кнопки выбора режима работы инструмента (см. настройки 

инструмента Magic Wand). 

3. Brush (Кисть). Вызывает диалоговое окно с настройками кисти. 

4. Sample All Layers (Образцы со всех слоев). Включает режим работы на 

всех слоях. Если этот режим не активен, то инструмент работает только на 
активном слое. 

5. Auto-Enhance (Усилить автоматически). Выбирает режим автоматической 

корректировки границы выделения. При работе в данном режиме усиливается 
неровность границы выделения. 

6. Refine Edge (Уточнить край). Вызов специальной команды, 

предназначенной для уточнения границ существующего выделения. 

Для создания пометки инструментом Quick Selection надо, чередуя длинные и 

короткие мазки, создать приблизительную границу выделенной области, или 
просто ее закрасить. Программа самостоятельно распространит пометку от трассы 
кисти до точек, у которых резко меняется яркость. Кисти большего размера 
создают более грубые выделения, с помощью небольшой кисти можно включить в 
выделение мелкие фрагменты картинки. 

Для управления размерами кисти на ходу в программе есть две удобные 

клавиатурные комбинации. Нажатие клавиши [ (открывающая квадратная скобка) 

уменьшает размеры кисти, клавиша ] (закрывающая квадратная скобка) служит 

для увеличения кисти. 

Режим быстрой маски 

Основные положения 

Быстрая маска (Quick Mask) - это особый режим редактора, когда все 
средства программы действуют не на изображение, а создают 
специальный объект, называемый маской. В программе она 
представляется как полупрозрачная пленка красного цвета, 
накрывающая оригинал. 

При работе с маской все изобразительные средства программы работают по 
своему техническому паспорту, но свое действие ограничивают маской. Кисти 
рисуют, ластик стирает, фильтры обрабатывают объект по сложному 
алгоритмическому закону, но все эти действия влияют только на маску, оставляя 
само изображение в неприкосновенности. После перехода в нормальный режим 
созданная маска превращается в выделение. Ее точки образуют защищенные 
области пометки, а фрагменты, не входившие в маску, получают статус 
выделенных. 



Так, в левой части на рис. 5.11 выделены все белые точки фона, а защищенными 
являются пикселы, образующие центральную фигуру. С правой стороны показана 
маска, соответствующая этому выделению. 

 
 

Рис. 5.11. Маска и соответствующее ему выделение 

Эта отношение связывает выделения и маски, независимо от их происхождения. 
Чтобы яснее представить себе родство этих объектов достаточно провести очень 
простой эксперимент. Запустить редактор, открыть любое изображение, построить 
выделение любой формы, например, прямоугольное, и, нажимая клавишу Q, 
несколько раз перейти из нормального режима редактирования в режим быстрой 
маски и обратно. 

Чтобы создать и обработать маску требуется знать ее состояние в каждой точке 
изображения. Данные о маске хранятся в редакторе в специальном канале. Это 
полутоновое изображение, точки которого описывают состояние маски в данном 
месте. Правила назначения цвета очень простые. Черный цвет канала означает 
наличие маски в данном месте изображения, белый ее отсутствие. Все точки с 
промежуточными значениями попадают в переходную зону между выбранной и 
защищенной областями изображения. 



 
 

Рис. 5.12. Состояния канала маски растушеванного и нерастушеванного 

выделений 

Если посмотреть на канал маски из предыдущего примера, то мы увидим картинку, 
показанную на рис. 5.12 слева. Поскольку маска полностью накрывает фигуру 
ребенка, то ее канал имеет в этой области полностью черный однородный цвет. С 
правой стороны показано состояние канала после растушевки выделения. 

Быстрая маска обладает как явными, так и скрытыми преимуществами перед 
использованием геометрических средств выделения. Во-первых, рисование - это 
процедура более гибкая, чем черчение. Процесс создания маски происходит под 
полным контролем оператора, он допускает любые уточнения, поправки, 
коррективы формы. 

Во-вторых, маска по своему определению является более устойчивым 
образованием, нежели пометка. Если выделение можно снять одним неудачным 
щелчком, то маска обладает высокой устойчивостью относительно ошибок такого 
рода. 

В-третьих, обрисовка границ сложной формы - это непростой процесс, имеющий 
естественные пределы. Легко представить кривые такой сложности, которые 
трудно будет повторить даже самому усидчивому оператору. Рисование масок не 
знает таких ограничений. Меняя размер рисующего инструмента и масштаб 
изображения, при известном усердии можно создать маску самой сложной формы. 

Совокупный опыт пользователей редактора показывает, что возможностей режима 
быстрой маски достаточно для создания любых, даже самых трудных выделений. 

Приведем сводку технических приемов, необходимых для эффективной работы в 
режиме быстрой маски. 

 Переход в режим Quick Mask выполняется по нажатию клавиши Q или щелчком 

мыши по кнопке Edit in Quick Mask Mode (Редактирование в режиме 

быстрой маски), расположенной в нижней части панели инструментов. Для 



возвращения в нормальный режим редактирования служит та же клавиша Q или 

кнопка Edit in Standard Mode (Редактирование в стандартном режиме), 

расположенная в нижней левой части панели. 

 Не всегда можно четко различить в каком из режимов находится редактор, что 
способно стать причиной различных ошибок. Перечислим признаки режима 
быстрой маски. Заголовочная строка окна документа выводит дополнительную 

метку примерно такого вида Quick Mask/8, активный слой в палитре слоев 

подсвечивается серым цветом, а палитра Channels (Каналы) получает 

дополнительный канал под названием Quick Mask, как показано на рис. 5.13. 

 
 
Рис. 5.13. Признаки режима быстрой маски 

 В режиме Quick Mask рисование черным цветом создает маску самой высокой 

плотности. Она в программе по умолчанию представляется красным цветом 
половинной прозрачности. Рисование белым цветом удаляет маску. Мазки любым 
другим цветом создают, если можно так выразиться области промежуточного 
выделения. Их принадлежность к маске зависит только от яркости цвета 
рисования, но не от его хроматической составляющей. Например, мазок темно-
синим цветом создает область с высокой степенью принадлежности к маске. 

 Для создания маски сложной формы удобно работать с одной кистью, меняя цвет 
рисования с черного на белый и наоборот. Для изменения цвета по ходу работы 

достаточно нажать клавишу X. 



 Оперативный выбор размеров кисти выполняется при помощи 

клавиш [ (открывающая квадратная скобка) и ] (закрывающая квадратная 

скобка). 

 Если цвет быстрой маски совпадает с преобладающим цветом оригинала, то 
становится сложно различить ее границы. Цвет представления маски можно 

изменить. Для этого достаточно два раза подряд щелкнуть по кнопке Edit in 

Quick Mask Mode, а затем по цветовому полю Color. В результате на экран 

будет выведена палитры Color Picker, средствами которого можно задать 

удобный цвет представления быстрой маски (рис. 5.14). 

 
 
Рис. 5.14. Выбор цвета быстрой маски 

 Хорошие результаты дает сочетание режима быстрой маски и традиционных 
средств выделения. Часто при помощи лассо или иных средств строится 
приблизительная граница пометки, которая доводится до полной готовности в 
режиме быстрой маски. Подобный подход получил большую популярность у 
пользователей пакета. В следующем разделе рассмотрим всю необходимую 
технику. 

Создание выделения в режиме быстрой маски 

Создадим пометку самого сильного хищника северного полушария, чей удачный 
портрет показан на рис. 5.15. 



 
 

Рис. 5.15. Изображение для демонстрации режима быстрой маски 

1. Беглое изучение примера не дает оснований на успешное применение 

инструмента Magic Wand. Фоновые области и изображение медведя не 

слишком отличаются по яркости и цвету, чтобы получить пометку достаточной 
точности, основываясь на цветовом ключе. Пробные попытки полностью 
подтверждают предварительный вывод. При небольших значениях допуска 
пометка, создаваемая волшебной палочкой, чрезмерно дробиться, разбиваясь 
на множество мелких подобластей. При увеличении допуска она захватывает 
множество лишних точек. 

2. Выберем инструмент Magnetic Lasso (Магнитное лассо) (Shift+L) и с его 

помощью обведем медведя. Это полуавтоматическое средство выделения 
является разновидностью обычного лассо. Инструмент самостоятельно 
проводит границу по точкам с максимальной контрастностью. Достаточно 
начать пометку простым щелчком в стартовой точке, а далее просто вести 
мышь, приблизительно указывая расположение трассы. В местах с небольшим 
контрастом редактор может делать много ошибок. В таких случаях следует 
частыми щелчками ставить контрольные точки, принудительно выбирая 
расположение границы. Для замыкания границы достаточно совместить 
конечную и начальную точку или просто выполнить двойной щелчок. Важно 
отметить, что создаваемая граница не должна и не может быть предельно 
точной. Достаточно лишь приблизительно наметить контуры будущей 
пометки. 



 
 
Рис. 5.15. Результаты работы инструмента Magnetic Lasso 

3. Перейдем в режим быстрой маски, для чего достаточно нажать клавишу Q. В 

результате будет построена маска, по своей форме совпадающая с пометкой. 

 
 
Рис. 5.17. Маска, созданная на основе выделения 



4. Установим черный цвет рисования (D), выберем кисть (B), увеличим масштаб 

изображения примерно до 200% (Ctrl+плюс). Зададим размер кисти, 

сравнимый с размерами граничных погрешностей маски (18-20 пикселов). 

Чередуя рисование черным и белым цветом (X) исправим все погрешности 

маски на границе изображения медведя. Всю работу по корректировке маски 
можно выполнить одной кистью. Для расширения маски рисуем черным 
цветом, удаление маскированных фрагментов выполняется белым цветом. 

Быстрая смена цвета рисования выполняется по нажатию клавиши X. 

5. Самые сложные фрагменты расположены в нижней части изображения. Там 
маска не позволяет определить точное расположение границы. Чтобы 
свериться с оригиналом достаточно на время перейти в нормальный режим 

редактирования (Q). Тогда вместо сплошной маски изображается только 

граница, а для продолжения работы вернуться в исходный режим (Q). Если 

мешает и граница, то ее можно скрыть по нажатию клавиш Ctrl+H. 

6. Ничто не мешает проявить малую толику терпения и построить маску, 
близкую к идеальной. Будем считать, что получена очень точная форма, 
которая охватывает фигуру медведя без изъятий и перекрытий. Очень редко 
встречаются ситуации, когда выделенная область не требует растушевки. 
Растушевать границу можно в режиме редактирования при помощи штатной 

команды Select => Modify => Feather (Выделение => Модификация 

=> Растушевка), но существует и иной, часто более предпочтительный 

способ. Это размытие быстрой маски. Размытие - это перемешивание точек. 
На границе маски расположены красные и белые точки, их перемешивание 
создаст зону с точками переходного цвета, что означает сглаживание границы 
выделения. 

7. Оставаясь в режиме быстрой маски, выполним команду Filter => Blur => 

Gaussian Blur (Фильтр => Размытие => Размытие по Гауссу). Сила 

размытия зависит от значения параметра Radius (Радиус). Мы не связаны 

условиями конкретной практической задачи, поэтому свободны в выборе 
этого значения. Зададим достаточно большой радиус (7), чтобы сделать 
заметной переходную зону, которую создает фильтр. Закроем диалоговое 

окно фильтра щелчком по кнопке OK. Размытие попутно компенсирует все 

небольшие погрешности формы, которые существовали в созданной маске. 

На следующем рисунке с большим увеличением показаны фрагменты границы 
размытой и неразмытой маски. 

 



 

Рис. 5.18. Размытие границы маски 8. Вернуться в нормальный режим 

редактирования 

Команда Color Range 

Команда Color Range (Цветовой диапазон) - это одно из самых мощных средство 

создания сложных многосвязных выделений. Эта команда не геометрическая; ее 
принцип действия базируется на цветовом подобии точек. Несколько упрощая 
дело, можно считать, что она является расширением и дополнением популярного 

среди пользователей инструмента Magic Wand (Волшебная палочка). В отличие 

от волшебной палочки, команда предоставляет пользователю специальную среду 
и несколько удобных сервисных средств, упрощающих реализацию принципа 
цветового подобия. 

 
 

Рис. 5.19. Диалоговое окно команды Color Range 

Основные положения 

Команда запускается на выполнение из раздела главного меню Select => Color 

Range. Построение выделенного фрагмента выполняется при помощи 

специального диалогового окна, показанного на рис. 5.19. 

Приведем краткое описание интерфейсных элементов этого окна: 

 Select (Выделение). Список содержит перечень цветов и цветовых диапазонов. 

Если из этого списка выбрать определенный цвет, то программа выделит 



(полностью или частично) пикселы, в раскраску которых данная цветовая 

составляющая вносит свой вклад. Например, выбор пункта Red (Красный) 

обеспечивает пометку всех красных точек и точек с заметным вкладом красного 
цвета. Пикселы чистого зеленого и синего оттенков выделяться не будут. Первый 

по списку раздел Sampled Colors(По образцам) предназначен для выбора 

цветов при помощи специальных пробников - инструментов 

типа Eyedropper (Пипетка). 

 Fuzziness (Разброс). Этот параметр команды выполняет тонкую настройку 

помеченной области. Повышение величины разброса расширяет выделенную 
область, уменьшение разброса влечет за собой сокращение числа помеченных 

пикселов. Параметр доступен только в режиме Sampled Colors, во всех 

остальных случаях команды он блокируется. Действие разброса отличается от 

параметра To le r a n c e (Допуск), который применяется для настройки 

инструментов Magic Wand. С его помощью можно включить в состав выделения 

частично помеченные пикселы, что влечет за собой растушевку границы 
помеченной области. Все изменения значения разброса немедленно влияют на 
выделенную область; повторных щелчков пипеткой выполнять не требуется. 

 Localized Color Clusters (Локализованные наборы цветов). Опция служит 

для ограничения выбора в пространстве. Если она включена, то будут выбраны 
точки, которые не только попадают в заданный цветовой диапазон, но и 

расположены не далее, чем указано в разделе Range. 

 Range (Диапазон). Задает максимальное удаление точек, которые могут быть 

выбраны. Раздел доступен, если только включена опция Localized Color 

Clusters. 

 Selection (Выделение). Радиокнопка, которая включает в диалоговом окне 

отображение помеченной области. Пикселы, выбранные полностью, 
изображаются в окне белым цветом, защищенные точки изображения остаются 
темно-серыми, пикселы, включенные в пометку частично, представляются в 
серых тонах. 

 Image (Изображение). Если выбрать эту радиокнопку, то в диалоговом окне 

будет отображаться не помеченная область, а миниатюра изображения. 

 Selection Preview (Просмотр выделения). Список объединяет различные 

варианты визуализации помеченной области в окне документа. В некоторых 
случаях работа над сложным выделением может стать намного комфортнее, если 
пометка отображается в окне документа, а самоизображение в диалоговом 

окнеColor Range. Чтобы добиться такой перестановки требуется включить 

кнопку Image и выбрать в списке Selection Preview удобный способ 

визуализации картинки. 

 Eyedropper (Пипетка). Инструмент, с помощью которого отбираются пробы 

цвета. Итоговое выделение строится по цветовым характеристикам эталонной 
точки, указанной этим инструментом, и заданного значения разброса. 

 Add to Sample (Добавить). При помощи этого инструмента можно добавить 

пикселы к уже существующему выделению. Его работа эквивалентна действию 

обычной пипетки при нажатой клавише Shift. 

 Subtract from Sample (Вычесть). Этот инструмент выполняет вычитание 

пикселей из заданной помеченной области. Эффект от его применения совпадает 

с использованием инструмента Eyedropper при нажатой клавише Alt. 



 Invert (Инвертировать). Переключатель служит для перестановки выделенной 

и защищенной областей изображения. 

Команда - это одно из немногих средств редактора, которым доступна точная 
пометка диапазона близких цветов и выделение мелких деталей изображения. 
Можно рассчитывать на хорошие результаты работы, если искомые фрагменты 
сильно различаются по своему цвету с окружающими областями изображения. 

 
 

Рис. 5.20. Фотография памятника 

Создание выделение при помощи команды Color Range 

Рассмотрим изображение монумента, показанное на рис. 5.20. Снимок был сделан 
в один из дождливых дней, которыми так богата лондонская осень, поэтому 
величественный памятник теряет значительную часть своей привлекательности. В 
этой ситуации возможны различные стратегии оживления картинки: заменить 
небо библиотечным изображением, заимствованным из многочисленных 
тематических коллекций фонов и текстур, внести кардинальные исправления в 
существующую картинку и, наконец, нарисовать новый задний план при помощи 

фильтров и инструментов Photoshop. Любое решение требует радикального 

вмешательства в изображение, что влечет за собой необходимость отделения 
фона от фотографии памятника. 



Выбор инструмента выделения в значительной степени зависит от вкусов и 
пристрастий ретушера, но, по объективным показаниям, лучшим выбором в 

данной ситуации будет команда Color Range. Любой геометрический инструмент 

потребует кропотливой работы по выделению мелких деталей шпиля и ажурной 
решетки в средней части памятника. Кроме того, фоновый рисунок представляет 

собой многосвязную область, что затрудняет работу с инструментом Magic Wand. 

Рассмотрим примерную последовательность операций, которую требуется 
выполнить для выделения искомого цветового диапазона. 

1. Выполним команду Select => Color Range. 

2. Выберем способ визуализации изображения и его помеченной части. В данном 
примере очень важно добиться точной пометки мелких деталей в верхней и 
средней части памятника. Хороший визуальный контроль можно получить при 

отображении маски в окне документа. Для этого в списке Selection 

Previewможно выбрать любой пункт, за исключением None. Так, 

пункт Grayscale дает высококонтрастное, хорошо различимое изображение 

выделенной и защищенной частей оригинала. 

3. Установим небольшое значение параметра Fuzziness (Разброс). Стартовая 

величина разброса выбирается обычно в диапазоне от 10 до 20. Уменьшение 
этого параметра делает границы выделения слишком резкими; увеличение 
разброса чрезмерно их размывает. 

4. В списке Select выберем пункт Sampled Color. Это позволит пользоваться 

инструментом Eyedropper, который служит для указания пробных точек "от 
руки". Щелчок пипеткой по изображению или его миниатюре создает 
некоторую пометку. Требуется, выбирая различные пробные точки, добиться 
максимально точного совпадения выделения с границами фона. Хороший 
результат - это продукт настойчивых, многократных попыток. Чтобы получить 
точное выделение следует подобрать пикселы, определяющие искомый 
цветовой диапазон. 

Какие средства для решения этой задачи предоставляет команда? Для этого 
можно выполнять простые щелчки по различным точкам фона, перетаскивать 

пипетку при нажатой клавише Shift, добавлять или вычитать пикселы из 

помеченной области при помощи инструментов Add to 

Sample и Subtract from Sample. Чтобы после неудачной попытки 

восстановить настройки диалогового окна, принятые по умолчанию, следует, 

удерживая клавишу Alt, щелкнуть по кнопке Reset (Сброс). Для нашего примера 

неплохая маска была сформирована после нескольких последовательных щелчков 

пипеткой по темным областям фона при нажатой клавише Shift. Полученная 

маска показана на следующем рисунке. Ее нельзя считать полностью законченной, 
но это неплохая основа для дальнейшей работы. 

Изменяя величину разброса, можно уточнить геометрию полученной маски. Чем 
выше значение этого параметра, тем больше пикселов изображения будет 
включено в состав помеченного фрагмента. В процессе экспериментов следует 
добиться того, чтобы граница между маской и выделением проходила как можно 
точнее по контуру монумента. При этом могут быть захвачены точки, 
принадлежащие внутренним областям памятника. Бояться этого не следует, 
поскольку лишние пикселы можно легко удалить на последующих этапах работы. 



В нашем примере хороший компромисс между точностью границы и 

избыточностью маски был получен для параметра Fuzziness, примерно равного 

15. Остальные параметры показаны на рис. 5.21. Для завершения работы с 

диалоговым окном следует щелкнуть по кнопке OK. 

 
 

Рис. 5.21. Маска в окне команды 

Созданная маска нуждается в уточнении. Даже при самом тщательном выборе 
пробных точек и настройке разброса видимо останутся защищенные точки 
принадлежащие фону, и выделенные пикселы, расположенные на внутренних 
частях памятника. Финальную настройку проще всего выполнить в режиме 
быстрой маски. Самый удобный способ перехода в этот режим дает нажатие 

клавиши Q. После того как построено выделение, отделяющее небо от монумента, 

открываются широкие возможности для внесения исправлений в фотографию 
Например, можно при помощи штатных инструментов цветокоррекции Photoshop 
сделать фон более ярким и солнечным. Несколько таких методик рассматриваются 
в последующих разделах этого курса. В некоторых случаях неплохую имитацию 

изображения неба способны дать фильтр Clouds (Облака) или 

инструмент Gradient (Градиент). Для этого надо выбрать подходящие оттенки 

голубого для цвета фона и цвета переднего плана и применить эти средства к 
выделенной части картинки. В данной ситуации, когда фон полностью отделен от 
центральной части изображения, можно применить и самое радикальное решение 



- создать новую композицию из монумента и изображения заднего плана, 
заимствованного из внешних источников. 

Ключевые термины 

Быстрая маска - специальный режим работы редактора, в котором все 
рисующие инструменты и обрабатывающие команды воздействуют не на 
изображение, а преобразуют специальный вспомогательный объект - быструю 

маску (quick mask), которая служит формой представления выделений и 

является способом их хранения. После завершения обработки маска 
конвертируется в выделение. 

Визуализация и сокрытие границы - базовая операция с выделенными 
областями, которая скрывает и выводит границу выделения, не удаляя саму 

выделенную область. В редакторе Photoshop это делается по нажатию Ctrl+H. 

Выделение - совокупность пикселов изображения, обладающих исключительным 
правом на обработку. Область применения инструментов и команд редактора. 

Маска - совокупность пикселов, не входящих в выделенную область. Защищенная 
часть изображения, которая является дополнением выделения. 

Обращение выделений - базовая операция с выделенными областями, которая 
меняет местами выделенную и защищенную области. 

Размытие - процедура усреднения цветовых и яркостных значений соседних 
пикселов. Размытие уменьшает контрастность обрабатываемой области, 
микширует границы, смягчает цветовые градации. 

Растушевка - создание переходной зоны на границе выделенной области. Эта 
операция размывает границу между выделением и окружающими ее пикселами. 

Сглаживание (антиалиасинг, antialiasing) - удаление ступенек и изломов гладких 
кривых и границ растровых изображений. Для этого точкам, расположенным в 
непосредственной близости от границы, присваиваются оттенки граничных 
пикселов, тем самым маскируя негладкость. 

Тоновое подобие - способ выбора точек инструментом Magic Wand. Инструмент 

включает в выделение все точки, яркость которых отличается от эталонной не 
более чем на заданную величину. 

Цветовой диапазон - принцип действия команды Color Range. Он заключается 

в выборе диапазона цветов по указанной пробной точке и заданному допуску. 
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Создание пометки при помощи инструмента 
Background Eraser 

Инструмент Background Eraser (Фоновый ластик) предназначен для 
удаления пикселов фона. Это штатное назначение специализированное 

средство впервые появилось в пятой версии пакета Photoshop. Новинка 

оказалась удачной - это экономично реализованное средство естественно 
вписалось в состав инструментов программы и получило признание 
пользователей. 

Основные положения 

Действие инструмента представляет собой сочетание эффектов 
волшебной палочки и обычного ластика. Он удаляет все пикселы, 
расположенные под кистью и попадающие в некоторую окрестность 
пробной точки. Пробной точкой служит центр кисти; он изображается в 
виде крестика. Размер окрестности зависит от заданного значения 
допуска. 

Если обрабатывается изображение, сведенное на один слой, то инструмент 
оставляет после себя прозрачные пикселы, которые по умолчанию отображаются 
в программе в виде шахматного узора белых и серых квадратиков. Стирание на 
многослойном изображении открывает пикселы слоя, расположенного ниже 
активного. 

Во многих ситуациях, когда не срабатывает стандартная техника пометки или 
работа со штатными инструментами выделения сопряжена с большими затратами, 
этот инструмент может дать простое решение. 

 



 

Рис. 6.1. Настройки инструмента Background Eraser 

Кнопка вызова инструмента расположена в средней части левого ряда панели 
инструментов. Для быстрого выбора достаточно несколько раз подряд 

нажать Shift+E. Все настроечные параметры инструмента Background Eraser 

представлены на панели свойств (рис. 6.1). 

Рассмотрим их: 

1. Brush (Кисть). Список, из которого можно выбрать кисть подходящего 

размера, формы и жесткости. 

2. Sampling: continuous (Непрерывная выборка). Выбирает непрерывный 

режим отбора проб. В этом случае эталонный цвет снимается с точек 
изображения, которые заметаются мышкой. 

3. Sampling: once (Однократно). В качестве эталонной выбирается точка 

первого щелчка инструментом. 

4. Sampling: background swatch (Выборка по фоновому цвету). 

Эталонным считается текущий фоновый цвет. 

5. Limits (Ограничения). Список служит для выбора одного из способов 

формирования окрестности пробной точки. Программа предлагает три 

различных варианта Режим Contiguous (Смежные пикселы) выбирает для 

удаления все соседние точки пробного пиксела, попадающие в заданный 

цветовой диапазон. В режиме Discontiguous (Все пикселы) в искомую 

окрестность включаются все пикселы заданного цветового диапазона, в том 
числе и несмежные с пробной точкой. В этом режиме 

инструмент Background Eraser удаляет больше точек, нежели в первом. 

В режиме Find Edges (Выделение краев) удаляются смежные области, 

построенные по образцу захваченного цвета, но при этом выполняются 
специальные действия по сохранению резкости границ изображения 
переднего плана. Это часто приводит к появлению на краях объектов 
ореолов, состоящих из захваченных фоновых точек. 

6. Tole rance (Допуск). Числовое поле, при помощи которого задается 

степень близости удаляемых пикселей. Чем выше значение допуска, тем 
больший диапазон цветов, заметаемых кистью, будет удален. 

7. Protect Foreground Color (Сохранить цвет переднего плана). 

Переключатель обеспечивает сохранение на активном слое точек, 
окрашенных основным рисующим цветом (цветом переднего плана). 

Использование инструмента Background Eraser 

Пусть требуется отделить от фона изображение мишки (рис. 6.2). 

Беглый осмотр оригинала позволяет сделать вывод о том, что в данной ситуации 
применение любого геометрического инструмента выделения - это заведомо 
бесперспективное дело. Потребуется несколько часов кропотливой работы для 

того, чтобы при помощи инструмента Lasso или кисточкой в режиме быстрой 



маски точно обрисовать все шерстинки животного. Инструмент Background 

Eraser позволяет решить эту задачу более эффективно. 

Рассмотрим основные операции процедуры: 

1. Пусть изображение загружено в программу. Сначала нужно создать дубликат 
основного слоя. Программа располагает несколькими различными средствами 

для решения этой задачи. Например, можно по нажатию клавиши F7 вывести 

на экран палитру Layers (Слои) и перетащить слой на пиктограмму Create 

New Layer (Создать новый слой). Самый оперативный способ дублирования 

слоев - это сочетание клавиш Ctrl+J. По умолчанию новый слой получит 

название Layer 1 и станет активным. 

 
 
Рис. 6.2. Пример для демонстрации инструмента Background Eraser 

2. Отключим видимость нижнего фонового слоя. Для этого достаточно щелкнуть 
по пиктограмме с изображением глаза, расположенной слева от слоя в 

палитре Layers. Активным должен остаться верхний слой. Признаком 

активности является синяя подсветка слоя в палитре. 

3. Активизировать инструмент Background Eraser. Для этого надо, 

удерживая Shift, несколько раз нажать клавишу E или воспользоваться 

соответствующей кнопкой панели инструментов. В программе он 
изображается в виде ластика с ножницами. 

4. Задать значения настроечных параметров инструмента. Эта задача не может 
иметь единственного решения. Оптимальное сочетание настроек подбирается 
опытным путем. Для данного примера целесообразно выбрать 

режимы Contiguous (Смежные пикселы) и Once (Однократно). Первый 

позволяет удалять только смежные с пробной точки фона, второй - фиксирует 
пробную точку той позицией, где сделан первый щелчок. Это, в сочетании с 
небольшим значением допуска, гарантирует наиболее безопасный вариант 
удаления. Установить значение допуска, равное примерно 10 процентам. 
Выбрать кисть небольшого размера с мягкими краями. Габариты кисти должны 
быть сравнимы с размерами обрабатываемых деталей. В нашем случае была 
выбрана мягкая кисть с диаметром 9. 



5. Комбинируя щелчки и перемещения ластика создать вокруг изображения 
медведя "зону отчуждения". Примерный вид такой области разделения 
показан на рис. 6.3. Работу следует проводить при достаточном увеличении 
картинки. Масштаб, равный 200 процентам, позволит ясно различить области 
фона и отдельные шерстинки. Щелчок ластиком указывает программе 
удаляемую точку фона. На основе заданного допуска программа находит все 
подобные точки фона и удаляет их. Каждое такое действие делает 
окрестность пробной точки прозрачной. Даже самая тщательная работа с 
ластиком и выбор наиболее "осторожных установок" этого инструмента не 
может гарантировать отсутствие ошибок. Для отката на несколько шагов 

можно использовать удобное сочетание клавиш Ctrl+Alt+Z. Поскольку 

работа ведется на дубликате фонового слоя, то нет опасности совершить 
непоправимую ошибку. 

 
 
Рис. 6.3. Зона отчуждения, созданная фоновым ластиком 

6. После того как создана "пограничная область", требуется распространить ее 
на все пространство фона, до границ изображения включительно. Эту часть 

работы проще всего выполнить при помощи инструмента Polygonal 

Lasso (Прямолинейное лассо). Это разновидность лассо, которая рисует 

ломаные линии. Данное обстоятельство упрощает трассировку границы, 
поскольку инструмент требует только установки опорной точки при изменении 
направления. 

7. Приведем границу выделения по прозрачной полосе, как показано на рис. 6.4. 
В этой области граница может располагаться довольно свободно, важно 
только чтобы она не пересекала закрашенные области. 



 
 
Рис. 6.4. Трасса полигонального лассо 

8. Удалим все выделенные точки верхнего слоя. Задачу проще все решает 

нажатие клавиши Del (рис. 6.5). 

 
 
Рис. 6.5. Удаление фоновых точек 

9. После этой операции на границе изображения может остаться полоска, 
состоящая из пикселов фона. Для ее удаления следует применить 

команду Layer => Matting => Defringe (Слой => Обработка краев 

=> Убрать бахрому). Эта команда маскирует захваченные пикселы фона 

путем их перекрашивания в цвет ближайшей базовой точки. Размер 
обрабатываемой пограничной области задается в пикселах. Одного или двух 
пикселов будет достаточно для большинства случаев. 

Эта операция завершает создание искомого выделения. Чтобы получить его в 
явном виде, когда граница помеченной и маскированной областей представляется 

в виде мерцающего пунктира, который пользователи Photoshop окрестили 

"марширующими муравьями", достаточно, удерживая клавишу Ctrl, щелкнуть по 



верхнему слою (по имени Layer 1) в палитре слоев. В результате будут 

помечены все непрозрачные точки активного слоя, т.е. изображение медведя. 

Использование каналов 

Введение 

Каналом называется представление растрового изображения в 
градациях отдельной цветовой координаты. Любая картинка 

в Photoshop представляет собой композицию некоторых базовых тонов - 

цветовых координат, набор которых зависит от выбранной хроматической модели. 
Это утверждение справедливо для всех способов представления растровых 

образов, за исключением модели Indexed Color (Индексированные цвета). 

Модель Bitmap (Битовый формат) описывается одним каналом с глубиной цвета, 

равной одному биту, но к этому способу представления графических данных 
обычно не применяют этот термин. 

Самой известной цветовой моделью является RGB, где различные оттенки 

получаются в результате смешения красного (Red), зеленого (Green) и синего 

(Blue) тонов разной интенсивности. Можно сказать, что в этой модели 

изображение состоит из трех каналов. В модели CMYK - четыре канала. Любая 

картинка в градациях серого Grayscale имеет всего один канал. Кроме основных 

каналов, без которых невозможно отображение растрового образа, могут 
создаваться и дополнительные, называемые иногда альфа-каналами. Обычно в 
этой форме хранят сложные маски. Быстрая маска также хранится во отдельном 
временном канале. 

Каким образом каналы кодируют цвет? Правила очень простые. Цвет получается в 
результате взаимодействия нескольких цветовых координат. Вклад или 
интенсивность каждой координаты описывается соответствующим каналом. Чем 
светлее точка канала, тем сильнее влияние цвета в данном месте изображения. 
Так черные точки каналов свидетельствуют об отсутствии хроматической 
координаты, белые точки говорят о ее максимальной интенсивности. 

На рис. 6.6 показаны цветная фотография горного пейзажа, записанная в 

системе RGB, а на рис. 6.7 -полутоновые изображения трех каналов этой картинки. 



 
 

Рис. 6.6. Фотография горного пейзажа 

Каналы представлены в последовательности, совпадающей с порядком букв в 

названии цветовой модели: слева красный (Red), в центре зеленый (Green), 

справа голубой (Blue) (см. рис. 6.7). 

 
 

 

Рис. 6.6. Каналы изображения 

Все побывавшие в горах знают, что на большой высоте очень ясное небо высокой, 
почти предельной, голубизны и очень белый снег. А тот, кто не бывал, может 
убедиться в этом по состоянию цветовых каналов. Синее небо должно иметь 

высокий вклад цветовой координаты Blue. Действительно, в области неба третий 

канал близок к белому, что свидетельствует о высокой яркости синего цвета. 
Чтобы получить белый цвет следует сложить все три координаты в равных 
пропорциях. Состояние каналов подтверждает и этот вывод. Все они имеют 
одинаковую яркость в тех местах, где на фотографии лежит снег. Это особенно 
заметно по снеговому склону правой горы. 

Для обработки каналов в редакторе используется специальная 

палитра Channels (Каналы), показанная на рис. 6.8. Вызов этой палитры 

выполняется по команде Window => Channels. Правила обращения с ней ничем 

не отличаются от палитры Layers. Для быстрого выбора отдельных каналов 

служат удобные клавиатурные сочетания Ctrl+#, где символ решетки означает 

номер канала. Например, чтобы сделать активным канал Green в системе RGB 
достаточно нажать Ctrl+4. 

http://www.intuit.ru/EDI/27_04_15_5/1430086749-14056/tutorial/1047/objects/7/files/07-07.jpg


 
 

Рис. 6.8. Палитра Channels 

Традиционно каналы рассматриваются ретушерами как мощное средство цветовой 
коррекции. Действительно, меняя яркость или контрастность отдельных цветовых 
координат, можно выполнить глубокую настройку цветовой гаммы растровой 
картинки. Намного реже они используются как средство создания сложных 
выделений. В некоторых случаях отдельные каналы могут содержать больше 
информации, пригодной для построения требуемого выделения, чем полноцветное 
представление растрового изображения. 

Создание маски по цветовому каналу. Вариант 1 

Пусть требуется создать выделение маленькой обезьянки (рис. 6.9). Эта задача по 
постановке и сути решаемых проблем напоминает ту, которая рассматривалась в 
предыдущем разделе. Но в данной ситуации применение 

инструмента Background Eraser не позволит выполнить точное отделение 

нижней части фотографии от фона, поскольку в этой части фотографии туловище 
почти сливается с фоновым изображением. Решение может дать использование 
цветовых каналов. 



 
 

Рис. 6.9. 

1. Выведем на экран палитру Channels (Каналы). Для этого надо выполнить 

команду главного меню Window => Channels (Окно => Каналы). 

Оригинал представляет собой сканированный снимок, заданный в 

модели RGB, поэтому состоит из трех каналов. 

2. Проверим вид отдельных каналов. Чтобы отобразить на экране представление 
одного цветового канала достаточно щелкнуть по его имени в палитре 
Channels. Другое решение этой задачи дают клавиатурные 

комбинации: Ctrl+3 -для Red, Ctrl+4 - для Green, Ctrl+5 - для Blue. 

Оказалось, что для нашего примера лучший контраст фона и изображения 
обезьянки достигается для канала синего цвета. Часто отдельный канал дает 
больше оснований для создания искомого выделения, чем сам оригинал. Вот и 
в данном случае полутоновая версия дает очень хорошее приближение к 
маске (рис. 6.10). Продолжим работу с каналом синего цвета. Требуется 
добиться такого его состояния, которое, во-первых, сделает видимой границу 
между туловищем и фоном, и, во-вторых, сохранит хорошую контрастность 
всех шерстинок шкуры животного. 

 
 
Рис. 6.10. Канал синего цвета 

3. Если работать с каналом напрямую, то это может привести к появление 
цветовых аномалий, поэтому канал следует дублировать. Для этого 



достаточно перетащить его пиктограмму на кнопку Create new 

channel (Создать новый канал), которая расположена в нижней части 

палитры Channels. Новый канал получит имя Blue copy и станет активным. 

4. Для усиления контраста между изображением обезьянки и окружающей 

средой применим к картинке средство Threshold (Изогелия). Эта команда 

окрашивает пикселы изображения в два цвета - черный и белый. 
Основанием для разделения служит величина заданного порога. Все 
точки, яркость которых превышает пороговое значение, становятся 
белыми, а точки с яркостью меньшей установленного рубежа, 
объявляются черными. Меняя величину порога, можно получить вариант 
изображения с хорошо заметным контрастом фона и центральной сцены. 

Искомая команда расположена в разделе главного меню пакета Image => 
Adjustments => Threshold (Изображение => Коррекция => 

Изогелия). Управление командой выполняется посредством одного 

регулятора в диалоговом окне с тем же названием. Эксперименты с 
интерактивным ползунком показали, что для нашего примера лучшие 
результаты даетзначение порога, равное 160 (рис. 6.11). 

 
 
Рис. 6.11. Двуцветный вариант канала синего цвета 

5. Изображение обработанного канала, представленное на предыдущем рисунке, 
показывает, что большая часть работы по созданию маски выполнена 
успешно. Всего лишь несколько ее фрагментов требуют ручного 
вмешательства. Это черные области в верхней левой части изображения, 
черный фрагмент небольшого размера в верхнем правом углу и несколько 
маленьких белых областей на теле животного. Все необходимые правки 
можно выполнить посредством обычной кисти или ластика, просто 



перекрашивая неточно выделенные области в белый или черный цвет (рис. 
6.12). 

 
 
Рис. 6.12. Вид маски после ручной корректировки 

6. Построенная маска выглядит несколько резкой. Это значит, что между 
выбранными и защищенными точками не существует переходной области 
даже небольшого размера. Для создания такой области целесообразно 
немного размыть маску. Данную задачу проще всего решить при помощи 

команды главного менюFilter => Blur => Gaussian Blur (Фильтр => 

Размытие => Размытие по Гауссу). Работой этого фильтра управляет 

один настроечный параметр Radius (Радиус), который задает степень 

размытия. Он принимает значения в диапазоне от 0,1 до 250 пикселей. В 
нашем случае следует выбрать небольшую величину радиуса размытия, в 
интервале от 0,8 до 1. 

7. После размытия канал полностью подготовлен для создания искомого вы-
деления. Легко заметить, что вид этого канала полностью совпадает с 
образом оригинала, который требовалось пометить. Чтобы превратить канал в 

выделение достаточно воспользоваться комбинацией клавиш Ctrl+Alt+6, 

где шестерка представляет собой номер канала Blue copy. Иная техника 

исполнения этой операции - это щелчок по имени канала в 

палитре Channels, при нажатой клавише Ctrl. 

8. Вернемся к композитному каналу. Этим термином профессионалы называют 
цветную версию изображения. Для этого можно воспользоваться палитрой 

Channels или сочетанием клавиш Ctrl+2. 

9. Для завершения операции осталось поменять местами выделенную и за-

щищенные области. Задачу решает команду Select 

=> Inverse (Выделение => Инверсия) или сочетание 

клавиш Ctrl+Shift+I. 

Создание маски по цветовому каналу. Вариант 2 

Рассмотрим еще один вариант использования данных отдельного цветового 
канала для построения маски. В качестве примера выберем фотографию, 
показанную на рис. 6.13, и попробуем отделить изображение животного от 
окружающего пейзажа. 



 
 

Рис. 6.13. Пример 

Не обсуждая аргументы, обосновывающие необходимость подобного 
преобразования в данной ситуации, будем просто рассматривать выбранную 
фотографию как учебный пример, хорошо подходящий для иллюстрации 
методики. 

1. Просмотр каналов не дает оснований для оптимистического прогноза: ни один 

из стандартных каналов аддитивной цветовой модели RGB не показывает 

значительной разницы между фоном и изображением животного. Попробуем 
изменить базовую цветовую модель и, соответственно, распределение 
цветовой информации по каналам. 

2. Переведем изображение в субтрактивную четырехкрасочную модель CMYK. 

Для этого требуется выполнить команду Image => Mode => CMYK Color 

(Изображение => Режим => CMYK). 

 



 
Рис. 6.14. Представление изображения в канале черной краски 

В результате информация о цвете выбранного примера будет представлена 

посредством четырех каналов: Cyan (Голубой , C), Magenta (Пурпурный, 

M), Yellow (Желтый, Y) и Black (Черный, K). Просмотр новых каналов 

показывает, что самой высокой контрастностью обладает канал черного цвета 
(четвертый по счету). Для перехода в этот канал достаточно воспользоваться 

комбинацией клавиш Ctrl+6. Его контрастность оказалась настолько велика 

(см. рис. 6.14), что предоставляет большую часть маски в готовом виде. 

3. Чтобы защитить изображение от изменений, требуется создать копию 

канала Black. Для этого достаточно просто перетащить его пиктограмму на 

кнопку Create new channel (Создать новый канал) 

палитры Channels (Каналы). Новый канал автоматически становится 

активным, и несколько последующих операций выполняются с его 
содержимым. 

4. Чтобы успешно завершить процедуру, требуется получить такой вариант 
канала, у которого фигура зубра окрашена в черный цвет, а окружающий фон 
будет закрашен белой краской. Распределение цветов не имеет значения, 
поскольку они легко меняются местами. Для генерации такой раскраски 
можно использовать любые изобразительные средства программы: кисть, 
аэрограф, ластик и пр. Рассмотрим применение инструментов тонирования. 

Выберем инструмент Burn (Затемнитель) и уберем светлые точки, 

расположенные на пограничных областях изображения зубра. Для успешной 
обработки следует использовать тоновые 

диапазоны Shadows (Тени), Highlights (Подстветка) и половинное 

значение параметра Exposure (Экспозиция). Напомним, что все необходимые 

настройки этого инструмента расположены на панели Options (Панель 

свойств). 

5. Для очистки фона можно использовать инструменты Eraser (Ластик) 

и Dodge (Осветлитель). С помощью первого выполняется грубая работа на 

участках, которые не примыкают к фигуре центрального плана. Осветлитель - 
это более тонкое средство, посредством которого можно убрать темные 
фрагменты, смежные с нижней частью фигуры животного. Чередуя режимы 
осветления и затемнения, надо постараться получить четкую границу между 
фоном и центральной частью композиции. Эти инструменты составляют 
удачную взаимодополнительную пару. Ошибки, сделанные одним средством, 
легко исправляются его визави. 

6. После того как изображение будет представлено в двуцветной палитре - 
только при помощи черной и белой красок, построение маски можно считать 
законченным. Некоторые фрагменты границы маски выглядят излишне резко, 
поэтому имеет смысл немного размыть изображение. Лучшее средство для 

решения данной задачи - это штатный фильтр пакета Gaussian 

Blur (Размытие по Гауссу), который расположен в разделе главного 

меню Filter => Blur (Фильтр => Размытие). Лучший эффект дает 

применение фильтра с небольшим радиусом; его значение не должно 
превышать 1. 



 
 
Рис. 6.15. Завершенная маска 

7. В большинстве растровых редакторов действует соглашение, согласно 
которому черные области маски соответствуют защищенным фрагментам 
изображения, а белым цветом изображаются выделенные точки. В нашем 
примере распределение цветов прямо противоположное. Поменяем раскладку 

цветов. Для этого следует выполнить команду Image => Adjustments 

=> Invert (Изображение => Коррекция => Инверсия) или 

воспользоваться клавиатурной комбинацией Ctrl+I. Вид полностью готовой 

маски показан на рис. 6.15. 

Напомним, что для превращения маски в выделение достаточно щелкнуть по 

пиктограмме соответствующего канала в палитре Channels, удерживая 

клавишу Ctrl. Более оперативный способ решения этой задачи дает комбинация 

клавиш Ctrl+Alt+#, где символ решетки означает номер канала, хранящего 

маску. В нашем случае это шестой канал. 

Предварительная подготовка изображения и правильно выбранный канал 
позволяют получить почти полностью готовую маску. Для завершения работы 
потребовалась незначительная отделка границ изображения. Эта работа вполне 
по силам и традиционным инструментам рисования программы (кисти, ластику и 
аэрографу), но применение инструментов тонирования в данной ситуации дает 
несколько заметных преимуществ. 

Инструменты тонирования Dodge (Осветлитель) и Burn (Затемнитель) действуют 

избирательно на отдельные тоновые диапазоны 

изображения Highlights (Подстветка), Midtones (Средние тона) 

и Shadows (Тени). Выбор активного диапазона выполняется при помощи списка, 

расположенного на панели свойств (рис. 6.16). 



 
 

Рис. 6.16. Настройки инструментов тонирования 

Граничные области маски и фона - это области высокого контраста, где по одну 
сторону расположены преимущественно светлые точки, а на другой стороне 
группируются темные пикселы. Для создания четкого разделения маски и фона 
этот контраст требуется еще более усилить. Это значит, что светлые области 

следует обработать инструментом Dodge, а темные - Burn. Если они работают в 

разных тоновых диапазонах, например, первый воздействует на средние тона или 
света, а второй - на тени, то вероятность ошибки существенно понижается. 
Стандартные инструменты не имеют такой подстраховки и успешность операции 
зависит только от терпения и твердости руки оператора. 

Создание маски по цветовому каналу. Вариант 3 

Рассмотрим еще один вариант создания сложной маски, использующий 
информацию цветовых каналов изображения. Такое внимание к каналам - это не 
авторский субъективизм, оно объясняется реальными причинами. Задачи 
построения простых масок в большинстве случаев решаются "в лоб", при помощи 
штатных средств и методик редактора. Программа располагает множеством 
разнообразных инструментов, но не дает в руки оператору волшебной палочки (по 
сути, а не по названию) - средства построения любых сложных масок. Поэтому во 
всех нештатных случаях требуется предварительная подготовка оригинала. 

Каналы представляют собой различные проекции изображения, которые могут 
содержать такой вариант оригинала, в котором достигается хорошая отделимость 
объекта от фона. В этой роли можно использовать дубликаты или слои оригинала, 
но все такие методики требуют проведения подготовительных, часто трудоемких, 
мероприятий. Не следует забывать о преобразовании изображения в другую 
цветовую систему. Это прием часто дает хорошие результаты для тех оригиналов, 
у которых каналы не обладают достаточной контрастностью для решения 
поставленной задачи. 



 
 

Рис. 6.16. Исходное изображение 

Пусть требуется заменить фон фотографии, показанной на рис. 6.16. Эта, 
пожалуй, самая сложная задача из всех, решаемых в данном разделе. Тонкие 
пряди волос и низкий контраст между прической модели и фоном делают ее 
трудно разрешимой для любой рассмотренной методики выделения. 

Изображение, выбранное для примера,- это цветной цифровой снимок, 

записанный в системе RGB. Будем считать, что оно загружено в редактор и на 

экран выведена палитра Channels. 

1. Проверим вид отдельных каналов. Чтобы отобразить на экране представление 
одного цветового канала достаточно щелкнуть по его имени в 

палитре Channels. Другое решение этой задачи дают клавиатурные 

комбинации: Ctrl+3 -для Red, Ctrl+4 - для Green, Ctrl+5 - для Blue. 

Оказалось, что для нашего примера лучший контраст фона и переднего плана 

достигается для канала синего цвета (Blue). Но, в данном примере, для 

уверенного построения маски недостаточно только той информации, которая 
содержится в синем цветовом канале. Работу с ним следует продолжить. 



Требуется добиться такого его осветления, которое, во-первых, сделает 
видимой границу между туловищем и фоном, и, во-вторых, сохранит хорошую 
контрастность прически. 

 
 
Рис. 6.18. Каналы фотографии 

2. Создадим дубликат канала Blue. Для этого достаточно перетащить его на 

пиктограмму Create new channel (Создать новый канал). Новый канал 

получит имя Blue copy. Дублирование канала - это подстраховка; если 

манипуляции с ним окажутся неудачными, то можно безболезненно вернуться 
к исходному изображению. 

3. Опытные пользователи знают, что сложение двух растровых объектов (слоев 
или каналов) в режиме, отличном от нормального, дает результат, 
принципиально отличающийся от исходных операндов. Сложение каналов 

выполняется при помощи команды Image => Apply Image (Изображение 

=> Внешний канал). Выполним эту команду. 



Команда предназначена для композиции двух изображений одинакового 
размера. Операция объединения требует, чтобы оба ее операнда были 
одновременно открыты в программе. Операндами могут быть композитные 
изображения, слои или каналы, принадлежащие одному или разным 
источникам. Важно, чтобы объединяемые образы имели одинаковые размеры. 
Активное изображение считается целевым. Можно считать, что при 
объединении оно находится снизу. Второе изображение называется 
источником, и его требуется выбрать из множества открытых изображений. 
Образ источника будет наложен на целевой. Для этой операции программа 
поддерживает большую часть режимов наложения, доступных для слоев. 

4. Все настройки команды Apply Image задаются в диалоговом окне, 

показанном на рис. 6.19. Если канал Blue copy остался активным (в 

противном случае пометить этот канал в палитре Channels), то потребуется 

минимальное вмешательство в это диалоговое окно, поскольку большинство 
требуемых параметров будет задано автоматически. Требуется наложить 
активный канал на себя и подобрать такой режим наложения, который дает 
максимальный контраст прически и фона. Режимы наложения выбираются в 

разделе Blending (Наложение). Результат изменения режима сразу 

показывается на экране, поэтому можно провести эксперименты и выбрать 
лучший из них. Испытания показали, что лучший результат дает 

режим Overlay (Наложение). 

 
 
Рис. 6.19. Диалоговое окно команды Apply Image с настройками сложения 
каналов 

5. Закроем диалоговое окно команды нажатием клавиши OK. Результат сложения 

каналов в режиме наложения показан на рис. 6.20. Изображение стало 
значительно контрастнее по своим границам. Проявились даже боковые 
полосы, которые не являются следствием операции. Это технологические 
фрагменты, указывающие на способ получения оригинала. 



 
 
Рис. 6.20. Вид канала Blue copy после выполнения операции сложения 

6. Резервы улучшения картинки еще не исчерпаны. Так можно усилить 

видимость границ при помощи фильтра High Pass (Цветовой контраст). 

Действие этого фильтра трудно описать несколькими фразами. Основной 
эффект от его применения заключается в следующем. Он окрашивает области 
изображения в нейтральный серый цвет, основываясь на различиях между 
цветами соседних точек. Если правильно подобрать значение радиуса - его 
единственного параметра - то в результате в изображении останутся только 
области с наивысшей контрастностью. Не снимая пометки с канала Blue copy 

выполнить команду Filter => Other => High Pass (Фильтр => 

Другие => Цветовой контраст). Появится диалоговое окно с тем же 

названием, в котором установить параметр Radius (Радиус) в диапазоне от 8 

до 15. Результат и настройки фильтра показаны на рис. 6.21. 



 
 
Рис. 6.21. Обработка канала фильтром High Pass 

7. После применения фильтра изображение выглядит отчасти "полинявшим". Это 
происходит потому, что большую часть точек он сдвигает в область 
нейтральных серых тонов, подчеркивая границы за счет пикселей внутренних 
областей. Теперь для получения маски требуется повысить общий контраст 
изображения. Для этого можно применить любое штатное средство тоновой 

коррекции, например инструмент Levels (Уровни). По команде Image => 
Adjustments => Levels (Изображение => Коррекция => 

Уровни) выведем на экран диалоговое окно, предназначенное для настройки 

тонов (рис. 6.22). 



 
 
Рис. 6.22. Диалоговое окно команды Levels 

8. Команда Levels - это самое простое и, вместе с тем, эффективное средство 

настройки тонового баланса. Его возможности подробно рассматриваются в 
разделе, посвященном тону и контрасту. Не вдаваясь в обсуждение деталей, 
установим регуляторы верхней шкалы так, как показано на рис. 6.23, и 

закроем диалоговое окно щелчком по кнопке OK. Эта операция значительно 

увеличит контраст обрабатываемого канала. 



 
 
Рис. 6.23. Увеличение контраста канала 

9. В результате проделанной работы получен образ с неплохим контрастом фона 
и переднего плана. Теперь волосы хорошо контрастируют с фоном, поэтому 
задача создания выделения упрощается. 



 
 

Рис. 6.24. Пометка светлых частей канала 

Хорошо заметна широкая белая полоса, окаймляющая прическу. Воспользуемся 
этим и попытаемся максимально автоматизировать задачу выделения волос. 

Выполним команду Select => Color Range (Выделение => Цветовой 

диапазон) и в разделе Select выберем пункт Highlights (Подсветка), как 

показано нарис. 6.24. Закроем диалоговое окно нажатием клавиши OK. 

Перейдем в режим быстрой маски (Q) и меняя цвет рисования с черного на белый 

(X) кистями разного размера удалим маску на фоне и восстановим ее на женской 

фигуре. В данной ситуации это не сложная проблема, поскольку самая трудная 
часть выделения (волосы) создана автоматически. А стирание и закрашивание 
площадей - задача элементарная. На следующем рисунке показана законченная 
маска. Сама маска изображена черным цветом и удалены все фоновые точки 
изображения (рис. 6.25). 



 
 

Рис. 6.25. Завершенная маска 

Использование режимов наложения 

Фотография наездницы (рис. 6.26) сделана в полевых условиях. При съемке на 
натуре трудно ожидать превосходных результатов, но этот пример являет 
редкое исключение. Образ удался автору. Композицию отчасти портят 
неправильная обрезка снимка и некоторый беспорядок в туалете амазонки, 
впрочем, совершенно оправданный в данных условиях. 

Предположим, что из натурного снимка требуется сделать фотографию. 
Поставленная задача не будет решена без построения точного выделения 
наездницы. Как это часто бывает, самая трудоемкая часть работы - это выделение 
развевающихся волос. В который раз при обсуждении заявленной темы возникает 
данная проблема. Тут нет никакого авторского субъективизма, просто при 
определенных условиях выделение волос становится задачей эталонной 
сложности. По изобилию деталей и непредсказуемости линий редкая натура 
может сравниться с пышной копной развевающихся волос. 



Рассмотрим способ, сердцевиной которого являются операции со слоями и их 
режимами наложения. Будем считать, что оригинал открыт в программе и на 
экран выведена палитра слоев, которая будет интенсивно использоваться в 
данной методике. 

 
 

Рис. 6.26. 

1. Изображение состоит из одного слоя Background. Это особенный слой, он 

накладывает ряд ограничений на выбор параметров, В частности он не имеет 
регулируемой прозрачности и режимов наложения. Сначала превратим 
фоновый слой в обычный. Для этого два раза подряд щелкнем по 

имени Background в палитре слоев. В диалоговом окне New Layer ввести 

новое имя для фона. Назовем его, например Original. 

2. Выберем инструмент Eyedropper (Пипетка) и возьмем пробу цвета с фона. 

Самый простой путь активизации пипетки - это нажатие клавиши I. В 

качестве пробной точки выберем участок фона в непосредственной близости 
от волос. 

3. Создать новый слой. Для этого достаточно выполнить команду главного 

меню Layer => New => Layer или просто нажать Ctrl+Shift+N. Имя 

нового слоя может быть любым. 

4. Зальем новый слой цветом, отобранным посредством пипетки. Самый простой 

способ для этой задачи дает комбинация клавиш Alt+Backspace. 

5. Изменим режим наложения нового слоя с Normal (Нормальный) 

на Difference (Разница). Изображение примет вид, показанный на рис. 6.26. 



 
 
Рис. 6.26. Вид изображения после наложения слоя в режиме Difference 

6. Создадим новый корректирующий слой Levels. Для этого надо выполнить 

команду с длинным названием Layer => New Adjustment Layer => 

Levels (Слой => Новый корректирующий слой => Уровни). Настроим 

регуляторы команды таким образом, чтобы повысить контрастность между 
темными и светлыми частями изображения. Применим установки диалогового 

окна, нажатием кнопки OK (рис. 6.28). 



 
 
Рис. 6.28. Усиление контраста при помощи корректирующего слоя Levels 

7. Создадим еще один новый слой (Ctrl+Shift+N). Он автоматически станет 

активным. Три следующие операции выполняются на этом слое. 

8. Выберем инструмент Lasso (L) и пометим наездницу таким образом, чтобы 

не выходить за пределы ее абриса. Граница пометки может быть немного 
смещена внутрь изображения, но она не должна захватывать фон. 

9. Зальем выделенную область белым цветом. Для этого надо сначала задать 

распределение цветов по умолчанию (D) и нажать Ctrl+Backspace. Снять 

пометку посредством сочетания клавиш Ctrl+D. После этой операции на 

границе пометки останутся многочисленные участки волос и туловища, 
окрашенные в отличные от белого цвета. 

10. Выберем кисть подходящего размера и закрасить белым цветом все 
фрагменты, которые не попали в выделенную область. Все операции по 
закраске совершенно безопасны, поскольку они выполняются на самом 
верхнем слое и не затрагивают само изображение. Любые ошибки в этой 
работе легко исправить простым перекрашиванием или глубокой отменой, 

которую разрешает палитра History. На рис. 6.29 показан результат только 

для самой верхней части изображения. Посредством выполненных операций 
изображение приведено к такому виду, который напоминает "псевдомаску" 
или "квазиканал". Черного фона в оригинале быть не должно. На рисунке он 
просто подчеркивает выделенную область, закрашенную белым цветом. 



 
 
Рис. 6.29. Псевдомаска 

11. Пометим все непрозрачные точки верхнего слоя. Для этого достаточно 

щелкнуть по его пиктограмме в палитре слоев, удерживая клавишу Ctrl. 

12. Сделаем активным самый нижний слой и отключим видимость всех остальных 
слоев. Теперь можно оценить полученный результат. Основная часть работы 
выполнена. Остались вне выделения только самые легкие локоны. Завершить 
создание сложного выделения можно при помощи режима быстрой маски. 

13. Перейти в режим быстрой маски (Q), задать большое увеличение, вы-брать 

подходящую кисть и внести все необходимые финальные поправки. 

14. Вернуться в стандартный режим редактирования (Q) 

При помощи комбинации клавиш Ctrl+Alt+Z можно выполнить откат на несколько 
шагов. Такая глубокая отмена - это фактически перемещение вверх по палитре 
History, к начальным состоянием изображения. Чтобы перейти по шкале времени 
вперед, в направлении конечных состояний, надо использовать комбинацию 
Ctrl+Shift+Z. 

 



Ключевые термины 

Альфа-канал - дополнительный канал растрового изображения, хранящий 
информацию о маске (выделении). Белые точки канала описывают выделенные 
области, черные - маскированные. Серые пикселы отвечают областям 
изображения с переходным состоянием выделения. 

Инструмент Background Eraser (Фоновый ластик) - средство, предназначенное 
для удаления фоновых точек изображения. Принцип действия инструмента 

представляет собой сочетание волшебной палочки (Magic Wand) и обычного 

ластика. Он удаляет все пикселы, расположенные под кистью и попадающие в 
некоторую окрестность пробной точки. 

Инструмент Burn (Затемнитель) - кисть, которая служит для затемнения 
обрабатываемых фрагментов изображения. Виртуальный аналог приема 
увеличения времени экспозиции при проявлении фотографий. Повторная 
обработка фрагментов кистью увеличивает затемнение. 

Инструмент Dodge (Осветлитель) - кисть, выполняющая осветление 
фрагментов. Мазки этой кистью не окрашивают, а осветляют обрабатываемые 
точки. Повторные мазки кистью усиливают эффект освещения. 

Инструмент Eyedropper (Пипетка) - средство для отбора цветовых проб. 
Щелчок инструментом по изображению делает цвет пробной точки активным 

цветом редактора. Этот прием при нажатой клавише Alt делает цвет пробной 

точки фоновым цветом. 

Кайма - пограничная зона, окружающая изображение отдельного слоя или 
плавающего объекта, цвет которой отличается от цвета фона. Кайма часто 
возникает при переносе фрагментов из одного изображения в другое. В 

программе существует специальная команда (Defringe), предназначенная для 

удаления подобных эффектов. 

Канал - представление растрового изображения в градациях одной 
цветовой координаты. Белые точки канала соответствуют максимальной 
интенсивности данного цвета. Черные точки описывают области нулевой 
интенсивности. Пикселы промежуточной яркости представляют промежуточные 
значения интенсивности цветовой координаты. 

Команда Apply Image (Внешний канал) - служит для композиции каналов, 
заимствованных из одного изображения или из различных изображений 
одинакового размера. 

Команда Defringe (Убрать кайму) - заменяет цвет пикселов каймы на цвет 
пикселов, удаленных от края. Кайма часто появляется после трансплантации 
фрагментов, заимствованных из сторонних источников. 

Команда Levels (Уровни) - служит для настройки тонов и контраста в 
изображении или выделенном фрагменте. 



Команда Threshold (Изогелия) - преобразует цветные и полутоновые в черно-
белые изображения предельной контрастности. 

Фильтр High Pass (Цветовой контраст) - сохраняет детализацию краев в 
пределах указанного радиуса, где возникают резкие переходы цветов, подавляя 
остальную часть изображения. Применение этого фильтра приводит к удалению 
из изображения некоторых мелких деталей и к созданию эффекта, отчасти 
противоположного размытию. 

Фильтр Gaussian Blur (Размытие по Гауссу) - усредняет цветовые и тоновые 
характеристики точек. Применение фильтра приводит к уменьшению количества 
деталей и позволяет создать эффект погружения в туман. 
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Артефактами принято называть любые дефекты изображения 
искусственного, внешнего происхождения. Для цифровых фотографий 
это, прежде всего, следы пыли, царапины, различные текстуры и узоры, 
возникающие при сканировании печатных оригиналов, зернистость 
фотопленки, перенесенная при оцифровке, и пр. 

Удаления артефактов одна из самых популярных и цитируемых проблем цифровой 
обработки изображений. Многолетняя практика использования растровых 
редакторов, в первую очередь Photoshop, позволила выработать множество 
различных рецептов для удаления дефектов. Если учесть, что многие методики и 
приемы могут комбинироваться и сочетаться друг с другом, то исчерпывающее 
описание алгоритмов технической ретуши способен вместить, пожалуй, только 
энциклопедический том, набранный петитом. В этом разделе рассмотрим только 
самые востребованные и эффективные способы борьбы с артефактами. Начнем с 
простейших. 

Инструмент Clone Stamp 
Основные положения 

Инструмент Clone Stamp (Штамп), наверное, самое популярное средство 
технической ретуши программы. Новичкам, делающим свои первые шаги в 
освоении пакета, оно кажется всесильным и удивительно остроумным. 
Искушенные пользователи часто недолюбливают его за монотонность и 
несбывшиеся ожидания. Профессионалы точно знают все сильные и слабые 
стороны этого средства и области его рационального применения. 



Инструмент присутствовал в программе с самых первых ее версий и за это время 
претерпел незначительные, декоративные изменения. За все время 
существования пакета тактика работы со штампом не обогатилась значительными 
нововведениями. В большинстве случаев она представляет собой хорошо 
знакомую каждому пользователю программы комбинацию отбора проб и переноса 
эталонных фрагментов на поврежденные участки изображения. 

Клонирующий штамп представляет собой кисть, которая не рисует, а 
позволяет обмениваться графическими данными между различными 
частями изображения. Тактика работы со штампом предельно проста. Сначала 
требуется указать область картинки, из которой будет производиться 
заимствование данных. Для этого нужно просто щелкнуть инструментом по 
выбранной точке, удерживая клавишу Alt. После выбора донорского фрагмента 
штамп позволяет перенести его графические данные в любое незащищенное 
место изображения. Это выполняется как рисование обычной кистью: короткими 
щелчками или длинными мазками. 

Для выбора штампа служит кнопка, расположенная на пятой сверху позиции 
левого ряда панели инструментов. Вызов инструмента можно осуществить 
посредством клавиши S. Все настроечные параметры размещены на панели 
свойств (рис. 7.1). Клонирующий штамп - это кисть специального назначения, 
поэтому большая часть настроек уже знакома по разделу, в котором обсуждалась 
техника использования кистей. 

 
 
Рис. 7.1. Настройки инструмента Clone Stamp 

Приведем лишь краткое описание настроек инструмента: 

1. Brush (Кисть). Вызывает диалоговое окно с настройками кисти; 
2. Вызывает и убирает панель Brush для глубокой настройки инструмента; 
3. Вызывает и убирает панель источника клонов, которая позволяет запоминать 

и настраивать образцы для клонирования; 
4. Mode (Режим). Выбирает режим наложения; 
5. Opacity (Непрозрачность). Служит для выбора значения непрозрачности; 
6. Включает и выключает управление прозрачностью при помощи планшета; 
7. Flow (Нажим). Задает скорость переноса краски с инструмента на 

изображение; 
8. Кнопка активации режима распылителя; 
9. Aligned (Выравнивание). Опция отвечает за взаимное расположение точки 

отбора пробы и кисти. Если эта опция включена, то изменение положения 
штампа приводит к смещению места копирования эталонного фрагмента. При 
работе с отключенной опцией точка отбора пробы не сдвигается; 

10. Sample (Образец). Служит для указания слоя или слоев, используемых для 
отбора проб. Самая ходовая опция этого списка - Current Layer (Текущий 



слой). При отборе пробы в этом режиме учитывается только текущий слой, а 
графические данные остальных отбрасываются; 

11. Включает и выключает режим учета нижележащих корректирующих слоев. 

Важно помнить, что штамп не работает на корректирующих слоях. Он способен 
обрабатывать изображение только на изобразительных слоях. 

Ретушь поврежденной фотографии клонирующим штампом 

Существует значительное количество ситуаций, в которых применение 
инструмента Clone Stamp оказывается оправданным и продуктивным. Чаще 
всего его используют для исправления старых фотографий, поврежденных в 
результате длительного или ненадлежащего хранения. Именно такой пример 
показан на рис. 7.2. Это сканированная старая фотография со значительными 
дефектами фона. 

 
 
Рис. 7.2. Пример поврежденной фотографии 
1. Будем считать, что снимок загружен в редактор. Выберем инструмент Clone 

Stamp (S). 
2. Увеличим масштаб изображение примерно до 200% (Ctrl+плюс) и сделаем 

видимым левый скол, расположенный у самого края снимка. Для эффективной 
работы с штампом очень важно задать правильный масштаб изображения. 
Если он невелик, то оператор рискует пропустить дефекты небольшого 
размера. При чрезмерном увеличении возможны ошибки иного рода. Детали 
микроструктуры изображения легко принять за артефакты. В большинстве 
случаев рациональный масштаб обрабатываемого штампом изображения 
лежит в диапазоне от 100 до 400%/ 



3. Сделаем неактивной опцию Aligned (Выравнивание). Это значит, что область 
взятия пробы не будет смещаться вместе с кистью инструмента. Значение 
параметра Sample (Образец) не имеет значения, поскольку выбранное 
изображение состоит из одного слоя. 

4. Выберем мягкую кисть, размеры которой сравнимы с габаритами дефекта. В 
нашем случае обработка скола проводилась кистью в 21 пиксел. Удерживая 
клавишу Alt, щелкнем по исправной области фона, расположенной в 
непосредственной близости от обрабатываемого фрагмента. 

Этот технический прием служит для выбора донорской области. Во всех своих 
применениях, до следующего отбора пробы, штамп будет заимствовать 
данные из выбранной области. В нашем случае, для этих целей лучше всего 
подходит фон, расположенный над сколом. После выбора эталонной области 
нанесем несколько коротких мазков по верхней части поврежденного 
фрагмента. 

Результативность операции клонирования зависит в первую очередь от 
правильного выбора донорской области. В общем случае, следует учитывать 
все характеристика донора и реципиента: цвет, тон, распределение теней, 
микрорисунок и др. Только в случае совпадение или близости этих свойств 
можно рассчитывать на успех предприятия. Для получения хорошего 
результата требуется много раз менять прицел клонирующего штампа. 
Типичная ошибка начинающих - это попытка обработать область 
значительных размеров, заимствуя данные из одной точки. 

5. Меняя точку отбора пробы и жесткость кисти, заделаем левый скол 
фотографии (рис. 7.3). Напомним, что оперативное управление жесткостью 
кисти выполняется при помощи: Shift+[ (уменьшение жесткости) 
и Shift+] (увеличение жесткости). 



 
 
Рис. 7.3. Исправление левого скола 

6. Техника удаления остальных дефектов на фоне фотографии не имеет никаких 
особенных отличий от описанной. Вся разница ограничивается размерами 
кистей инструмента и выбором донорской области. Возможные ошибки 
клонирования можно исправить при помощи палитры History или 
посредством клавиатурного сочетания Ctrl+Alt+Z. Будем считать, что 
задача удаления всех дефектов фона успешно решена. 

7. Ликвидируем круглое пятно на лбу мужчины. Операцию будем проводить 
мягкой кистью размером 20 пикселов. Возьмем пробу над бровью слева от 
пятна и один раз щелкнем по дефекту. Пятно пропадет, но обработанный 
фрагмент получит слишком большую яркость, заметную на фоне серых точек 
окружения. 

8. Выберем инструмент Burn (Затемнитель), на панели свойств 
установим Exposure=10% и нанесем несколько коротких мазков по области 
избыточного осветления. В результате дефект будет полностью ликвидирован 
и замаскированы последствия его обработки. 

9. Осталось убрать несколько пятен на правой стороне рубашки. Одно из них, 
которое расположено на воротнике, удаляется обычным образом, 
однократным щелчком клонирующего штампа. Второе пятно стоит на границе 
рубашки и пиджака, что несколько осложняет задачу. Можно ликвидировать 
его в два приема. Сначала заимствовать данные из рубашки, затем перенести 
на правую часть пятна фрагменты костюма. Это возможный, но 
нерациональный путь. Поступим иначе. Выберем жесткую кисть в 20 пикселов 
и отберем пробу прямо на границе между рубашкой и пиджаком (рис. 7.4). 
После этого достаточно одного точного щелчка для полного удаления этого 
дефекта. 



 
 
Рис. 7.4. Отбор граничного образца 

10. В результате предпринятых действий изображение приведено в состояние, 
которое можно назвать "предпродажным". Для завершения работы осталось 
поправить граничные области, которые Ничто не мешает обработать штампом 
граничные фрагменты изображения точно так же, как мы ликвидировали 
пятна и сколы. Но есть более рациональный способ. Выберем 
инструмент Crop (Рамка) и растянем рамку, размеры и положение которой 
намечают будущую форму фотографии. Если это не удалось с первого раза, 
то боковые маркеры рамки позволяют уточнить положение и форму рамки. 
Нажатие клавиши Enter заканчивает работу с инструментом обрезания (рис. 
7.5). 



 
 
Рис. 7.5. Изображение до и после обработки 

Использование клонирующего штампа. Модифицированная методика 

Рассмотрим простую методику работы со штампом, отличающуюся от стандартной 
более высокой устойчивостью к ошибкам. 



 
 
Рис. 7.6. Поврежденный снимок 

Состояние фотографии, показанной на рис. 7.6, далеко от идеала. Масштабный 
скол, проходящий через весь снимок - это самое заметное повреждение примера. 
Он затрагивает самые чувствительные области лица, поэтому исправление этого 
дефекта потребует значительных усилий. Менее критичные повреждения 
эмульсионного слоя расположены в верхнем левом и нижнем правом углах 
фотографии. Их исправление не требует высокого мастерства и доступно 
начинающему ретушеру. С них и следует начать процедуру исправления снимка. 

1. Выведем на экран палитру Layers (F7) и создадим новый слой. Для этого 
достаточно щелкнуть по кнопке Create a new layer (Создать новый слой), 
расположенной в нижней части палитры или воспользоваться комбинацией 
клавиш Ctrl+Shift+N. 

2. Выберем инструмент Clone Stamp. Вызов инструмента поддержан горячей 
клавишей - S. 

3. На панели Options (Панель свойств), расположенной в верхней части окна 
программы, зададим параметры инструмента. Размер кисти будет меняться 
динамически в процессе клонирования. Эту задачу в программе выполняют 
две клавиши [ и ] (открывающая и закрывающая квадратные скобки). Режим 
наложенияNormal следует оставить. Непрозрачность Opacity равна 100 
процентам. Опция Aligned (Выравнивание) включена в большинстве 



ситуаций. Самая важная настройка - это опция Sample = All Layers (Все 
слои). Ее надо включить, чтобы штамп получил способность переносить 
графическую информацию с одного слоя на другой. 

4. Не снимая пометки с нового слоя, и чередую отбор проб и рисование 
штампом, обработать все дефектные области фотографии. Напомним, что 
взятия образца выполняется по щелчку мыши при нажатой клавише Alt. 

 
 
Рис. 7.7. Состояние дополнительного слоя 

На рис. 7.7 показано изображение дополнительного слоя; на нем изображаются 
все клонирующие мазки штампом, которые пришлось сделать в процессе ретуши 
примера этого раздела. 

В чем заключаются преимущества данной методики по сравнению со стандартной 
техникой работы с клонирующим штампом? Мазки клонирующей кисти 
переносятся не на оригинал, а накладываются на дополнительный слой. Любое 
неудачное действие можно отменить простым стиранием с этого слоя. Данный 
способ не знает тех ограничений на глубину отката, которые сильно ограничивают 
область применения палитры History (История). Сам результат обработки 
приведен на рис. 7.7. 



 
 
Рис. 7.7. Изображение, обработанное клонирующей кистью 

Наверное, каждому пользователю программы знакома ситуация, когда небрежное 
применение инструмента или работа штампом с некорректными установками 
порождает новые дефекты. Они могут проявляться в виде монтажных швов, 
некоторого регулярного узора, пограничных зон на стыке областей с различными 
текстурами тоном или цветом. Некачественное клонирование по своим 
последствиям напоминает небрежно наложенный макияж, т.е. лекарство 
оказывается хуже болезни. 

Какие же рецепты можно предложить в подобной ситуации? Лучшее лечение - это 
профилактика: не следует допускать появления вторичных артефактов. Рецепты 
корректной работы общеизвестны - это тщательная настройка инструмента Clone 
Stamp, точный выбор донорских областей, подбор кисти оптимальной в данной 
ситуации. Кроме того, перед обработкой критических областей следует провести 
пробные мазки и эксперименты с настройками. 

В некоторых случаях скрыть стыковочные швы удается посредством аккуратной 
обработки инструментов Smudge (Палец). Обработка фильтрами размытия и 
внесение дозированного шума могут замаскировать или полностью удалить 
вторичные артефакты. Если клонирующие мазки отделены от основного 



изображения и находятся на отдельном слое, то пользователю предоставляется 
большая свобода в применении соответствующих фильтров. 

Результативность операции клонирования зависит от множества факторов: опыта 
ретушера, наличия подходящего донорского материала, характера повреждений, 
настроек инструмента Clone Stamp и пр. Одним из важнейших условий 
правильного клонирования является выбор кисти и ее настройка. Если 
изображение отмечено массивными и глубокими повреждениями, то для его 
успешной реставрации часто приходится создавать новую кисть. 

Длинные царапины механического происхождения часто своей формой 
приближаются к прямым линиям, по крайней мере на участках значительной 
протяженности. Для обработки таких дефектов инструментом Clone 
Stamp можно использовать небольшую техническую хитрость. Будем считать, что 
выбран донорский фрагмент и отобрана проба. Для обработки штампом прямой 
линии следует щелкнуть инструментом в стартовой точки прямой, затем, 
удерживая клавишу Shift, выполнить повторный щелчок по конечной точке. 

Инструмент Healing Brush 

Долгое время набор инструментов программы, предназначенных для технической 
ретуши, был весьма ограниченным. В него входили клонирующий штамп, для 
которого удаление дефектов является штатной функцией, и некоторые 
инструменты, у которых ретушь была второй, побочной "специальностью". 
Разработчики пакета, столь изобретательные в создании новаторских средств 
обработки растровых изображений, отказывались признавать ограниченность 
потенциала инструмента Clone Stamp. Ситуация кардинально изменилась с 
выходом седьмой версии редактора. Он пополнился сразу двумя новыми 
средствами Healing Brush(Восстанавливающая кисть) и Patch (Заплатка), 
предназначенными для технической ретуши. Несколько позднее арсенал 
программы обогатился еще одним средством ретуши - 
инструментом Spot Healing Brush (Точечная востанавливающая кисть). Все 
эти средства обладают некоторой "интеллектуальностью". В частности, 
восстанавливающая кисть анализирует исправляемый фрагмент и настраивает 
прозрачность, освещенность и текстуру "заплатки" так, чтобы получить безшовное 
соединение. 

Основные положения 

Для выбора восстанавливающей кисти следует нажать кнопку, расположенную в 
левом ряду инструментальной панели на четвертой сверху позиции, или 
воспользоваться клавишей J. Большинство настроечных параметров кисти, как и 
обычно, расположены на панели свойств. В основном это уже хорошо известные 
настройки кисти штампа. Требует пояснений только настройки раздела Source. 
Если выбрана опция Sampled, то образец для исправления дефекта указывается 
пользователем. В противном случае донорские фрагменты заимствуются из 
некоторой библиотечной текстуры (Pattern). 



 
 
Рис. 7.9. Настройки восстанавливающей кисти 

На первый взгляд техника работы с восстанавливающей кистью напоминает 
использование клонирующего штампа. Это известное сочетание отбора донорских 
фрагментов и переноса их на поврежденные области изображения. Более 
внимательное изучение инструмента открывает несколько существенных отличий. 

• Восстанавливающая кисть - это средство, обладающее элементами 
интеллектуальности. Если штамп механически переносит донорские фрагменты 
на поврежденные, то кисть учитывает различные параметры источника и цели и 
на их основе формирует клонирующий мазок. Набор анализируемых параметров 
достаточно велик. Кисть принимает во внимание освещенность, цвет, яркость и 
текстуру областей, что позволяет добиваться хороших результатов для самых 
тяжелых повреждений. Несколько упрощая существо дела, можно считать, что 
она берет из донорской зоны только текстуру и добавляет к ней цвет и тон 
целевой области. 

• Восстанавливающая кисть является полуавтоматическим средством ретуши, по 
этой причине она располагает сокращенным набором настроечных параметров. 
Самые заметные ограничения - это урезанный состав режимов наложения. Если 
для штампа доступны все 23 режима, предусмотренных в программе для кистей, 
то восстанавливающая кисть может использовать только восемь. 

• Подобно любому средству рисования восстанавливающая кисть может 
накладывать короткие и длинные мазки. Если рисовать этим инструментом, не 
отпуская кнопку мыши, то результат сначала будет подобен применению 
клонирующего штампа. Только после освобождения левой кнопки мыши 
сработает интеллектуальный алгоритм обработки, который подгонит мазок кисти 
под цвет и тон окружающих фрагментов. Эта подгонка требует времени на 
выполнение всех необходимых расчетов. Задержка, необходимая программе на 
выполнение постобработки, особенно заметна на слабых компьютерах. 

• Инструмент Healing Brush может работать только с самыми простыми кистями, 
Ему недоступно в полном объеме то разнообразие настроечных параметров, 
которые предлагают последние версии программы для рисующих кистей. 

• Следует еще раз упомянуть об особенностях выбора донорских областей для 
инструмента Healing Brush. Строение или, как часто говорят в компьютерной 
графике, текстура - это самая важная характеристика фрагмента, выбранного для 
клонирования. Если текстура донорской области удачно аппроксимирует 
микроструктуру поврежденного фрагмента, то успех операции можно считать в 
значительной степени обеспеченным. 

• Программа почти не знает ограничений на выбор донорских областей. 
Подходящие фрагменты могут находиться даже в другом изображении с 
отличной цветовой моделью, размерами и разрешением. Для получения 
логичных и предсказуемых результатов целесообразно выбирать изображения с 
одинаковыми базовыми параметрами. 

• Опыт показывает, что инструмент Healing Brush дает лучшие результаты при 
использовании жестких кистей небольшого размера. Габариты кисти должны 



немного превышать размеры дефекта. Короткие мазки имеют преимущество 
перед длинными в большинстве случаев. 

• Если для клонирующего штампа изменение "прицела" - это обязательное условие 
успеха, то восстанавливающая кисть не нуждается в постоянной настройке 
донорской области. Очень часто хороших результатов можно добиться, 
использую только один донорский фрагмент. 

• Инструмент не имеет обычной для всех прочих кистей настройки прозрачности. 
Это ограничение можно отчасти снять посредством специальной 
команды Fade Healing Brush (Ослабить восстанавливающую кисть). Чтобы 
уменьшить интенсивность действия кисти надо сразу после ее применения 
выполнить командуEdit => Fade Healing Brush (Ctrl+Shift+F). В 
результате на экран будет выведено простое окно с регулятором настройки 
прозрачности. Таким способом можно изменить интенсивность только самого 
последнего применения восстанавливающей кисти. Намного более полный 
контроль дает создание дублирующего слоя. Меняя его прозрачность, можно 
регулировать интенсивность всех исправляющих мазков, наложенных на 
дубликат. 

• Восстанавливающая кисть не очень удачно справляется с ретушью областей, 
имеющих резкие перепады тона и высокую контрастность. Данный недостаток не 
является ошибкой разработчиков: он вытекает из самого принципа действия 
инструмента. Для коррекции дефектов такого рода лучше обратиться к 
инструменту Clone Stamp или предварительно тщательно выделить 
поврежденный фрагмент. В этом случае редактор не будет учитывать 
характеристики областей, расположенных за пределами выделения. 

Удаление морщин восстанавливающей кистью 

Рассмотрим использование восстанавливающей кисти на традиционно трудном 
для ретушеров объекте, коим является человеческое лицо (рис. 7.10). 

 
 
Рис. 7.10. Исходное состояние ретушируемой фотографии 



1. Будем считать, что графический файл, хранящий изображение, открыт в 
программе. Создадим дубликат фонового слоя. Для этого достаточно 
перетащить пиктограмму единственного слоя картинки на кнопку Create a 
new layer (Создать новый слой) палитры Layers (Слои). Дублирование слоя 
- это не только вполне оправданная мера предосторожности, меняя 
прозрачность нового слоя можно управлять интенсивностью применения 
инструмента Healing Brush. 

2. Выберем восстанавливающую кисть. Для этого можно воспользоваться 
специальной кнопкой инструментальной панели или просто нажать 
клавишу J. 

3. Установим жесткую кисть, диаметр которой сопоставим с шириной морщин (в 
нашем примере пять пикселов), активизируем радиокнопку Sampled (По 
образцу) и снимем пометку с переключателя Aligned (Выравнивание). 

4. Успех операции во многом зависит от правильного выбора донорской области. 
Для исправляющей кисти особое значение имеет ее текстура, а цвет и тон 
можно считать второстепенными параметрами. Для маскирования носовых 
складок хорошо подойдут соседние участки скул. Возьмем образец донорской 
области при помощи щелчка мышкой при нажатой клавише Alt. Не меняя 
"прицела", нанесем несколько коротких последовательных мазков сначала на 
одну носовую складку, затем на другую. 

5. Для исправления резких морщин на подбородке подойдут соседние 
фрагменты щек. Выберем участок со средней интенсивностью волосяной 
поросли, возьмем пробу и перенесем ее на обе кожные складки подбородка. И 
в этом случае нет необходимости в изменении донорской области. 

Результат предпринятой косметической операции показан на рис. 7.11. 

 
 
Рис. 7.11. Исправленный снимок 



Восстанавливающая кисть - это сравнительно новое средство, техника работы с 
инструментом находится в процессе становления. Еще не создан его подробный 
"технический паспорт". 

Из всего изложенного можно сделать вывод о том, что инструменты Clone Stamp и 
Healing Brush - это средства одного целевого назначения, что с необходимостью 
поднимает вопрос о целесообразности присутствия штампа в арсенале программы. 
Ветерана рано списывать в запас. Есть задачи, с которыми он справляется лучше 
"амбициозного новичка". Например, клонирование поврежденных областей 
больших размеров, обработка дефектов с высокой контрастностью. Это средство 
незаменимо во всех случаях, когда техника клонирования используется для 
решения специальных художественных задач, например создание точных копий 
объектов. 

Инструмент Patch 

Инструмент Patch (Заплатка) - это полуавтоматическое средство технической 
коррекции с интеллектуальной обработкой поврежденных областей. В основе 
принципа действия этого средства лежат одинаковые с восстанавливающей 
кистью приемы обработки графической информации. С помощью этого средства 
можно быстро исправить поврежденные фрагменты большого размера и сложной 
текстуры. 

Базовая техника 

Данная новинка, которая впервые появилась в седьмой версии пакета, 
заслуживает самой высокой аттестации. Оно демонстрирует редкое сочетание 
эффективности и технической простоты. Для удаления артефакта надо построить 
выделение дефекта, и перетащить его инструментом Patch с донорского на 
поврежденный фрагмент или в обратном направлении. Как и для исправляющей 
кисти при выборе донора следует в первую очередь принимать во внимание 
текстуру областей. Программа самостоятельно настроит цвет и тон заплаты после 
клонирования. 

Для активизации инструмента Patch служит кнопка, расположенная в одном 
разделе инструментальной панели с исправляющей кистью. Для быстрого вызова 
можно воспользоваться клавишей Shift+J. 

 
 
Рис. 7.12. Настройки инструмента Patch 

Средство отличается высокой степенью автоматизма, поэтому имеет очень мало 
настроек. Как и обычно все они расположены на панели свойств (рис. 7.12): 

• Source (Источник). Радиокнопка, управляющая порядком указания донорской и 
поврежденной областей. Если она активизирована (по умолчанию), то 



используется прямой порядок работы инструмента. Сначала следует выделить 
исправляемый фрагмент, а затем перетащить выделение на донорскую область; 

• Destination (Назначение). Радиокнопка меняет режим работы инструмента. В 
случае ее выбора последовательность выполнения операций становится 
противоположной. Сначала надо любым удобным способом выделить донорскую 
область, а затем инструментом Patch перетащить ее на поврежденную; 

• Transparent (Прозрачность). Включает режим извлечения образца из 
окружающего фона. Дает хорошие результаты для случаев, когда образец 
окружает однородный фон или мягкий градиент; 

• Use Pattern (Использовать узор). Служит для выбора текстуры, которая, в этом 
случае, выполняет функции донорской области. 

Рассмотрим работу с инструментом на примере изображения, показанного на рис. 
7.13. Исправление такого дефекта традиционными средствами потребовало бы от 
оператора значительных усилий. Оперение орла - это область с ярко выраженной 
структурой, поэтому любая неточность выбора донорской области или 
погрешности совмещения будут хорошо заметны на ее фоне. 
Инструмент Patch дает простое решение этой проблемы. 

 
 
Рис. 7.13. Изображение с масштабными повреждениями 

1. Будем считать, что изображение загружено в программу. Построим выделение 
поврежденной области (рис. 7.14). Для этого можно использовать любой 
штатный инструмент выделения (в данном случае удобнее работать с лассо) 
или сам инструмент Patch. 



 
 
Рис. 7.14. Выделение поврежденной области 

2. Проведем визуальный осмотр изображения и попытаемся определить область, 
которая напоминает поврежденный фрагмент своей геометрией и текстурой. 
Если не рассматривать возможные, но экзотические варианты заимствования 
из сторонних источников, то выбор оказывается невелик. Подходящая область 
расположена левее дефекта. 3. Выберем инструмент Patch. Для этого 
достаточно несколько раз подряд (не более двух) нажать Shift+J. Число 
настроек инструмента невелико и все они расположены на панели свойств. 
Установим радиокнопку Source (Источник), которая обычно выбирается по 
умолчанию. 



 
 
Рис. 7.15. Смещение выделенной области 

3. Зацепим инструментом выделенную область и перетащим ее на ту часть 
изображения, которая выбрана для клонирования (рис. 7.15). Как только 
будет отпущена левая кнопка мыши, произойдет маленькое чудо. Эталонная 
область будет скопирована в выделение и созданная заплата будет наложена 
на поврежденный фрагмент. Интеллектуальная постобработка программы 
изменит заплатку таким образом, чтобы ее тон и цвет соответствовали новому 
окружению (рис. 7.16). 

Упоминание чуда в описании технического средства - это не преувеличение. 
Первое успешное применение инструмента оставляет ощущение фокуса, который 
был мастерски проделан у вас на глазах невидимым и искусным 
престидижитатором. 



 
 
Рис. 7.16. Обработанное изображение 

Техника применения инструмента настолько проста, что почти полностью 
исчерпывается рассмотренным примером. Приведем несколько дополнительных 
соображений: 

• Для создания выделения можно использовать любые средства и методики, 
которыми располагает программа для решения подобных задач. В том числе 
режим быстрой маски и любые комплексные способы построения сложных масок. 
Искомое выделение должно немного превосходить размеры дефектной зоны. 

• Обработка областей небольшого размера дает лучшие результаты, нежели 
разовая ретушь фрагментов больших габаритов. 

• Необходимое выделение можно создать и посредством самого 
инструмента Patch, но его использование в этой роли не дает никаких 
преимуществ по сравнению со специализированными средствами программы. 

Усовершенствованная методика 

Способ технической ретуши, рассмотренный в данном разделе, удачно сочетает в 
себе автоматизм инструмента Patch и возможность контроля ключевых операций 
процедуры. В качестве примера выберем изображение, показанное на рис. 7.17. 

 



 
Рис. 7.17. Пример сильно текстурированной поверхности 

Это отсканированный кусок трикотажной ткани с заметным повреждением в его 
средней части. Исправление областей с рельефной текстурой (пример которой 
дает выбранный образец) - это нетривиальная задача даже для самых искусных 
ретушеров. Малейшая неточность мазка клонирующего штампа или погрешность 
совмещения заплаты и дефекта приведет к нарушению узора, и будут мгновенно 
распознаны наблюдателем. Особенность предлагаемой методики состоит в том, 
что донорская область превращается в плавающий объект, положение и размеры 
которого допускают настройку. Толь ко после тщательной подгонки размеров и 
положения виртуальная заплатка ставится на место. 

1. Проведем осмотр изображения и найдем подходящий донорский фрагмент. 
Эта обязательная в общем случае операция в нашем примере допускает 
произвольное решение, поскольку любая неповрежденная часть материала 
способна послужить образцом. Выберем инструмент Lasso (L) и построим 
выделение выбранной области, как показано на рис. 7.17. 

 
 
Рис. 7.17. Выбор донорской области 

2. Активизируем инструмент Patch (J). В данной ситуации инструмент должен 
работать в режиме Destination. Удерживая клавиши Ctrl+Alt, перетащим 
построенное выделение на поврежденный фрагмент. Эта операция переводит 
виртуальную заплату в плавающее состояние. Она не сливается с фоновым 
слоем, а накладывается на него. Фактически выделенный фрагмент 
превратится во временный слой, который не регистрируется в 
палитре Layers. 

3. После того, как заплата будет поставлена на место, освободим 
клавиши Alt и Ctrl. Воспользуемся комбинацией Ctrl+T для активизации 
команды свободного деформирования. результате появится рамка и 
манипуляторы команды свободного деформирования (рис. 7.19). 

4. Используя манипуляторы свободного трансформирования, выполним точную 
настройку размеров и положения заплатки. Для нашего примера 
потребовалось выполнить небольшой поворот и слегка увеличить ее размеры. 
Чтобы закончить работу с командой и применить выполненные 
преобразования достаточно нажать клавишу Enter. В результате 



трансформационная рамка исчезнет, на экране останется граница выделения, 
а инструмент Patch сохранит свою активность. 

 
 
Рис. 7.19. Трансформация виртуальной заплатки 

5. Переведем курсор мыши внутрь помеченной области и слегка сдвинем 
заплатку. Эта операция нужна не для дальнейшей настройки донорской 
области; она просто запускает механизм постобработки графической 
информации инструмента Patch. Размеры сдвига должны быть 
минимальными, в идеале это смещение на один пиксел. Результаты обработки 
текстурированной поверхности показаны на рис. 7.20. 

 
 
Рис. 7.20. Исправленное изображение 

Обработка областей с высокой контрастностью 

Общение с инструментом Patch оставляет ощущение неограниченных 
возможностей этого средства. Кажется, что это своеобразная волшебная палочка 
ретушера и ему по силам любая задача технической ретуши. Но у любого 
технического средства есть своя область рационального применения. Так техника 
виртуальной заплатки плохо работает на областях с высокой контрастностью. При 
исправлении дефекта алгоритмы постобработки инструмента Patch учитывают 
цветовые и тоновые характеристики окружения дефектной области. Если 
поврежденная зона и ее окрестность имеет значительные различия по тону или 
цвету, то результат наложения виртуальной заплатки может быть весьма далеким 



от идеала. В подобных случаях неплохое решение проблемы может дать 
комбинированная обработка инструментами Clone Stamp и Patch. 

На рис. 7.21 показан любительский снимок со значительным повреждением 
эмульсионного слоя в верхней части. Это пример дефекта с высокой 
контрастностью поврежденной области и фона. Попробуем ликвидировать дефект 
инструментом Patch. 

 
 
Рис. 7.21. Пример фотографии 

1. Попытаемся решить задачу "в лоб", при помощи наложения виртуальной 
заплатки. При помощи лассо обведем поврежденный фрагмент (см. рис. 7.22), 
затем выберем инструмент Patch (наложение заплатки в этом случае 
выполняется в режиме Source) и перетащим его на ту часть фона, которая 
расположена ниже и левее дефекта. 



 
 
Рис. 7.22. Выделение дефекта 

Результат, показанный на рис. 7.23, разочаровывает. В данном случае 
интеллектуальная обработка инструмента сработала со значительными 
ошибками. 

 
 
Рис. 7.23. Результат наложения заплатки 

2. Отменим результаты применения инструмента Patch (Ctrl+Z) и снимем 
выделение (Ctrl+D). Строго говоря, эти действия являются 
необязательными, последующие шаги методики дадут такие же результаты, 
даже если продолжить работу без отмены последствий наложения заплатки. 

3. Активизируем инструмент Clone Stamp (S), выберем кисть достаточно 
больших размеров (примерно 40 пикселов), удерживая клавишу Alt, пометим 
донорскую область и обработаем штампом артефакт. При этом нет 
необходимости стремиться к получению результата отличного качества. 



Работа со штампом - это подготовительное мероприятие перед применением 
средства Patch (рис. 7.24). 

 
 
Рис. 7.24. Подготовительная обработка дефекта штампов 

4. Снова построим выделение обрабатываемой области, выберем 
инструмент Patch и перетащим выделение на протяженный участок фона, 
расположенный ниже и левее дефекта. После освобождения левой кнопки 
мыши большая часть фрагмента будет успешно исправлена, но даже после 
предварительной подготовки инструмент не дал исчерпывающего решения 
задачи. На сколе остались заметны некоторые нарушения однородности 
белого цвета, впрочем, довольно слабо выраженные. 

5. Повторим операцию еще раз без изменения настроечных параметров и 
донорской области. Повторное наложение виртуальной заплатки полностью 
решает проблему. Результат обработки показан на рис. 7.25. 



 
 
Рис. 7.25. Обработанная фотография 

Ключевые термины 

Артефакт - любые дефекты изображения искусственного, внешнего 
происхождения. Для цифровых фотографий это, прежде всего, следы пыли, 
царапины, различные текстуры и узоры, возникающие при сканировании печатных 
оригиналов, зернистость фотопленки, перенесенная при оцифровке, и пр. 

Инструмент Clone Stamp (Штамп) - корректирующий инструмент с полностью 
"ручным" управлением. Основан на переносе донорских фрагментов, которые 
выбираются оператором, на поврежденный оригинал. 

Инструмент Healing Brush (Восстанавливающая кисть) - корректирующий 
инструмент с интеллектуальной постобработкой клонированных фрагментов. 
Переносит указанные пользователем области на оригинал, затем подгоняет 
клонированный фрагмент под окружение, учитывая текстуру, освещенность, 
прозрачность и затененность соседних пикселов. 

Инструмент Patch (Заплатка) - корректирующий инструмент с интеллектуальной 
постобработкой клонированных фрагментов. Учитывает текстуру, освещенность, 
прозрачность и затененность окружающих пикселов и автоматически подгоняет 



параметры клона под оригинал. Используется для исправления больших 
фрагментов изображения. 

Инструмент Spot Healing Brush (Точечная восстанавливающая кисть) - 
корректирующий инструмент с интеллектуальной постобработкой клонированных 
фрагментов. Упрощенная версия инструмента Healing Brush, не требующая 
указания донорских фрагментов, которые программа самостоятельно заимствует 
из ближайшего окружения дефекта. Применяется для обработки артефактов 
небольшого размера. 
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Размытие - это очень распространенный и эффективный метод борьбы с 
артефактами, который имеет в редакторе несколько различных технических 
оформлений. Если усреднить тоновые уровни (яркости) в некоторой 
фиксированной окрестности изображения, то характеристики соседних 
точек сблизятся, и дефектные пикселы мимикрируют или полностью 
сольются со своим окружением. 

Принцип размытия лежит в основе многих технических средств программы. 
Достаточно назвать инструмент Blur (Размытие) и шесть фильтров раздела 
главного меню с тем же названием. Непосредственное применение средств 
размытия к поврежденным фрагментам часто не приводит к успеху, поскольку 
вносит сильные искажения в оригинал. Практика цифровой ретуши выработала 
несколько эффективных приемов, позволяющих локализовать область 
действия инструментов размытия. В этом разделе рассмотрим несколько методик 
такого типа. 

Размытие дефектов инструментом Blur 

Использование инструмента Blur для устранения дефектов - это технически 
очень простой способ ретуши, не потерявший своего значения и в наше время, 
когда повсеместное распространение получили корректирующие слои, внешние 
дополнения (plugins) и различные ухищрения с палитрой History. 

Для вызова инструмента надо нажать кнопку Blur на панели инструментов. Этот 
инструмент представляет собой кисть, но не рисующую, а выполняющую размытие 
обрабатываемых фрагментов. Настройки этого средства показаны на рис. 8.1. 
Единственный новый параметр, который не встречался ранее при описании кистей 
иного типа, - это Strength (Интенсивность). Он задает силу размытия. 



 
 
Рис. 8.1. Настройки инструмента размытия 

На рис. 8.2 показана полутоновая фотография с хорошо заметными дефектами 
механического происхождения. Это длинная белая царапина в левой части 
снимка, очевидно механического происхождения, и множество точек черного 
цвета и неведомой природы на правом рукаве свитера. 

 
 
Рис. 8.2. Пример фотографии с множественными повреждениями 

Все эти дефекты допускают обработку клонирующим штампом, но этот инструмент 
очень обязывающее средство. Интенсивная работа со штампом часто вносит в 
изображения вторичные артефакты, вызванные неверно выбранными установками 
или неподходящими донорским областями. Рассмотрим более щадящий способ 
технической ретуши. 

1. Выведем на экран палитру Layers (F7) и добавим к оригиналу новый слой 
Эта простая операция не раз обсуждалась в предыдущих разделах. Напомним, 
что для этого достаточно щелкнуть по кнопке Create a new layer (Создать 
новый слой), расположенной в нижней части палитры слоев, или 
воспользоваться сочетанием клавиш (Ctrl+Shift+N). Вновь созданный слой 
не содержит совершенно никакой графической информации. 

2. Выберем инструмент Blur (Размытие). Быстрый вызов инструмента 
выполняется посредством клавиши R. Напомним, что это кисть, которая не 
рисует, а выполняет локальное размытие обрабатываемых фрагментов. 

3. Начнем исправление оригинала с удаления черных точек на рукаве. На 
панели Options активизируем опцию Sample All Layers (Использовать 
все слои), выберем режим наложения Mode = Lighten (Осветление) и 
зададим половинный нажим кисти Strength = 50%. 

4. Выберем такой масштаб, при котором все артефакты будут хорошо различимы 
и подберем подходящий размер кисти. Ее габариты должны иметь размеры, 
сопоставимые с темными точками и немного превышать их (примерно 9 
пикселов). 



5. Обработаем инструментом Blur все посторонние включения черного цвета на 
правом рукаве. Несмотря на то, что фон имеет сложный и ясно выраженный 
рисунок, операция увенчалась полным успехом. Даже самый искусный 
оператор не смог повторить его, работая в данной ситуации со штампом (рис. 
8.3). 

 
 
Рис. 8.3. Удаление дефектов на рукаве 

6. Уберем белую полосу в левой верхней части изображения. Обработаем ее тем 
же средством, предварительно изменив режим 
наложения на Darken (Затемнение). Все остальные опции инструмента можно 
не менять. 

 
 
Рис. 8.4. Отретушированное изображение 

Ретушь снимка потребовала кропотливого труда, но результат вполне 
оправдывает затраченные на него усилия. На рис. 8.4 показано финальное 
состояние фотографии. 

Использование слоя в этой методике - это дополнительная подстраховка от 
ошибочных или неосторожных действий ретушера. Все недопустимые искажения, 
внесенные в оригинал, можно удалить простым отключением видимости 
дополнительного слоя или его удалением. 



Самая большая опасность этой методики - это чрезмерное размытие отдельных 
фрагментов. Эту ситуацию легко идентифицировать по появлению характерных 
сгустков, отдаленно напоминающих комочки спекшегося стекла. Ту норму, которая 
убирает посторонние частички и не приводит к драматической потери резкости, 
можно найти только путем проб и ошибок. 

Размер кисти инструмента Blur - это важнейшая настройка процедуры удаления 
артефактов. От правильного выбора этого параметра во многом зависит успех 
всей процедуры. Напомним, что в программе существуют специальные клавиши, 
позволяющие менять размер рисующей кисти на лету, не обращаясь к 
специальным палитрам или командам. Нажатие клавиши [ (левая квадратная 
скобка) уменьшает размер кисти, а ] (правая квадратная скобка его увеличивает. 

Размытие дефектов фильтрами 
Cпособ исправления дефектов, рассмотренный в начале раздела являются 
инструментальным. Как и для любого виртуального инструмента, каждое 
применение ручного размытия требует волевого импульса оператора. Высокая 
квалификация исполнителя и щадящая норма выработки - вот необходимые 
условия успешной работы любого универсального средства производства. В этом 
смысле цифровая ретушь полностью подтверждает эту всеобщую закономерность. 
Представьте себе, какого объема работу требуется проделать, чтобы штампом 
привести в надлежащее состояние изображение, на оцифрованный вариант 
которого сканердобросовестно перенес все ворсинки бумажного оригинала. Мысль 
о неизбежности этой процедуры способна сокрушить самую оптимистичную и 
стойкую натуру. 

Кроме ручных инструментов в арсенал программы входят 
многочисленные средства массового действия, основанные на 
применении алгоритмов преобразования. Они называются фильтрами. 

Фотография, показанная на рис. 8.5, - это снимок очень неплохого качества, 
выполненный, видимо, в студийных условиях. Тщательный осмотр выявил у 
снимка только один заметный недостаток - шум, равномерно рассеянный по всему 
полю изображения. Видимо, появление этого множества мелких и хаотично 
распределенных точек разного цвета вызвано общей причиной. Можно 
предполагать, что таковой является неисправность сканирующего устройства. 
Известно, что сканеры цифровые камеры невысокого класса имеют меньшую 
чувствительность в синей области спектра, поэтому часто вносят искажения в 
соответствующий канал изображения. 



 
 
Рис. 8.5. Пример зашумленного изображения 

Исследуем отдельные каналы цифровой фотографии. Напомним, что канал - это 
полутоновая версия изображения, описывающая вклад отдельной 
цветовой координаты. Например, канал красного цвета показывает, как будет 
выглядеть изображение, если отключить подачу зеленого и синего цвета, а 
интенсивность красного представить различной плотностью серого тона. 

Штатным средством работы с каналами в программе является 
палитра Channels (Каналы), которая выводится на экран по команде Window => 
Channels (Окно => Каналы). 

 
 
Рис. 8.6. Вид отдельных каналов 



Просмотр каналов поддержан горячими клавишами. Для этого достаточно 
воспользоваться комбинацией Ctrl+#, где # - это номер канала в названии 
модели плюс 2. Например, для изображения в системе RGB вызов канала синего 
цвета (третьего) выполняется по нажатию Ctrl+5. Полноцветное, или как иногда 
говорят композитное, изображение вызывается клавиатурным 
сочетанием Ctrl+2. Проверка фотографии полностью подтверждает 
предположение - канал синего цвета имеет заметный шум искусственного 
происхождения (рис. 8.6). 

Рассмотрим две методики использования размывающих фильтров для удаления 
артефактов. В первой из них фильтр применяется непосредственно к каналу. Это 
операция вполне допустима в тех случаях, когда требуется лишь 
небольшое размытие, не приводящее к деградации всего изображения. 
Значительное изменение любого из основных каналов меняет вклад 
цветовой координаты, поэтому может привести к цветовому сдвигу. 

Второй способ сложнее технически, но имеет более широкую область применения. 
Даже при значительных установках размытия он не приводит к заметному 
ухудшению оригинала. 

Размытие канала 

Первым рассмотрим более простой подход. 

1. Откроем изображение. 
2. Сделаем активным поврежденный канал синего цвета. Канал представляет 

интенсивность цветовой координаты в градациях серого цвета, поэтому 
изначально цветная картинка должна превратиться в полутоновую. 

 
 
Рис. 8.7. Диалоговое окно фильтра Gaussian Blur 



3. Выполним команду главного меню Filter => Blur => Gaussin Blur 
(Фильтр => Размытие => Размытие по Гауссу). Постепенно увеличивая 
радиус, уберем все точки постороннего происхождения. Оптимальная 
величина этого параметра обычно подбирается опытным путем, следуя 
принципу "не навреди". Чем выше разрешение изображение, тем большие 
значения радиуса размытия могут быть восприняты изображением 
"безболезненно". Для данного примера методом проб и ошибок было найдено 
рациональное значения радиуса, равное 2,4 (рис. 8.7). 

Размытие по Гауссу - это одна из самых трудоемких операций растровой 
графики. Неслучайно ее часто используют для тестирования технического 
обеспечения вычислительных систем. При обработке изображений большого 
размера изменения, заказанные в диалоговом окне фильтра, могут 
переносится на оригинал с заметной задержкой. 

4. Вернемся к композитному каналу. Для этого достаточно воспользоваться 
комбинацией клавиш Ctrl+2 или щелкнуть по строке палитре Channels с 
пиктограммой RGB. 

5. Размытие канала отчасти подействовало на цветную версию изображения. 
Фильтр применялся к "одной третьей части" изображения, поэтому потеря 
резкости заметна, но не носит критического характера. Повысим резкость 
картинки при помощи фильтра нерезкого маскирования. Он вызывается по 
команде Filter =>Sharpen => Unsharp Mask (Фильтр => Резкость 
=> Контурная резкость). Этот фильтр отличается более сложным 
управлением по сравнению с фильтром Gaussian Blur, его работой 
управляют три независимых параметра: Amount (Эффект), Radius (Радиус) 
и Threshold (Изогелия) (рис. 8.8). Приведем лишь диапазоны значений 
настроечных параметров фильтра: Amount < 150%, Radius = 1, 0 < 
Threshold < 20 (рис. 8.8). 



 
 
Рис. 8.8. Диалоговое окно фильтра нерезкого маскирования 

Два сильно увеличенных фрагмента (400%) фотографии молодого человека, 
показывают разницу между исходным состоянием изображения и его видом после 
обработки (рис. 8.9). 

 
 
Рис. 8.8. Исходное состояние канала синего цвета в сравнении с обработанным 
Размытие слоя 

Привлекательная идея размывания артефактов дефектного канала реализована в 
рассмотренной методике несколько прямолинейно, что существенно сужает 
область ее возможных применений. Легко привести примеры, когда даже 
незначительное размывание канала заметно искажает цветовую гамму 
изображения. Рассмотрим более тонкий способ использования размывающего 
фильтра. Воспользуемся той же фотографией в качестве примера. 

1. Откроем изображение и выведем на экран палитру Layers (F7). 



2. Создадим дубликат слоя Background (Ctrl+J). По умолчанию новый слой 
получит имя Background copy. 

3. Изменим режим наложения нового слоя на Color. Пока это не вызовет 
никаких видимых изменений на экране (рис. 8.10). Вернемся на фоновый 
слой. 

 
 
Рис. 8.10. Структура слоев изображения 

4. Размоем слой Background. Для этого выполним команду Filter => Blur 
=> Gaussian Blur (Фильтр => Размытие => Размытие по Гауссу) и 
подберем такой радиус размытия, который удаляет большую часть дефектов. 
Опытным путем был определен оптимальный радиус размытия, равный 1,7 
(рис. 8.11). 

 
 
Рис. 8.11. Настройка фильтра размытия 



В чем преимущества этого подхода по сравнению с методикой, рассмотренной 
ранее? Самое главное, что в данном случае потребовалось меньшее значение 
радиуса размытия, при равном качестве результата. Несмотря на то, что не 
выполнялись операции непосредственно с дефектным каналом, его состояние 
значительно улучшилось. На рис. 8.12 показаны значительно увеличенные (400%) 
фрагменты изображения до, и после обработки. 

 
 
Рис. 8.12. Состояние оригинала до и после обработки 

Описанная методика допускает различные исполнения. Для некоторых 
зашумленных изображений лучшие результаты дает размытие верхнего слоя, а не 
слоя Background. 

Использование фильтра Dust & Scratches 
Фильтр Dust & Scratches (Пыль и царапины) - это штатное средство 
программы, прямым предназначением которого является удаление мелких 
дефектов. Подобно размывающей кисти и штампу, он является инструментом 
первого ряда, входящим в арсенал и начинающего пользователя и опытного 
цифрового ретушера. 

Принцип действия фильтра - это дозированное размытие, которое часто 
позволяет удачно скрыть мелкие повреждения изображения. Управляют 
работой фильтра два параметра: Radius (Радиус) и Threshold (Изогелия). 
Первый определяет размеры области, в пределах которой действует 
размывание, второй задает минимальную разницу между тоновыми 
уровнями пикселей, которые считаются фильтром различными и 
включаются в обработку. 

Базовая техника 

Рассмотрим технику применения фильтра Dust & Scratches, которая 
рекомендована разработчиком - фирмой Adobe. В качестве полигона для 
демонстрации возможностей этого средства выберем изображение, показанное 
на рис. 8.13. Для правильной постановки диагноза достаточно окинуть оригинал 
одним беглым взглядом. Множество мелких точек небольшого размера покрывают 
поверхность снимка с различной плотностью. Это типовой дефект всех 
фотооригиналов "преклонного возраста". 



 
 
Рис. 8.13. Старая фотография 
1. Выберем такой масштаб изображения, который позволяет увидеть все 

существенный дефекты. Обычно это 100 процентов или более. 
2. Активируем фильтр по команде Filter => Noise => Dust 

& Scratches (Фильтр => Шум => Пыль и царапины). 
3. В диалоговом окне фильтра передвинем регулятор Threshold влево, до 

нулевой величины. Это означает, что программа будет рассматривать все 
пикселы выделения или всего оригинала как различные. 

4. Подберем минимальное значение параметра Radius, удаляющее данный 
дефект или их набор. При этом все изображение может стать чрезмерно 
размытым. 

5. Постепенно увеличивая параметр Threshold, попытаемся убрать чрезмерное 
размытие оригинала. Этот параметр следует увеличивать до тех пор, пока не 
станут появляться удаленные ранее дефекты. Опытным путем были найдены 
значения параметров фильтра, показанные на рис. 8.14. 



 
 
Рис. 8.14. Настроечные параметры фильтра Dust & Scratches 

Сам результат после обработки фильтром показан на рис. 8.15. 



 
 
Рис. 8.15. Изображение, обработанное фильтром 

Состояние картинки после обработки ее фильтром нельзя считать завершенным. 
Предстоит еще большая работа по восстановлению изображения, но с задачей 
удаления белой пыли фильтр полностью справился. 

Выборочная фильтрация дефектов 

Базовая техника удаления дефектов фильтром Dust & Scratches, 
рассмотренная в предыдущем разделе, может быть значительно улучшена за счет 
использования слоев и выделений. На рис. 8.16 показана хорошая в целом 
фотография, но с заметными повреждениями в нижней части. Изображение 
тротуара испещрено мелкими черточками и точками черного цвета. 



 
 
Рис. 8.16. Фотография с дефектами 
1. Выберем инструмент Lasso (L), на панели свойств в поле Feather зададим 

радиус растушевки, равный примерно трем пикселам. 
2. При помощи лассо обведем поврежденную область. Желательно, чтобы 

граница выделения не содержала протяженных прямых фрагментов. В 
отличие от геометрически правильных областей фрагменты нерегулярной 
формы меньше бросаются в глаза. В нашем примере можно создать область 
очень простой формы, включающую в себя и ноги девочки. 

3. Превратим выделенную область в слой. Эта задача проще всего решается 
нажатием клавиш Ctrl+J. 

4. По команде Filter => Noise => Dust & Scratches активируем фильтр. 
5. Следуя патентованной тактике разработчика этого средства, зададим нулевое 

значение параметра Threshold. 
6. Перемещая регулятор Radius, подберем такое значение радиуса, которое 

удаляет большую часть дефектов на изображении тротуара. В данном случае 
поставленную задачу удалось решить при небольших значениях радиуса (рис. 
8.17). 



 
 
Рис. 8.17. Параметры фильтрации 

7. Увеличивать значение параметра Threshold до тех пор, пока не будет 
возвращена текстура тротуара, которая была размыта вместе с чужеродными 
вкраплениями. 

После обработки фильтром в нижней части оригинала остались протяженные 
белые полосы (рис. 8.18). Это штучное повреждение, которое очень просто 
ликвидировать любым из рассмотренных средств технической ретуши ручного 
управления (Clone Stamp, Healing Brush, Patch Tool). Обработанный 
фрагмент снимка, показанный далее, демонстрирует результативность описанной 
методики. 

 
 
Рис. 8.18. Фрагмент обработанного изображения 
Фильтрация разнородных дефектов. Вариант 1 

Фильтр Dust & Scratches - это мощный, но, конечно, не всесильный 
инструмент технической коррекции. Удаление дефектов большого размера может 
внести недопустимые искажения в неповрежденные фрагменты оригинала. На рис. 
8.19 показана фотография с несколькими протяженными царапинами. Попытка их 



удаления при помощи фильтра, согласно методике, описанной в предыдущем 
разделе, оказалась неудачной. Полная ликвидация дефектов потребовала выбора 
слишком больших значений управляющих параметров, что привнесло в оригинал 
заметные искажения. Из этого эксперимента следует очевидный вывод - фильтр 
надо применить избирательно, только в локальных областях расположения 
царапин. 

 
 
Рис. 8.18. Изображение с протяженными дефектами 
1. Активируем фильтр по команде Filter => Noise => Dust & Scratches. 
2. Подберем необходимые значения радиуса и порога по той методике, которая 

описана в предыдущем разделе. Полного удаления царапин удается достичь 
только при больших значениях этих параметров. Окно предварительного 
просмотра (рис. 8.20) показывает, какие значительные искажения при этом 
вносятся в изображение. В результате такой обработки симпатичное личико 
мальчугана стало похоже на застывшую гипсовую маску. 



 
 
Рис. 8.20. Настройки фильтра 

3. Выведем на экран палитру History. По умолчанию она запоминает двадцать 
последних действий оператора. Наш пример потребовал только двух 
операций: первое из них открытие графического файла, второе - это 
применение фильтра. 

4. Поставим пиктограмму кисти в первой колонке у состояния палитры, которое 
называется Dust & Scratches. Сделаем активным первую запись (Open) 
палитры. Это означает, что в исходное состояние изображение может быть 
перенесена графическая информация из состояния, помеченного кистью (рис. 
8.21). 

 
 
Рис. 8.21. Состояние палитры History 



5. Выберем инструмент History Brush (Архивная кисть). Самый простой 
способ его активизации - это нажатие клавиши Y. Чтобы ликвидировать 
светлые дефекты, надо задать для инструмента режим 
наложения Darken (Затемнение). И наоборот, при обработке темных 
дефектных областей следует выбрать режим 
осветления Lighten (Осветление). Установить размер кисти, сопоставимый с 
габаритами обрабатываемых областей. Кисть должна иметь мягкие края. Все 
эти настроечные параметры выбираются из панели Options (Панель 
свойств). 6. Обработать инструментом все поврежденные фрагменты 
оригинала (и только их). Результат показан на рис. 8.22. 

 
 
Рис. 8.22. Изображение после обработки 

Правильное использование фильтра требует точного задания его пара метров, 
которого бывает трудно добиться при перетаскивании регуляторов диалогового 
окна мышкой. Напомним, что ползунки числовых полей можно перемещать по 
нажатию стрелочных клавиш (вверх, вниз). Это соглашение действует в 
большинстве диалоговых окон пакета, и, в том числе, для фильтра Dust & 
Scratches. 

Фильтрация разнородных дефектов. Вариант 2* 

На рис. 8.23 показана фотография с повреждениями разного типа. В ее левом 
верхнем углу заметна чужеродная зернистость, вызванная, по всей видимости, 
какими-то причинами химического характера. Несколько белых царапин с правой 
стороны имеют, очевидно, механическое происхождение. В независимости от 
точности поставленного диагноза, эти повреждения требуют "индивидуального 
лечения". Вряд ли удаться подобрать сочетание параметров фильтра Dust 
& Scratches, эффективно решающее сразу несколько разных задач - удаление 
разнотипных дефектов и сохранение неповрежденных фрагментов изображения. 
Понятно, что этот инструмент надо применять избирательно, с настройками, 
оптимизированными под артефакты разного типа. Использование 
палитры History дает эффективное решение этой проблемы. 



 
 
Рис. 8.23. Изображение в исходном состоянии 
1. Выведем на экран палитру History. 
2. Запустим фильтр Dust & Scratches и в его диалоговом окне подберем 

параметры, ликвидирующие все мелкие дефекты в левом верхнем углу 
фотографии. Состояние царапин при этом можно не принимать во внимание. 
Параметры фильтра, решающие поставленную задачу, показаны на рис. 8.24. 



 
 
Рис. 8.24. Удаление мелких дефектов 

3. Запомним текущее состояние фотографии. Для этого надо щелкнуть по 
кнопке Create new snapshot (Создать новый снимок), расположенной в 
нижней части палитры History. Если при этом удерживать клавишу Alt, то 
программа выведет диалоговое окно New Snapshot (Новый снимок), в 
котором можно задать собственное имя нового снимка. Отличительные имена 
помогают лучше ориентироваться в палитре с большим количеством снимков 
состояний. Назовем текущее состояние Small. 

4. Вернемся к тому состоянию, которое изображение имело до применения 
фильтра. Для этого можно пометить состояние Open палитры History или 
просто воспользоваться стандартной клавиатурной комбинацией Ctrl+Z. 

5. Еще раз вызовем фильтр Dust & Scratches и подберем такие настройки, 
которые удаляют длинные белые царапины с правой стороны снимка (рис. 
8.25). 



 
 
Рис. 8.25. Удаление царапин 

6. Запомним состояние снимка, полученное после удаления царапин. Для этого 
создадим еще один снимок изображения и назовем его Scratches. 

7. Вернемся к стартовому состоянию изображения (Ctrl+Z), которое называется 
в палитре Open. 

8. В палитре History поставим пиктограмму восстанавливающей кисти 
напротив состояния Small. Это означает, что из этого состояния снимка 
графическая информация будет копироваться в исходное, которое имело 
изображение сразу после его открытия (рис. 8.26). 



 
 
Рис. 8.26. Вид палитры History, настроенной на удаление мелких дефектов 

9. Активизируем инструмент History Brush (Y), зададим подходящий размер 
кисти и закрасим кистью верхний левый верхний угол фотографии. В 
результате будут удалены все мелкие дефекты, который в изобилии 
присутствовали в оригинале. 

10. Поставим значок восстанавливающей кисти напротив состояния Scratches. 
При этом активным палитры History должно быть новое состояние под 
названием History Brush (их может несколько, в зависимости от числа 
применений восстанавливающей кисти). При помощи инструмента History 
Brush удалить все царапины в правой части снимка. В нашем примере даже 
не потребовалось менять настройки инструмента. На рис. 8.27 показан тот вид 
палитры History, который она принимает после выполнения последней 
операции, а на рис. 8.28 представлена фотография после обработки. 

 
 
Рис. 8.27. Состояние палитры после выполнения заключительной операции 



 
 
Рис. 8.28. Обработанное изображение 

Палитра History - это своего рода машина времени, встроенная в редактор. Она 
позволяет выполнять глубокий откат и обмениваться графическими данными 
между различными состояниями изображения. Правила такого обмена очень 
просты. Перенос данных выполняется инструментом History Brush (Архивная 
кисть). Источником служит запись палитры, помеченная значком этой кисти, а 
адресатом является текущее состояние, выделенное в палитре синим цветом. 
Источником и адресатом могут быть любые зарегистрированные в палитре 
состояния обрабатываемого изображения. 

На первый взгляд методика может показаться излишне сложной. Но большое 
число повторяющихся операций, выполняемых в фиксированной 
последовательности, - это признак не сложности, а, скорее, громоздкости. Ее 
можно считать равноценной платой за высокую гибкость и универсальность 
процедуры. В частности, она позволяет применять настройки фильтра 
избирательно к разным локальным фрагментам поврежденного изображения. Так, 
в нашем примере удалось полностью избавиться от всех чужеродных артефактов, 
не затрагивая центральные части композиции. 

Ключевые термины 
Инструмент Blur (Размытие) - кисть, которая не окрашивает изображения, а 
избирательно размывает его в заданных тоновых диапазонах. 

Размытие - это ручная или автоматическая процедура усреднения параметров 
точек, принадлежащих некоторой окрестности или выделенной области. 
Обработке размытием могут подвергаться не только яркости пикселов, но и иные 
цветовые или тоновые характеристики, например насыщенность или 
освещенность. 

Размытие по Гауссу - специальный вид размытия, когда сила усреднения 
рассчитывается по закону нормального распределения Гаусса. Этот тип размытия 



во многих случаях является предпочтительным по сравнению с иными 
алгоритмами. Например, размытие по Гауссу используется при создании эффекта 
тумана, длярастушевки границы выделения посредством размытия маски и во 
многих других случаях. 

Фильтр - алгоритмическое средство обработки пикселов. В отличие от 
инструментов, фильтры применяются не избирательно, а массово, ко всем точкам 
изображения или его выделенной области. 

Фильтр Dust & Scratches (Пыль и царапины) - средство для удаления 
артефактов небольшого размера. Принцип действия фильтра - 
дозированное размытие дефектов. Отличается хорошо продуманной технологией 
применения, что исключает оператора от работы "вслепую" методом проб и 
ошибок. 

Фильтр Unsharp Mask (Контурная резкость) - профессиональное средство для 
настройки резкости изображения. Для этого программа ищет границы 
сравнительно однородных фрагментов и повышает их контрастность за счет 
добавления более светлой и темной полос по обе стороны от граничной линии. 
Это создает иллюзию высокой контрастности. 

 



Трансформация. «Умные» объекты. 

Марионеточная деформация 

Содержание: 

1. Команды трансформации;   
2. Puppet Warp (Марионеточная деформация);   
3. Трансформация с учетом контента (содержимого слоя);  
4. Совмещение изображения, выделение фрагментов и трансформациях их с целью 

создания единого образа; 
5. Возможности Smart Objects («Умные» объекты). 

Виды трансформации 

В Photoshop можно трансформировать:  

 часть пикселов изображения: 

 слой (несколько слоев одновременно); 

 выделенную область слоя;  

 выделение, для этого существует специальная команда главного меню. 

Трансформация пикселов слоя 

Команды трансформации действуют на выделенный слой (несколько выделенных слоев) 
или на выделенную область пикселов слоя. 

При действии команды появляется Bounding Box (Габаритный контейнер), перемещая 
маркеры которого вы совершаете различные действия. При этом вся работа в программе 
будет блокирована до применения или отказа от действия команды (контейнер должен 
исчезнуть). 

Для того чтобы применить трансформацию, необходимо нажать клавишу <Enter> или 
сделать двойной щелчок внутри контейнера, а чтобы отменить — нажать клавишу <Esc>. 

Возможно точное задание параметров в панели параметров трансформации. В главном 
меню Edit (Редактирование) есть две команды для трансформации: Transform 
(Трансформирование ) и Free Transform (Свободное трансформирование ). Рассмотрим их 
подробнее и с переводом. 

Команда Edit | Transform 

Эта команда неудобна тем, что каждый вид трансформации вызывается отдельной 
подкомандой (табл). 

Таблица 
Команда Описание, быстрые клавиши 

Again (Применить снова) Повтор трансформации, 
<Shift>+<Ctrl>+<T> 

Scale (Масштабирование) Масштабирование 

Rotate (Поворот) Поворот 

Skew (Наклон) Наклон 

Distort (Искажение) Деформация 

Perspective (Перспектива) Перспектива 

Warp (Деформация) Искажение, изгиб. Возможна 
настраиваемая деформация с 



помощью рукояток и точек 
трансформации 

Rotate 180° (Поворот на 180°) Поворот на 180° 

Rotate 90° CW (Поворот на 90° по 
часовой) 

Поворот на 90° по часовой стрелке 

Rotate 90° CCW (Поворот на 90° 
против часовой) 

Поворот на 90° против часовой 
стрелки 

Flip Vertical (Отразить по 
вертикали) 

Отражение по вертикали 

Flip Horizontal (Отразить по 
горизонтали) 

Отражение по горизонтали 

Команда Edit | Free Transform 

 Эта команда позволяет совершать все виды трансформации (см. табл. 9.1) за одну 
сессию. Вызывается также быстрыми клавишами <Ctrl>+<T>. Различные действия 
выбираются комбинациями быстрых клавиш при перемещении углового маркера: 

<Shift> — пропорциональное масштабирование; 

<Alt> — масштабирование относительно центра; 

<Alt>+<Shift> — пропорциональное масштабирование относительно центра; 

<Ctrl> — искажение; 

<Ctrl>+<Shift> — перспектива; 

<Shift>+<Alt>+<Ctrl> — двухсторонняя перспектива (трапеция);   

<Ctrl>+<Alt> — наклон. 

Потренируемся на примере. Рассмотрим все клавиши. 

1. Откройте файл Бордоский дог_DVD.psd.  

2. Для трансформации всех пикселов слоя выделение загружать не надо. Достаточно 
активизировать слой щелчком по названию. Мы будем работать со слоем Обложка, 
активизируйте его. 

3. Вызовите команду главного меню Edit | Free Transform (Редактирование | Свободное 
трансформирование) или нажмите клавиши <Ctrl>+<T>. 

4. Вокруг слоя появился габаритный контейнер трансформации с маркерами по углам и в 
середине каждой из сторон (Рис.1). Маркеры служат для масштабирования, 
перемещения, искажения, наклона и имитации перспективы. 



 

Рис. 1. Габаритный контейнер трансформации слоя 

 

5. Для масштабирования по одному измерению установите курсор на угловой маркер и 
перетащите его. Маркер перемещается перпендикулярно стороне габаритной рамки, и 
одна из сторон рамки изменяет свой размер. Для пропорционального масштабирования 
нужно удерживать нажатой клавишу <Shift> при перемещении углового маркера. 

6. Для вращения относительно центра подведите курсор к угловому маркеру. Курсор 
должен принять вид изогнутой стрелки. Затем перетащите маркер по диагонали — 
следом за ним вращается слой. 

7. Для искажения перемещайте угловой маркер, удерживая нажатой клавишу <Ctrl>. 

8. Чтобы подтвердить трансформацию, нажмите клавишу <Enter> или сделайте двойной 
щелчок во внутренней области габаритного контейнера. Для отказа от трансформации 
нажмите клавишу <Esc>. Все изменения пропадают. 

9. Для отмены последнего действия, не выходя из самого режима, используйте 
стандартную комбинацию клавиш <Ctrl>+<Z>. Выполните отмену последней операции. 
Область осталась в режиме трансформации, но границы вернулись в состояние, которое 
было до выполнения последнего искажения. 

10. Отмените все искажения и трансформации. 

Создание иллюзии объема при помощи трансформации 

Будем использовать тот же файл Бордоский дог_DVD.psd. 

1. Для трансформации всех пикселов слоя выделение загружать не надо. Достаточно 
активизировать слой щелчком по его названию. Мы будем работать со слоем Боковая 
часть, активизируйте его. 

2. Вызовите команду главного меню Edit | Free Transform (Редактирование | Свободное 
трансформирование). Вы видите, что вокруг слоя появился габаритный контейнер  

трансформации. 

3. Нажав комбинацию клавиш <Shift>+<Alt>+<Ctrl> (трапеция), перетащите правую 
верхнюю угловую точку для придания перспективы. 

4. Отпустите клавиши и перетащите левый средний маркер вовнутрь (Рис. 2). 



5. Получив результат, как на Рис. 2, нажмите клавишу <Enter>, чтобы применить 
трансформацию. 

6. Активизируйте слой Обложка. 

7. Нажмите комбинацию клавиш <Ctrl>+<T>, чтобы вызвать команду Free Transform 
(Свободное трансформирование). 

8. Нажав клавишу <Ctrl> (искажение), тащите левую верхнюю угловую точку вверх до тех 
пор, пока она не совпадет с высотой слоя Боковая часть. Затем выберите левый нижний 
маркер и перетащите его вниз на то же расстояние. Опустите клавишу и перетащите 
правый средний маркер вовнутрь. Получив результат, как на Рис. 3, нажмите клавишу 
<Enter>, чтобы применить трансформацию. 

 

Рис. 2. Создание перспективы для боковой грани 

 

Рис. 3. Схема трансформации слоя Обложка 



9. При активном слое Обложка выполните быстрыми клавишами <Ctrl>+<E> сведение со 
слоем Боковая часть. 

10. Примените к получившемуся слою слоевой эффект Drop Shadow (Тень): двойным 
щелчком рядом с именем слоя вызывается диалоговое окно Layer Style (Стиль слоя), в 
котором настраиваются параметры эффекта Drop Shadow (Рис. 4). 

 

Рис. 4. Применение эффекта Drop Shadow 

Применение искажения 

Команда Warp (Деформация) позволяет выполнять настраиваемую деформацию с 
помощью рукояток и точек трансформации.  

Этикетка на кружке 

Откройте файл Кружка.psd. 

Используя возможности трансформации, мы этикетку поместим на кружку. 

1. Активизируйте слой Картинка. 

2. Нажмите комбинацию клавиш <Ctrl>+<T> (свободное трансформирование). Вы увидите, 
что вокруг слоя появился габаритный контейнер трансформации. 

3. Правой кнопкой мыши щелкните внутри контейнера трансформации — появится 
контекстное меню (Рис. 5). Выберите команду Warp (Деформация). 

4. При помощи рукояток трансформации растяните картинку по форме кружки (Рис. 6). 
Примените трансформацию, нажав клавишу <Enter>. 

5. Установите у слоя Картинка режим наложения Multiply (Умножение); Opacity 
(Непрозрачность) — 87 %, для реалистичности нанесенного изображения (Рис. 7). 



 

Рис. 5. Контекстное меню трансформации 

 

 

Рис. 6. Применение Warp 

 

 

Рис. 7. Изменение параметров слоя Картинка. Результат работы 

Фрукты в вазе 

Откройте файлы Яблоки.jpg и Ваза.jpg из папки Фрукты электронного архива. 

1. В файле Яблоки.jpg выделите яблоки, используя инструмент Elliptical Marquee 

(Овальная область) в режиме суммирования (Рис. 8). 

2. Активизируйте инструмент Move (Перемещение) и перетащите выделенные яблоки в 

файл Ваза.jpg (Рис. 9). 



 

Рис. 8. Выделение яблок 

 

 

Рис. 9. Перемещение выделенных яблок 

3. В файле Ваза.jpg яблоки стали огромного размера из-за несовпадения разрешений 

файлов. Если вызвать команду трансформации, нажав комбинацию клавиш <Ctrl>+<T>, 
границ контейнера не будет видно. 

4. Уменьшите масштаб изображения быстрыми клавишами. Вы увидите границы 
контейнера на сером служебном поле. Удерживая клавишу <Shift> для 
пропорциональности, уменьшите яблоки (Рис. 10). 

5. В контекстном меню контейнера трансформации выберите команду Warp (Деформация) 
для точного размещения яблок (Рис. 11). 

6. Измените параметр Opacity (Непрозрачность) слоя с яблоками до 69% (Рис. 12). 



 

Рис. 10. Уменьшение масштаба для удобства трансформации 

 

 

Рис. 11. Применение команды Warp 

 

Рис.12 Изменение непрозрачности слоя c яблоками 

 



Точная трансформация 

 Когда необходимо точно указать значения параметров трансформации, используется 
панель параметров, которая появляется при нажатии комбинации клавиш <Ctrl>+<T> (Рис. 
13). 

 

Рис. 13. Задание точных значений параметров трансформации 

Smart Objects («Умные» объекты) 

Smart Objects («Умные» объекты) — объекты, в которых помещенная информация 
сохраняет свои исходные характеристики. 

Благодаря Smart Objеct растровые и векторные изображения можно теперь 
масштабировать, искажать без потерь в качестве. Уменьшив объект до любого, даже совсем 
маленького размера, его можно вернуть в первоначальное состояние. 

Способы создания Smart Object: 

 при помещении векторных данных через буфер обмена;   

 при выполнении команды File | Place (Файл | Поместить); 

 несколько выделенных слоев преобразовываются в один Smart Object через 
контекстное меню. 

  Преимущества использования: 

 если это векторные и растровые данные — масштабирование без ущерба качества; 
при нескольких слоях (растровые, текстовые) — совместная трансформация. При 
этом трансформация выполняется сразу со всеми слоями и сохраняется 
возможность изменения многослойного оригинала; 

 вы можете применять операцию Warp (Деформация) одновременно к нескольким 
текстовым слоям в составе Smart Objеct (к нескольким выделенным текстовым 
слоям Warp не применяется). 

  Однако: 

 изображение со значком Smart Objects нельзя редактировать. Все редактирование 
должно вестись с исходным файлом; 

 от Smart Object всегда можно отказаться, превратив его в обычный растровый слой. 

Создание встроенных смарт-объектов 

Встроенные смарт-объекты можно создавать различными способами: с помощью 
команды «Открыть как смарт-объект», поместив файл (CS6) или поместив файл как 
встроенный (CC, CS6), вставляя данные из Illustrator или преобразуя один или несколько 
слоев Photoshop в смарт-объекты. 

Выполните одно из следующих действий. 

 В меню «Файл» выберите команду «Поместить встроенные» для импорта файлов 
как смарт-объектов в открытый документ Photoshop. 

 В меню «Файл» выберите команду «Открыть как смарт-объект», выберите файл и 
нажмите кнопку «Открыть». 

 Чтобы преобразовать выделенный слой в смарт-объект, выберите «Слой» > «Смарт-
объекты» > «Преобразовать в смарт-объект». 



 Чтобы импортировать файл как смарт-объект в документ Photoshop, в приложении 
Bridge в меню «Файл» выберите команду «Поместить» > «В Photoshop». 

 Выберите один или несколько слоев и в меню «Слой» выберите команду «Смарт-
объекты» > «Преобразовать в смарт-объект». Слои объединяются в смарт-объект. 

 Перетащите слои или объекты PDF или Adobe Illustrator в документ Photoshop. 

 Вставьте иллюстрацию из Illustrator в документ Photoshop и в диалоговом окне 
«Вклеить» выберите «Смарт-объект». Для большей гибкости включите поддержку 
форматов — как PDF, так и AICB (без поддержки прозрачности) в разделе 
«Обработка файлов» диалога «Установки» программы Adobe Illustrator. 

Создание связанных смарт-объектов | Photoshop CC 

В Photoshop можно создавать связанные смарт-объекты. Содержимое связанного смарт-
объекта обновляется при изменении исходного файла изображения. Связанные смарт-
объекты особенно удобны при работе в команде или в тех случаях, когда ресурсы 
необходимо повторно использовать в других проектах. 

Выполните следующие действия для создания связанного смарт-объекта: 

1. Выберите пункт меню «Файл» > «Поместить связанные». 
2. Выберите подходящий файл и нажмите кнопку Поместить. 

Связанный смарт-объект будет создан и отображен на панели Слои со значком ссылки 
( ). 

 
Обновление связанных смарт-объектов 

Если внешний исходный файл меняется в тот момент, когда открыт документ Photoshop, 
ссылающийся на него, соответствующий связанный смарт-объект обновляется 
автоматически. Однако при открытии документа Photoshop, содержащего 
несинхронизованные связанные смарт-объекты, для их обновления требуются следующие 
действия: 

 

Щелкните правой кнопкой мыши слой связанного смарт-объекта и выберите пункт 
«Обновить измененное содержимое». 

Выберите пункт меню Слой > Смарт-объекты > Обновить измененное содержимое. 

Связанные смарт-объекты, исходные изображения которых были изменены, визуально 
выделяются на панели «Слои»: 

 
Так обозначаются несинхронизованные связанные смарт-объекты на панели «Слои». 

 
Так на панели «Слои» обозначаются связанные смарт-объекты, у которых отсутствуют 

внешние исходные файлы. 

Исправление неработающей ссылки на смарт-объект 
Чтобы обработать связанный смарт-объект с отсутствующим внешним исходным 

файлом, выполните следующие действия. 

1. Щелкните правой кнопкой мыши значок слоя связанного смарт-объекта и 
выберите Исправить неработающую ссылку. 



2. Перейдите к новой папке отсутствующего объекта. 
3. Нажмите кнопку Поместить. 

Просмотр свойств связанных смарт-объектов 
 

Выберите слой связанного смарт-объекта на панели Слои, затем выберите Окно > 
Свойства. 

Отображаются следующие свойства: 

 Путь к внешнему исходному файлу для связанного смарт-объекта 

 Размер связанного смарт-объекта и координаты расположения (X, Y) 

На панели «Свойства» можно выполнить следующие действия: 

 Редактирование содержимого внешнего файла изображения. При необходимости 
Photoshop открывает внешнее приложение для обработки исходного файла 
изображения. Например, Photoshop открывает Adobe Illustrator, если внешний 
исходный файл имеет расширение .ai. 

 Встраивание связанного смарт-объекта в текущий документ. 

 

Встраивание связанных смарт-объектов 
Выполните одно из следующих действий. 

 Щелкните правой кнопкой мыши слой связанного смарт-объекта на 
панели Слои и установите флажок Встроить связанные. 

 Выберите пункт меню Слой > Смарт-объекты > Встроить связанные. 

 На панели Свойства нажмите кнопку Встроить. 

Упаковка связанных смарт-объектов 
Можно упаковать связанные смарт-объекты в документ Photoshop, чтобы сохранить их 

исходные файлы в папке на компьютере. Копия документа Photoshop сохраняется вместе с 
исходными файлами в папке. 

1. Выберите Файл > Упаковать. 
2. Выберите папку, в которую требуется поместить исходные файлы и копию 

документа Photoshop. 

Вместе с ними упаковываются все связанные смарт-объекты (аудио или видео) в 
документе. 

Нахождение связанных файлов в Photoshop 
 

Photoshop всегда выполняет поиск связанных файлов в последнем известном 
относительном местоположении. Если связанный файл отсутствует в этом 
местоположении, Photoshop выполняет его поиск: 

 В последнем известном абсолютном местоположении 

 С использованием сохраненного псевдонима (только в ОС Mac OS) 

 В той же папке, что и содержащий документ 

Такое поведение позволяет перемещать, копировать и открывать для общего доступа 
папки и файлы проекта с минимальным риском появления неработающих ссылок. 



Преобразование встроенного смарт-объекта в связанный смарт-объект 

Можно преобразовать встроенный смарт-объект в связанный смарт-объект. 
Трансформации, фильтры и другие эффекты, примененные к встроенному смарт-объекту, 
сохраняются в процессе преобразования. 

Выполните следующие действия. 

1. Выберите слой встроенного смарт-объекта в документе Photoshop. 
2. Выберите Слой > Смарт-объекты > Преобразовать в смарт-объект. 
3. Выберите папку на компьютере, в которую требуется сохранить исходный файл. 

Введите имя файла, включая поддерживаемое расширение. 
Например, link_file.jpg. 

Фильтрация панели «Слои» по смарт-объектам | Photoshop CC 

 

На панели «Слои» выберите Смарт-объекты из всплывающего меню фильтрации. 

 

 

 

Фильтрация слоев по смарт-объектам 

Щелкните один из следующих значков: 

     Фильтрация по актуальным связанным смарт-объектам 

     Фильтрация по несинхронизированным связанным смарт-объектам 

     Фильтрация по отсутствующим связанным смарт-объектам 

     Фильтрация по встроенным смарт-объектам 

Можно использовать переключатель ( ), чтобы отключить 
фильтрацию слоев. 

Создание дубликата встроенного смарт-объекта 

 

 На панели «Слои» выберите слой смарт-объекта и выполните одно из следующих 
действий. 

 Для создания дубликата смарт-объекта, который связан с оригиналом, в меню 
«Слой» выберите команду «Новый» > «Скопировать на новый слой» или 
перетащите слой смарт-объекта на значок «Новый слой» в нижней части панели 
«Слои». Изменения, вносимые в оригинал, будут отражаться на копии и наоборот. 



 Чтобы создать дубликат смарт-объекта, не связанный с оригиналом, в меню 
«Слой» выберите команду «Новый» > «Новый смарт-объект через копирование». 
Изменения, вносимые в оригинал, не отразятся на копии. 

 Новый смарт-объект появится на панели «Слои» с тем же именем, как у 
оригинала, и дополнением «копия». 

Редактирование содержимого смарт-объекта 

 

При редактировании смарт-объекта исходный файл открывается либо в Photoshop (если 
содержимое — растровые данные или файл camera raw), либо в приложении, которое по 
умолчанию обрабатывает данный формат (например, Adobe Illustrator или Adobe Acrobat). 
При сохранении изменений в исходном содержимом они отражаются на всех связанных 
экземплярах смарт-объекта в документе Photoshop. 

1. Выберите смарт-объект на панели «Слои» и выполните одно из следующих 
действий. 

o В меню «Слой» выберите команду «Смарт-объекты» > «Редактировать 
содержимое». 

o Дважды щелкните миниатюру смарт-объекта на панели «Слои». 
o На панели Свойства нажмите кнопку Редактировать содержимое. 

2. Нажмите «ОК», чтобы закрыть диалоговое окно. 
3. Внесите изменения в исходное содержимое файла, затем выберите «Файл» > 

«Сохранить». 
4. Photoshop обновит смарт-объект, чтобы отразить внесенные изменения. (Если 

изменения не видны, нужно активировать окно документа, содержащего смарт-
объект.) 

Замена содержимого смарт-объекта 

Можно заменить данные изображения в одном смарт-объекте или в нескольких 
связанных экземплярах. Эта функция позволяет быстро обновлять визуальное оформление 
или заменять подстановочные изображения с низким разрешением на окончательные 
версии. 

1. Выберите смарт-объект, затем в меню «Слой» выберите команду «Смарт-
объекты» > «Заменить содержимое». 

2. Выберите файл, который необходимо использовать, и нажмите кнопку 
«Поместить». 

3. Нажмите кнопку «ОК». 
4. Новое содержимое будет помещено в смарт-объект. 

Преобразование встроенного или связанного смарт-объекта в слой 

 

Преобразование смарт-объекта в обычный слой растрирует содержимое в текущий 
размер. Преобразуйте смарт-объект в обычный слой, только если больше не нужно 



редактировать данные смарт-объекта. После растрирования смарт-объекта трансформации, 
деформации и фильтры, примененные к нему, изменять нельзя. 

 

 Выберите смарт-объект, затем выберите Слой > Смарт-объекты > Растрировать. 

Экспорт содержимого встроенного смарт-объекта 

1. Выберите смарт-объект на панели «Слои», затем в меню «Слой» выберите 
команду «Смарт-объекты» > «Экспортировать содержимое». 

2. Выберите расположение для содержимого смарт-объекта и нажмите кнопку 
«Сохранить». 

3. Photoshop экспортирует смарт-объект в исходном формате, в котором он был 
помещен (JPEG, AI, TIF, PDF или другие форматы). Если смарт-объект был 
создан из слоев, он экспортируется в формате PSB. 

 

Подарки от Adobe: работа с векторными объектами 

Фирма Adobe прислала посылку с подарками: программу Photoshop, кружку для 
чаепития и другие сувениры с логотипами компании на всех местах (Рис. 14). Откройте 

файл Подарки_от_Adobe.psd. 

 

Рис. 14. Файл Подарки_от_Adobe.psd 

1. Откройте файл Start.jpg. 

2. Выполните команду File | Place (Файл | Поместить), указав файл Наклейка.ai. 

3. В диалоговом окне Place  (Открыть смарт объект) нажмите кнопку OK. В файл 
поместилась наклейка в габаритном контейнере. С помощью габаритного контейнера и 
используя необходимые быстрые клавиши (<Shift> — для пропорциональности; 
движение с <Ctrl> за правый верхний угол контейнера вверх — для искажения), 
поместите наклейку на боковой грани. 

4. Сделайте двойной щелчок внутри контейнера (или нажмите клавишу <Enter>) для 
применения трансформации. В палитре Layers (Слои) в пиктограмме слоя Наклейка 
появится значок, показывающий, что на слое находится Smart Object (объект, который 



можно изменять, трансформировать без ущерба качества в программе Illustrator (в 
нашем случае объект векторный)). 

5. Для реалистичности печати установите у слоя Наклейка режим наложения Мultiply 
(Умножение). Белый цвет наклейки исчезнет. Изображение будет таким, как на Рис. 15. 

6. Выполните команду File | Place (Файл | Поместить), указав файл Логотип.ai. 

7. Примените команду и согласитесь с трансформацией: скопируйте слой с логотипом 
(<Ctrl>+<J>) (Рис. 16). Как вы заметили, можно Smart Object скопировать, как 
обыкновенный слой. 

8. Трансформируйте логотип на верхней грани, не изменяя режим наложения  

(Рис. 17). 

 

Рис. 15. Слой Наклейка в режиме наложения Мultiply 

 

Рис. 16. Два слоя со Smart Object с логотипом 



 

Рис. 17. Размещение логотипа на коробке 

9. Второй логотип будем размещать на кружке для чаепитий. 

10. Для чашки простого масштабирования недостаточно. Необходима трансформация 
Warp (Деформация). Однако векторным объектам Smart Object трансформация Warp 
недоступна. 

11. Выполните команду главного меню Layer | Smart Objects | Rasterize (Слои | Смарто-
бъект | Растрировать), переведя логотип в обыкновенный растровый слой. 

12. Выполните трансформацию Warp. 

13. И, наконец, поместите логотип на кружку, установив режим наложения Мultiply 
(Умножение) (Рис. 18). 

 

Рис. 18. Добавление логотипа на чашку 
 

Использование Smart Objects в сложной трансформации 

В данном примере мы рассмотрим такое преимущество Smart Objеct, как совместная 
трансформация файла формата PSD, а также возможность изменения многослойного 
оригинала. 

Рассмотрим задачу рекламиста: размещение на тумбе плаката. 

1. Откройте файл Тумба.jpg. 

2. Выполните команду File | Place (Файл | Поместить), указав файл Плакат.psd. 



3. Пропорционально уменьшите плакат, также при помощи трансформации Warp 
(Деформация) разместите плакат на тумбе. Согласитесь с трансформацией. Заметьте, 
что вы совершали искажения одновременно нескольких слоев (в том числе текстовых), 
что в обыкновенном файле невозможно. 

4. Установите параметр Opacity (Непрозрачность) равным 81% у слоя с плакатом. 

5. Предположим, вам необходимо изменить что-либо на плакате. Сделайте двойной 
щелчок по пиктограмме слоя со Smart Objеct. Откроется окно с загруженным файлом с 
плакатом. 

6. Включите отображения другого слоя, выключив из видимости слой с какой-либо 
текстовой надписью. 

7. Сохраните файл открытого Smart Objеct (<Ctrl>+<S>) с плакатом. Заметьте: все 
изменения передались в файл с тумбой. 

Трансформация выделения 

Для трансформации выделения существует специальная команда главного меню Select | 
Transform Selection (Выделение | Трансформировать выделенную область), а пикселы 
здесь ни при чем. 

Допустим, у вас есть выделенная область на пустом слое. Вы выполняете команду 
главного меню Select | Transform Selection. Появляется габаритный контейнер, к которому 
применимы все те же действия и клавиши, которые мы рассматривали ранее. 

Марионеточная деформация Puppet Warp 

Марионеточная деформация отображает визуальную сетку, с помощью которой можно 
существенно деформировать определенные фрагменты изображения, не затрагивая других 
областей. Иногда, для удобства настройки, сетку отключают. Данный метод может иметь 
множество применений: от легкой ретуши изображения (например, придания формы 
волосам) до полной трансформации (например, изменения положения рук или ног, 
изменения формы объекта). 

Марионеточную деформацию можно применять к слоям изображения, тексту, маскам, 
векторным маскам (чтобы применить к изображениям искажение, не затрагивая оригинал, 
используйте Smart Objects (Умные объекты)). 

1. Откройте файл Человек.psd. 

2. Выполните команду Edit | Puppet Warp (Редактирование | Марионеточная деформация) 
при активном слое с деревянной куклой. На панели параметров появятся настройки 
деформации, а человечек будет покрыт сеткой (Рис. 19). 

Панель параметров (Рис. 20) имеет настройки: 

• Mode (Режим) определяет эластичность сетки в целом. Режим Distort (Искажение) 
используется для того, чтобы получить очень эластичную сетку для обертывания 
широкоугольных изображений или карт текстур; 

• Density (Частота) определяет расстояние между узлами сетки; 

• Expansion (Расширение) расширяет или стягивает внешний край сетки; 

• Show Mesh (Сетка) позволяет отображать сетку. 



 

Рис. 18. Сетка марионеточной деформации 

 Чтобы временно скрыть «булавки» коррекции, нажмите клавишу <H>. 

  Снимите флажок с Show Mesh (Сетка) на панели параметров марионеточной 
деформации. 

 

Рис. 19. Панель параметров марионеточной деформации 



3. Щелкните в окне изображения, чтобы добавить «булавки» в трансформируемых 
областях и в местах, которые требуется закрепить на месте (Рис. 20). 

 

Рис. 20. Добавление «булавок» для деформации.  Рис. 21. Изменение положения «булавок» 

4. Перетащите булавку для изменения положения руки (Рис. 21). 

 Чтобы изменить перекрытие частей тела человека, необходимо нажать кнопку Pin Depth 
(Глубина) на панели параметров. 

 Чтобы удалить выбранные булавки, нажмите клавишу <Del>. Чтобы удалить другие 
булавки по отдельности, наводите на них курсор, нажимайте клавишу <Alt> и при 
появлении значка ножниц щелкайте по ним. 

 Чтобы повернуть булавку, выделите ее, нажмите клавишу <Alt> и удерживайте курсор 
рядом с булавками, но не над ними. Когда появится круг, выполните перетаскивание, 
чтобы повернуть «на глаз». 

5. Выполните изменение тела человечка так, как показано на Рис. 22. 

В файле Человек_сравнение.psd представлены стартовый и итоговый варианты  

(Рис. 23). 



 

Рис. 22. Вариант изменения положения рук и ног 

 

 

 Рис.  23. Сравнение работы 



 

Рис. 24. Веревка для деформации Рис. 25. Веревка деформированная 

Чтобы закрепить навыки использования данного метода, выполните упражнение. 

Откройте файл Веревка.psd (Рис. 24). 

Попробуйте изменить изображение веревки с помощью команды Puppet Warp 

(Марионеточная деформация), как в файле Веревка_итог.psd (Рис. 25). 

На Рис. 26 представлен пример выполнения сложного задания по завязыванию морского 
узла. 

В папке Pappet Warp есть примеры морских узлов для сложного задания. 

 

Рис. 26. Морской узел, завязанный средствами Photoshop 

Масштабирование с учетом содержимого Content-Aware 

Scale 

Масштаб с учетом содержимого позволяет изменить размер изображения, не затрагивая 
важные части, например, людей, здания, животных и т. д. При обычном масштабировании 
все пикселы обрабатываются одинаково, а при масштабировании с учетом содержимого в 
основном затрагиваются пикселы, не содержащие важного визуального материала. 
Масштабирование с учетом содержимого позволяет увеличить или уменьшить размер для 
выбора оптимальной композиции. 



Если при изменении размера изображения требуется сохранить определенные области, 
то эти области заранее сохраняются, как отдельный альфа-канал, с помощью которого 
можно обезопасить это содержимое. 

Откройте файл Сравнение масштабирования.psd. 
Сравните в слоях результат обыкновенной трансформации и масштабирования с учетом 

содержимого — результат удивляет. 

1. Итак, файл Сравнение масштабирования.psd уже открыт (Рис. 27). 

2. При активном слое Start выполните команду Edit | Content-Aware Scale 
(Редактирование | Масштаб с учетом содержимого). Вокруг слоя появится контейнер 
трансформации. Однако при масштабировании за правый боковой маркер вы увидите, 
что море сокращается при неизменном дереве и вышке спасателей (Рис. 28). 

 

Рис. 27. Море без трансформации 

 

Рис. 28. Действие масштаба с учетом содержимого — моря 



 При достаточно большом масштабировании будут изменяться шезлонги. Чтобы важные 
части изображения были защищены, необходимо заранее их выделить и задать как 
альфа-канал. Отмените масштабирование. 

3. Выделите шезлонги и сохраните выделение в альфа-канале (Рис. 29). 

 

Рис. 29. Сохранение выделенных объектов в альфа-канале 
4. Выполните команду Edit | Content-Aware Scale (Редактирование | Масштаб с учетом 

содержимого), выбрав в панели параметров в выпадающем списке Protect (Защищать) 
название канала с объектами. 

При масштабировании объекты будут защищены (Рис. 30). 

 

Рис. 30. Защита объектов при масштабировании 



Также существует возможность при помощи нажатия на панели параметров кнопки 
Protect Skin Tones (Защищать телесные тона) защищать области, содержащие цвета, 
близкие к оттенкам кожи. 

Откройте файл Люди.psd. 
Данное изображение — это фотография берега моря красивейшего острова Родос, где из 

воды выходят три человека (Рис. 31). 

1. Выполните команду Edit | Content-Aware Scale (Редактирование | Масштаб с учетом 
содержимого), нажав на панели параметров кнопку с человечком Protect Skin Tones 
(Защищать телесные тона). 

2. Начните масштабировать фотографию. При масштабировании объекты будут 
защищены. 

 

Рис. 31. Фотография с объектами «цвета человеческой кожи» 
 



«Гламурная» 
корректировка



Начальная модель



Удаление дефектов кожи
• Инструментом Healing Brush (Восстанавливающая кисть) 

удаляем крупные дефекты



Гладкость кожи
1. Создать копию слоя Удаление пятен.
2. Применить к слою-копии фильтр Filter | Blur | Surface Blur

(Фильтр | Размытие | Размытие по поверхности), размыть 
изображение. Параметры Amount (Значение) и Threshold
(Порог) зависят от вида и разрешения изображения. (В 
данном случае подходят 6 и 11).

3. Для слоя с размытой кожей добавить слой-маску. 
Инвертировать маску — клавишами (команда Image | 
Adjustments | Invert (Изображение | Коррекция | Инверсия)). 
При инвертировании маски слой с размытием не виден, 
размытие не применяется.

4. Кистью белого цвета порисовать в активной маске на участках 
кожи с дефектами, не затрагивая глаза, губы, волосы. Это 
позволит сохранить общую четкость изображения.

Выступающий
Заметки для презентации
Практически во всех алгоритмах подавления шумов, дефектов, муара, улучшения�кожи и т. п. используются фильтры размытия. Алгоритм снижения резкости используется не только в цифровой обработке, но и активно применяется фотографами еще на�стадии съемки за счет частичной расфокусировки.



Гладкость кожи



Добавление шумов для 
создания фактуры кожи

1. Создать новый слой. Залить его командой Edit | Fill
| 50% Gray (Редактирование |
Выполнить заливку | 50% серый). Установите 
режим наложения Overlay (Перекрытие).

2. К новому серому слою добавьте шумы фильтром 
Filter | Noise | Add Noise (Фильтр |
Шум | Добавить шум) со значением Amount
(Эффект) равным 2,1. Эти действия необходимы 
для создания будущей фактуры кожи.

3. Чтобы слой распространял свое действие только 
на кожу, надо создать маску отсечения



Добавление шумов для 
создания фактуры кожи



Повышение контраста лица
1. Создайте копию слоя с размытой кожей. 

Маску не удаляйте. Она позволит 
распространить повышение контрастности 
только на лицо, исключив волосы.

2. Установите режим наложения Overlay
(Перекрытие), Opacity (Непрозрачность) —
27% 



Повышение контраста лица



Имидж платиновой блондинки.
Перекрашивание волос. 

• Выделение волос в режиме быстрой маски.



Перекрашивание волос



Перекрашивание волос
• Установите режим наложения Screen (Экран). 
• Для придания естественного пепельного 

отлива создайте корректирующий слой 
Hue/Saturation (настройки на следующем 
слайде)

• Чтобы коррекция ограничивалась только 
нижележащим слоем, выполните операцию 
отсечения.



Перекрашивание волос



Меняем цвет глаз
Существуют два варианта перекрашивания: рисование 
цветом в режиме Color (Цветность) и использование 
корректирующего слоя цветовой коррекции. Используем 
корректирующий слой Hue/Saturation.
1. Используя инструмент Elliptical Marquee

(Эллиптическая область), выделите оба
глаза, установите легкую растушевку.

2. Создайте корректирующий слой Hue/Saturation
(Цветовой тон/Насыщенность)
(параметры на следующем слайде)

3. Для реалистичности синих глаз установите у 
корректирующего слоя режим наложения Overlay
(Перекрытие), Opacity (Непрозрачность) — 89%.



Меняем цвет глаз



Подводка глаз
1. Создайте новый слой.
2. Выберите кисть диаметром 3 пиксела, 

установите параметр Opacity
(Непрозрачность) равным 30%.

3. Легкими штрихами подведите глаза



Подводка глаз



Подводим брови
1. Создайте новый слой. Установите 

параметр Opacity (Непрозрачность) 
равным 15%.

2. Кистью коричневого цвета проведите 
линию бровей.



Подводим брови



Губы с блеском
1. Скопируйте губы со слоя Удаление пятен в отдельный слой.
2. Создайте корректирующий слой Curves (Кривые) и осветлите 

изображение. Установите режим наложения Screen (Экран).
3. Создайте еще один корректирующий слой Curves (Кривые), но 

на этот раз затемните изображение. 
4. Инвертируйте слой-маски обоих корректирующих слоев так, 

чтобы они были заполнены черным цветом.
5. Кистью белого цвета с прозрачностью 50% порисуйте в маске 

слоя Свет там, где хотите добавить блеска. Затем той же 
кистью порисуйте в маске слоя Тень там, где хотите затемнить 
губы. Данный алгоритм повсеместно используется для 
придания блеска на любых частях тела.



Параметры корректирующего 
слоя Curves для блеска губ



Губы с блеском



Итоговый вариант блондинки



Имидж рыжеволосой.
Перекрашивание волос. 

• Выделение волос в режиме быстрой маски.



Перекрашивание волос



Меняем цвет глаз и подводим 
брови



Красим губы

Обведите кистью губы. 
Цвет — RGB (168; 80; 54)



Наносим тени

1. Создайте новый слой.
2. Установите у нового слоя режим наложения 

Soft Light (Мягкий свет).

3. Кистью светло-коричневого цвета с 
прозрачностью 20—30% порисуйте на слое



Итоговый вариант рыжей



  

Лабораторная работа 8 

Тема: Разработка макета персонального сайта в графической 

среде Adobe Photoshop 

 
Цель работы: научиться применять технические элементы дизайна при 
разработке макетов сайтов, а также изучить возможные способы компоновки 
информационных блоков сайта. 
 
Постановка задачи: В графическом редакторе Adobe Photoshop разработать 
макет персонального сайта, который включает следующие элементы: 

- фон; 
- заголовок сайта; 
- меню сайта (вертикальное или горизонтальное по усмотрению студента) 
- два – три информационных блока для левой и правой части 

соответственно; 
- информационный блок для центральной части страницы; 
- завершающую часть сайта. 

 
Этап 1: Разработка композиции макета 

При разработке сайтов для крупных компаний или порталов, 
содержащих большое количество функций (ленту новостей, форму 
авторизации и т.д.) первым Этапом является разработка макета. Хорошим 
тоном при создании любых Интернет-ресурсов является визуальная 
схожесть всех его страниц. Непрофессиональным подходом считается, 
например, использование разного фона на отдельных страницах сайта или по-
разному оформленных заголовков. Изначально сайт должен восприниматься 
пользователем как единое целое. В применении к корпоративным и 
персональным сайтам, которые, как правило, содержат несколько десятков 
страниц, это означает, что для каждой страницы сайта должен использоваться 
один и тот же макет. В большинстве случаев при разработке макета отводится 
место как для общих элементов, которые будут отображаться на всех 
страницах, так и для индивидуальных, которые составляют контент страницы. 

Содержимое макета для сайта компании, которое является общим для 
всех страниц, должно подчеркивать индивидуальные особенности компании, 
выделять ее род деятельности так, чтобы у пользователя, посетившего сайт 
такой компании, складывалось ассоциативное впечатление о ее деятельности 
еще до того, как он прочитает заголовок страницы. При этом в общих 
элементах макета стараются размещать такой графический материал, который 
ассоциативно связан с родом деятельности компании. Например, для сайта 
компании, занимающейся транспортными перевозками, в качестве 
графического материала можно использовать изображения карты.  



  

В этом случае команда разработчиков в крупной компании включает 
дизайнеров, верстальщиков и программистов. Задача дизайнера заключается в 
подготовке макета сайта в любом графическом редакторе, задача 
верстальщика – в подготовке шаблона HTML кода, задача программиста – 
наполнение сайта динамически меняющимся содержимым (например, 
разработка динамического содержимого каждой страницы). Кроме того, в 
команду разработчиков могут входить редакторы и корректоры, задача 
которых заключается в разработке контента сайта, а также тестировщики, 
которые выявляют возможные ошибки в отдельных модулях сайта или 
портала. Исправляют эти ошибки, как правило, программисты. 

Макет как корпоративного, так и персонального сайта может 
разрабатываться в любом графическом редакторе. Профессионалы, в 
основном используют Adobe Photoshop и Adobe Illustrator. Первый 
программный продукт идеально подходит для создания макета, а второй 
используется при разработке логотипов и других векторных изображений, 
которые используются на сайте. 

В традиционных сайтах макет включает следующие общие блоки: 
заголовок сайта, левую и правую часть, которые содержат наиболее свежую и 
актуальную информацию для пользователя, завершающую часть, которая 
содержит сведения о разработчике, счетчики, время генерации страницы (для 
динамических сайтов), дату последней модификации и т.д. (рис. 1). Меню 
сайта может располагаться в заголовке или левой части, иногда меню сайта 
размещают также в правой части, хотя встречается это редко.  

Индивидуальным блоком макета, фактически, является только 
центральная часть, которая содержит уникальную в рамках страницы 
информацию. Этот блок конструируется так, чтобы он мог содержать 
произвольную информацию. 

При разработке композиции макета сайта важно определить, сколько 
страниц будут включать сайт, какая информация будет располагаться в левой 
и правой части, сколько пунктов будет содержать основное меню сайта и т.д. 
Эта информация является основополагающей при разработке композиции и в 
дальнейшем не должна изменяться. Если, например, в горизонтальном меню 
увеличится количество пунктов, то меню просто не поместится в отведенное 
место. Такие ситуации недопустимы. 

 
Заголовок сайта 

(содержит логотип, баннеры, название сайта, фирменный знак, меню пользователя и т.п. Иногда в 
шапке может присутствовать поиск и контактная информация) 



  

Левая часть 
(имеет фиксированный 
размер – от 150 до 250 
пикселей и содержит 

регистрационные формы, 
ленту новостей и т.п.) 

Центральная часть 
(содержит основной документ. На 

главной странице может размещаться 
поясняющий текст, объясняющий 

пользователю, на какой сайт он попал и 
каковы его основные возможности. Если 
сайт состоит из нескольких страниц, то 

хорошим тоном при верстке сайта 
является изменение только этой части 

макета) 

Правая часть 
(имеет фиксированный размер 

от 150 до 250 пикселей и 
содержит менее актуальные 

для пользователя 
интерактивные элементы: 
голосование, статистику 
сайта, ссылки на другие 

источники, баннеры) 

Завершающая часть 
(содержит информацию о разработчиках, времени последней модификации, логотипы, время 

генерации страницы и др. элементы) 

Рис.1. – Структурная схема макета персонального сайта 
 
Этап 2. Выбор фона для сайта 

Как правило, при разработке макета сайта используют ненавязчивый 
фон. Если на фон необходимо поместить изображение, то обычно 
используются различные комбинации однородного цвета (или градиента) и 
изображения. Изображение не может выступать в качестве самостоятельного 
фона, поскольку в этом случае фон может получиться слишком ярким, 
содержащим большое количество цветовых оттенков, и создавать у 
пользователя неверное впечатление. Поэтому фоновое изображение следует 
предварительно подготовить. Такая подготовка может включать 
обесцвечивание рисунка, увеличение яркости или регулировку его 
прозрачности на фоне однородного цвета. Кроме того, необходима также и 
тоновая коррекция изображения, если однородный цвет отличается от серого 
цвета.  

Для разработки макета сайта в среде Photoshop обычно создают новое 
изображение, ширина которого не меньше минимально допустимой 
разрешающей способности монитора.  

Так как сайт рассчитан, прежде всего, на многоцелевую аудиторию, то 
оптимальная ширина макета лежит в пределах 850-950 пикселей. Появление 
горизонтальной полосы прокрутки при низком разрешении монитора – 
признак неудачной композиции сайта. Высота макета – произвольная 
величина и зависит только от размеров заголовка сайта и нижней части. 
Оптимальная высота – 500 пикселей. 

Подготовленный при выполнении Этапа 2 фон помещают на самый 
нижний слой макета в среде Photoshop. 
 
Этап 3. Разметка информационных блоков макета 

Разметка информационных блоков макета является логическим 
продолжением композиции макета. Цель такой разметки заключается в 
определении размеров для каждого блока и наведении границ каждого блока. 
Если в дальнейшем границы макета не будут задействованы в окончательном 
варианте макета, они все равно необходимы, так как это в дальнейшем сильно 
облегчит этап верстки сайта. 



  

Разметка информационных блоков выполняется исключительно 
инструментом “Карандаш” с шириной кисти в 1 пиксель. Использование 
других инструментов, например, “Линия” неуместно, поскольку в дальнейшем 
при растеризации контур линии получается размытым. Именно в данном 
случае говорят о так называемом “техническом” дизайне, подчеркивая, в 
первую очередь, точность и четкость изображения. Любой, правильно 
выполненный, макет сайта обязательно содержит элементы технического 
дизайна. На рис. показан фрагмент разметки информационных блоков для 
сайта, посвященного поиску заказов на перевозку крупногабаритных грузов. 

 

 
Рис. 2 – Пример разметки информационных блоков сайта (фрагмент) 

 
Следует отметить, что в зависимости от разрешения экрана, сайт может 

иметь разные размеры. Исходя из этого, при разработке макета сайта 
необходимо, чтобы некоторые элементы сайта не имели четкого 
фиксированного размера, т.е. были динамическими. Если сайт построен по 
традиционной схеме (см. рис. 1), то обычно фиксированными оставляют 
левую и правую часть, а вот ширина центральной части меняется в 
зависимости от размеров окна браузера. В заголовке и нижней части сайта 
также должны существовать “резиновые” элементы. В заголовке сайта 
динамичность элементов, как правило, достигается за счет 
периодического повторения однородного фонового изображения 
заголовка. Поэтому в любом заголовке сайта такие динамические элементы 
обязательно должны присутствовать. 

Если сайт содержит горизонтальное меню (как, например, на рис. 2), то 
динамичность элементов меню достигается, либо за счет промежутков между 
пунктами меню, либо за счет изменения размеров самих пунктов меню. 
Изменение размеров не всегда целесообразно, поэтому в большинстве случаев 
используется первый вариант. 
 
Этап 4: Разработка заголовка сайта 



  

Для разработки заголовка сайта необходимо подобрать графический 
материал, который приблизительно соответствует тематике и общей 
направленности ресурса. Например, при разработке игрового портала  для 
заголовка можно использовать изображение колоды карт или шахматной 
доски. Кроме того, заголовок обязательно должен содержать фрагмент 
изображения, которым можно замостить часть заголовка, чтобы создать 
иллюзию динамичности. Для этого лучше всего использовать симметричную 
штриховку фона или горизонтальные линии, как показано на рис. 3. При 
разработке заголовка сайта грузоперевозок, изображенного на рисунке 3, были 
использованы только два изображения, взятые из Интернета: изображение 
фуры и фото площади Белорусского вокзала (г. Минск). Дорога, тротуар, 
бордюры и оба бигбоарда были получены средствами Photoshop. Так, дорога 
и тротуар получаются из серого фона с добавлением шума и белых 
разметочных полос с последующим искажением для придания трехмерного 
представления, а бордюры – серые линии. Для обеспечения динамичности 
заголовка использована область, отмеченная на рис. 5 красным 
прямоугольником. При изменении размеров сайта у пользователя создается 
впечатление, что изменяются размеры бигбоарда, расположенного у 
противоположного края дороги, края которого скрывает меню сайта. Наконец, 
при помощи эффекта слоя “Отбросить тень” удалось придать объем заголовку 
сайта в целом. На бигбоардах, а также на фуре можно поместить логотип и 
название компании, а также ссылки общего назначения, такие как “Добавить 
в избранное”, “Сделать стартовой и т.д.” 
 

 

 
Рис. 3 – Заголовок сайта 

 
Этап 5. Разработка меню сайта и заголовков информационных блоков 

Меню сайта – пожалуй, самый простой элемент, который либо 
завершает заголовок сайта (если меню горизонтальное), либо выступает в 
качестве самостоятельного элемента, если меню расположено слева или 
справа. Если меню сайта выступает как часть заголовка, то очень часто первый 



  

пункт меню повторяет контур заголовка. Это создает некоторые проблемы при 
верстке, однако такой сайт выглядит намного красивее. Сам факт осознания 
того, что контур меню повторяет контур заголовка, создает целостность 
картины в целом. Для придания объема самому меню используют 
градиентную заливку. При этом в качестве исходных цветов используются 
цвета, которые не слишком отличаются друг от друга, например желтый и 
оранжевый, голубой и синий, либо оттенки одного и того же цвета. 

Так как меню является интерактивным элементом, при разработке важно 
предусмотреть минимум три состояния у каждого из элементов меню: 
обычное состояние, подсвеченное состояние и нажатое (или фиксированное) 
состояние, которое показывает, какая страница сайта является текущей. На 
рисунке 4 показаны два из трех возможных состояний. 

Заголовки информационных блоков обычно оформляются в той же 
цветовой гамме, что и меню, так как цель каждого заголовка – привлечь 
внимание пользователя к тому или иному блоку. Заголовки на рис. 4 
выполнены в той же цветовой гамме, однако разделение на две 
горизонтальные полосы отсутствует, чтобы подчеркнуть их 
индивидуальность. 

 
Рис. 4 – Готовый макет сайта (фрагмент) 

 
Этап 6 (заключительный). Разработка нижней части сайта 

В нижней части сайта, как правило, располагаются сведения об авторе 
страницы, счетчики посещений, дата последней модификации и другая 
информация, которая является вторичной по своей природе.  

 
 
Советы к дизайну 
Цветовые сочетания, цвет 
Цвет определяется темой самого сайта. Цвет должен гармонировать с темой. 
Как правило, основная часть сайта должна состоять из светлых цветовых 
сочетаний, а в шапку, подвал и меню можно добавить яркие, либо темные 
цвета.  



  

Цвета, недопустимые в основной части сайта: 
- неоновые кричащие (желтый, салатовый, бирюзовый, красный, оранжевый, 
малиновый); 
- все темные цвета (черный, темно-синий, коричневый, темно-зеленый и т.д.). 
Градиенты 
В дизайне сайта допускаются следующие градиенты: 
- от белого к любому пастельному цвету (светло-серый, бежевый, светло-
голубой, светло-розовый и т.д.); 
- цветовые оттенки от светлого к темному (например, от синего к темно-
синему, от светло-серого к серому). 
Не допускаются: 
- от белого к любому цвету (красный, зеленый, синий и т.д); 
- радужные и разноцветные градиенты (от синего к красному, от оранжевого 
к фиолетовому и т.д). 
Также можно использовать популярный сегодня градиент web 2.0, который 
подчеркивает глянцевость градиента. Он применяется в меню, иконках и 
иногда шапке. 
Цветовая гамма 
Цветовая гамма сайта должна подчеркнуть его направление, а также быть 
привлекательной для пользователя, чтобы он как можно дольше оставался на 
сайте. 
Советы по созданию цветовой гаммы: 
Сильная гамма (яркость) – красный (оттенки красного) + чб монохром, 
фиолетовый, синий, желтый; 
Живая гамма (молодежность) – красный, оранжевый, зеленый, бирюза, беж, 
фиолетовый; 
Дружественная (гармоничность) – оранжевый, коричневый, желтый, синий, 
беж, розовый; 
Радушная (элегантность) – желто-оранжево-коричневый, светло-зеленый, 
синий, фиолетовый; 
Волнующая (движение) – желтый, синий, фиолетовый, зеленый, оранжевый; 
Классическая (стабильность) – оттенки синего (насыщенный синий), 
насыщенный красный, оранжевый, кораллово-красный; 
Энергичная (молодость) – фиолетовый, зеленый, оранжевый или желтый, 
фиолетовый + монохром, пурпурный, красный; 
Профессиональная (техника) – монохром + цвет. 
Для создания определенной цветовой гаммы выбираем не больше трех 
предложенных цветов. 
Шрифты 
Шрифты, наиболее употребляемые в дизайне сайтов для меню и основной 
текстовой информации – Arial и Calibri.  
Шрифты с засечками употребляются, когда надо подчеркнуть классичный 
дизайн сайта. 
Удачные курсивные шрифты для меню и позаголовков – Monotype Coursiva 
иArial Italic. 



  

Для шапки возможно использование любых шрифтов, основное требование 
для них – читабельность. 
Цвет шрифта должен контрастировать с цветом фона сайта (светлый фон, 
темный шрифт). 
Картинки и клипарты 
Картинки и клипарты на сайт можно применять разные, подходящие по теме 
сайта. Главное требование – хорошее качество картинки. 
 
Задание 

Используя подробную методику по созданию макета сайта подготовить 
в графическом редакторе Adobe Photoshop макет сайта по теме курсовой 
работы. 

Если курсовая работа не подразумевает использование сайта, то можно 
подготовить макет вашего персонального сайта. При этом, при разработке 
меню сайта учесть, что сайт должен содержать 7-8 страниц:  

- главная. На данной странице впоследствии будет размещаться краткая 
автобиография объемом 300-400 слов, резюме и фотография; 

- мои проекты. На данной странице будут размещены графические 
материалы, выполненные в прошлом семестре при изучении курса “Системы 
графического дизайна” и другим курсам. Оформление каждой работы должно 
включать текстовое описание, скриншот и ссылку на загрузку; 

- мой софт. Эта страница должна содержать свежие ссылки на 
программы, которыми Вы чаще всего пользуетесь. Оформление каждой 
работы должно включать текстовое описание, скриншот и ссылку на загрузку; 

- мои увлечения. На этой странице следует поместить информацию о 
Ваших хобби. Если имеются готовые работы в данной области, можно также 
выложить и фотографии Ваших работ. Любите паять – выложите несколько 
электронных схем, придуманных собственноручно, нравится спорт – можно 
разместить несколько фотографий с тренировками, в которых Вы участвовали 
и т.д. 

Оставшиеся 3-4 страницы придумайте самостоятельно. Например, 
можно выложить сведения о Вашей работе, планах на будущее, Вашей 
успеваемости в школе, техникуме, лицее и т.д. 

В информационных блоках левой и правой части можно разместить: а) 
ленту новостей, б) ссылки на сайты друзей или одногруппников; в) карту 
сайта; г) счетчики посещаемости; д) ссылки на любимые сайты. Размещать 
регистрационную форму не следует, так как данный цикл лабораторных работ 
не предусматривает работу с сервером, а любая регистрационная форма – это 
взаимодействие с сервером. Главное требование – разрабатываемый сайт 
должен быть полностью функциональным, на нем не должно быть 
несуществующих работ или нерабочих ссылок. 



Растровая графика
Photoshop

Тема 11. 

Вывод изображения на печать



Содержание 
• Основные представления о цветной печати

• Цветоделение

• Типографский растр

• PostScript-драйвер принтера

• Разрешение и линиатура растра

• Муар

• Треппинг и печать с наложением

• Создание печатного документа в Adobe Photoshop

• Настройка параметров печати Photoshop



Основные представления о 
цветной печати
• Цветная печать - способ 

воспроизведения на бумаге (ткани или 
другом материале) многокрасочных 
изображений. Выполняется с помощью 
специальных фотоформ (клише), число 
которых соответствует числу печатных 
красок

Выступающий
Заметки для презентации
Так, при трехцветной печати применяют три основные краски: жёлтую, голубую и пурпурную (CMY). Для передачи тёмных цветов этих красок (или их оттенков) недостаточно и приходится прибегать к четвертой краске - чёрной (blacK). В этих случаях печать называется четырехцветной (CMYK).



Основные представления о 
цветной печати
• Многокрасочный оттиск получают 

последовательным переносом соответствующей 
краски с формы (клише) на лист бумаги с точным 
совмещением границ изображения. Печатание 
выполняется на много- или однокрасочных 
печатных машинах в один или несколько приёмов 
(прогонов). Профессиональная полиграфическая 
печать документов предполагает использование в 
макете растрированных и цветоделенных
иллюстраций.



Цветоделение

• Цветоделение есть разделение цветов 
изображения на формы (или пленки) для 
печати на типографском станке. Другими 
словами, цветоделение разбивает цвета на 
составляющие, что необходимо для печати 
публикации в типографии. При совмещении 
базовых цветов все цвета публикации 
комбинируются и образуют на печатном 
оттиске композитное изображение.

Выступающий
Заметки для презентации
При цветной печати для изготовления каждого клише (фотоформы) необходимо получить так называемый цветоделенный негатив. Иначе говоря, оригинал-макеты для цветного изображения должны быть представлены в виде нескольких пленок (форм): по одной для каждой наносимой краски. Разделение цветного изображения на отдельные краски (сепарации) называется цветоделением. При этом любой цвет в оригинале представляется сочетанием базовых цветов, взятых в разных пропорциях.




Цветоделение
• Цветоделение происходит следующим образом: 

исходный оригинал освещается белым светом, 
между оригиналом и экспонируемой фотопленкой 
последовательно устанавливают светофильтры. 
Красный светофильтр генерирует Голубую (Cyan) 
сепарацию, зеленый фильтр - пурпурную 
(Magenta), синий фильтр используется, чтобы 
генерировать Желтую (Yellow) сепарацию. Черная 
сепарация получается путем совмещения всех 
трех.



Типографский растр

• При печати цветоделенные формы 
(сепарации) переносятся на бумагу базовой 
краской одного цвета - полутоновыми 
растрами.

• Растр - периодически (линейно) или 
хаотически (стохастически) повторяющихся 
набор точек различной величины, создающих 
иллюзию плавных полутоновых переходов.

Выступающий
Заметки для презентации
Если под увеличением рассмотреть отпечатанное в типографии изображение, то видно, что оно - точечное, т.е. состоит из растровых точек. В линейном растре точки равноудалены. При популярном сегодня частотно-модулированном (стохастическим) растрировании точки растровой сетки располагаются на разном расстоянии друг от друга. Таким образом, при печати изображение растрируется. В компьютерных издательских системах растрирование проводят с использованием аппаратных и программных средств. Растрирование - обязательный элемент печати. В подавляющем большинстве случаев задача растеризации возлагается на само устройство вывода - PostScript принтер или фотонаборный автомат (ФНА). Растеризатор встроен в интерпретатор языка описания страниц PostScript, используемого типографским принтером.




Типографский растр
• При растровой печати печатание оттисков производится с 

формы, на которой изображения состоят из растровых 
печатающих элементов. В полиграфии используются 
различные формы растровых точек, наиболее традиционная и 
широко распространенная - круглая. Когда растровая точка 
черная, то для передачи полутонов (оттенков) используется 
изменение размеров точек растра и расстояний между ними. 
Большие черные точки с малыми расстояниями между ними 
создают впечатление темных тонов, а мелкие точки с 
большими белыми пространствами между ними создают 
иллюзию светлых оттенков. Так, например, 20 процентов серого 

создается не с помощью соответствующей 20-процентной серой печатной 
краски, а с использованием черной печатной краски, покрывающей только 20 
процентов от поверхности области, занятой этим оттенком.

Выступающий
Заметки для презентации
Фотонаборные автоматы - дорогостоящие и сложные устройства, покупку которых может позволить себе не каждое издательство. Все фотонаборные автоматы используют язык PostScript и имеют в несколько раз более высокое разрешение печати, чем лучшие принтеры. 
[слайд]
На растр влияет не только разрешение принтера, но и сорт бумаги. Чем ровнее и плотнее поверхность бумаги, тем лучше передаются полутона. Так, газетная бумага имеет очень грубую структуру и высокую степень растекания (растискивания) краски. На качестве растра сказываются также тип печатной машины и сорт типографской краски.




PostScript-драйвер принтера

• Для типографии оригинал-макет должен 
быть представлен на прозрачной пленке в 
натуральную величину. Вывод документа на 
пленку осуществляется с помощью 
фотонаборного автомата - аналога лазерного 
PostScript принтера с разрешением порядка 
3600 dpi. PostScript-драйвер принтера 
сообщает операционной системе как 
перевести публикацию на язык PostScript.

Выступающий
Заметки для презентации
PostScript - это формат, который часто используется для подготовки файлов, предназначенных для профессиональной печати. 



PostScript 
• PostScript (Пост скрипт) - язык высокого уровня 

для описания страниц, стандартный 
командный язык управления фотонаборными 
аппаратами. 

• Позволяет детально описать характеристики и 
расположение любых элементов, таких как шрифты, 
линии, изображения, кривые и т.д., на странице 
издания для отображения на экране дисплея или 
устройстве вывода, оборудованном интерпретатором 
языка PostScript.

Выступающий
Заметки для презентации
Постскрипт - разработка компании Adobe Systems. Является стандартом де-факто в области издательских систем. 
При создании файла PostScript все объекты публикации, включая разметку, иллюстрации и шрифты, преобразуется в PostScript - язык, который PostScript-принтеры используют для печати графики высокого разрешения. Спецификации PostScript лицензированы практически всеми производителями лазерных принтеров и фотонаборных автоматов, а также разработчиками программного обеспечения для издательских систем и подготовки документов. Windows содержит PostScript-драйверы многих из принтеров и такой PostScript-драйвер можно установить, даже не имея PostScript-принтера как реального устройства в наличии.




Достоинства PostScript-принтеров
• можно задавать параметры растрирования при печати: линеатуры и 

углы растрирования для каждой выводимой формы;

• непосредственная загрузка в принтер шрифтов Type 1. При печати на 
прочих принтерах шрифты будут преобразованы в контуры 
(переведены в кривые);

• адекватное отображение инверсного текста. Для прочих принтеров 
требуется установить режим печати шрифтов как графики, что 
значительно увеличивает время печати и требует больших ресурсов 
принтера;

• высокая точность и отсутствие погрешностей при выводе на печать 
повернутых и искаженных изображений. Можно печатать в 
произвольным масштабе, зеркально, и по несколько сверстанных 
страниц на одном листе.



Разрешение и линиатура
растра

• Разрешение (dpi) - количество реальных 
точек, которое может напечатать принтер 
на единичном отрезке длиной 1 дюйм.

• Линиатура растра (lpi, lines per inch) -
количество растровых точек на 1 дюйм 
или 1см (шаг сетки растра)

• Большинство газетных иллюстраций печатается с растром 75 lpi, а 
журнальных - 133 lpi (133 точки в каждой строке изображения).

Выступающий
Заметки для презентации
При повышении линиатуры растра менее заметной становится растровая структура изображения и лучше воспроизводятся мелкие детали изображения. Очевидно, что от линиатуры растра зависит видимое качество иллюстраций. Чем выше линиатура, тем менее заметны образующие растр точки, и отпечаток ближе к оригиналу. Большинство газетных иллюстраций печатается с растром 75 lpi, а журнальных - 133 lpi (133 точки в каждой строке изображения).



Муар

Растрирование имеет два аспекта:

• пространственная частота растра определяет 
тоновый диапазон и уровень детальности, 
достижимый в окончательном отпечатанном 
изображении

• угол поворота растра определяет объем 
информации, которую должно содержать 
изображение для получения хорошего качества 
печати.

Выступающий
Заметки для презентации
Простейшим случаем цветной печати является использование плашечных цветов. В этом случае каждый из плашечных цветов изображения выводится на отдельную пленку. При работе с плашечными цветами фактически выполняется растрирование, при котором интенсивность цвета уменьшается пропорционально интенсивности точек полутонового растра. Традиционно угол наклона при печати монохромных документов и печати плашечными цветами составляет 45° - это значение обеспечивает наилучшую маскировку (скрытие) линейной структуры растра, что проверено на практике.



Муар
• Краски модели CMY(K) называются также 

триадными.

• Полноцветные документы выводятся с 
помощью фотонаборного автомата на четыре 
пленки, соответствующие базовым цветам.

• Каждый из них растрируется отдельно с 
различными углами наклона растровой 
сетки. 



Муар

Стандартные углы:

• 15 градусов для голубого;

• 75 градусов для пурпурного;

• 0 градусов для желтого;

• 45 градусов для черного.

Выступающий
Заметки для презентации
Такие углы наклона растров базовых цветов при печати триадными (CMYK) красками позволяют образовать нормальный оттиск и избежать возникновения муара. Иначе говоря, при такой величине углов пятна, формирующие напечатанные изображения, глаз наблюдателя легче смешивает, как бы сливая их вместе и растровая структура изображения менее заметна.



Муар
Если углы наклона растров не согласованы, 
появляется муар (интерференционный паразитный 
узор - брак цветовоспроизведения). 
В конечном итоге углы наклона растров должны быть 
подобраны так, чтобы точки базовых цветов группировались в 
виде полиграфических розеток. Каждую такую розетку 
можно рассматривать как некую точку цветного растра, 
образующую цвет в данной точке изображения. 
Так, например, при цветной печати "узор" из 16-ти пурпурных точек, 16-ти 
жёлтых и 32-х пустых (то есть белых) по законам смешения цветов дадут 
светлый оранжевый цвет.

Выступающий
Заметки для презентации
Принятые по умолчанию углы наклона растров, соответствующих базовым триадным цветам, подобраны на основе многолетнего опыта, и для их изменения нужны очень весомые причины. 



Треппинг

Треппинг (Trapping) - процесс 
компенсации неточности приводки при 
печати, в результате которой могут 
появиться зазоры между пересекающимися 
объектами. Треппинг заключается в 
создании узкой полоски смешения цветов 
на границе объектов разного цвета.

Выступающий
Заметки для презентации
Другими словами, треппинг - это незначительное растягивание одного из смежных объектов разных цветов, так что граничащие цвета немного накладываются. Возникающий при наложении третий цвет будет ближе к более темному из них. Форма объекта может от этого слегка исказиться.
При отсутствии треппинга между смежными цветами могут возникать белые или цветные зазоры. Этот способ печати, как и печать с наложением, применятся для компенсации механических погрешностей печатного станка.




Треппинг

Приемы треппинга:

• сжатие (choking), или внутренний треппинг,

• растяжение (spreading), или внешний 
треппинг. 

Сжимается или растягивается, как правило, цветовой 
объект, более светлый. Если перекрывающий объект 
светлее фона, делается внешний треппинг, а если фон 
светлее объекта, в фоновом цвете цвета немного 
стягиваются внутрь - внутренний треппинг.

Выступающий
Заметки для презентации
Итак, при печати в несколько красок нужно, чтобы цвета располагались друг относительно друга точно, то есть были приведены. 
Треппинг - один из способов выполнения приводки. Он применяется для улучшения качества печати на печатных машинах. Печатная машина является механическим устройством. 
Печатный лист, проходя через машину, растягивается, деформируется при нанесении на него краски, может двигаться неравномерно, смещаться в стороны. Причем в каждом конкретном случае искажения при печати могут быть разными. Если вы проведете треппинг публикации, то возникающие при такой цветной печати дефекты будут не так заметны.




Печать с 
наложением (Overprint)
Если мы для иллюстрации назначим объекту 
обводку, т.е. присвоим атрибут печати с 
наложением с помощью команды Overprint, то 
обводка будет печататься вдоль границы 
объектов. Этим и достигается устранение 
неточной приводки форм.
Этот способ эффективен при печати черных или темных 
объектов поверх светлых объектов, а также при печати 
мелких объектов.

Выступающий
Заметки для презентации
Второй способ компенсации погрешности приводки форм - печать с наложением (Overprint). Если мы для иллюстрации назначим объекту обводку, т.е. присвоим атрибут печати с наложением с помощью команды Overprint, то обводка будет печататься вдоль границы объектов. Этим и достигается устранение неточной приводки форм. Overprint (печать поверх или печать с наложением) применяется при печати объектов и текста на цветном фоне. Этот способ эффективен при печати черных или темных объектов поверх светлых объектов, а также при печати мелких объектов.




Задания треппинга в Adobe
Photoshop

• Открыть RGB изображение в Adobe Photoshop.
• Командой Image (Изображение) | Mode (Режим) 
| CMYK Color (Модель CMYK) конвертировать 
изображение к печати в цветовую модель CMYK.
• Выполнить команду Image (Изображение) | Trap
(Треппинг) и задайте ширину треппинга (Width-Ширина) 
и его размерность (Trap Units-Единицы треппинга).



Создание печатного 
документа в Adobe Photoshop
Разрешение большинства принтеров:

• Струйные - от 300 до 600 точек на дюйм;

• Лазерные PostScript - 600 точек на дюйм;

• Профессиональные устройства 
фотовывода PostScript - 1200 точек на 
дюйм или выше.

Выступающий
Заметки для презентации
Большинство домашних пользователей Photoshop ограничиваются печатью изображений на цветном струйном принтере. Для простейших типов изображения, таких, как черно-белый рисунок, используется только один цвет, выбранный из оттенков серого. Такие изображения можно печатать на домашнем лазерном принтере. При профессиональной типографской печати изображения, содержащие более одного цвета, необходимо выводить на отдельные печатные формы: одна форма под каждый цвет. Как уже отмечалось выше, данный процесс, именуемый цветоделением, обычно сводится к печати чернилами основных четырех цветов CMYK-палитры: голубой, пурпурный, желтый и черный. Photoshop позволяет пользователю задавать параметры формирования печатных форм.
Детализация напечатанного изображения зависит от разрешения самого изображения (в пикселах на дюйм) и разрешения принтера (в точках на дюйм). Пользователи, не являющиеся типографскими работниками или сотрудниками студий печати, как правило, используют для печати настольные принтеры, а не устройства фотовывода. Разрешение большинства струйных принтеров приблизительно составляет от 300 до 600 точек на дюйм. Разрешение большинства настольных домашних лазерных принтеров PostScript составляет 600 точек на дюйм, а разрешение профессиональных устройств фотовывода PostScript - 1200 точек на дюйм или выше.




Создание печатного 
документа в Adobe Photoshop
В Photoshop CS5 имеются следующие 
команды вывода на печать:

Печать Выводит диалоговое окно "Печать", в котором 
можно просмотреть общий вид изображения и 
задать параметры. Настроенные пользователем 
параметры печати сохраняются как новые 
значения по умолчанию при нажатии 
кнопки "Готово" или "Печать".

Печать одного экземпляра Осуществляет печать одного экземпляра 
изображения без открытия диалогового окна 
настройки печати

Выступающий
Заметки для презентации
Большинство домашних пользователей Photoshop ограничиваются печатью изображений на цветном струйном принтере. Для простейших типов изображения, таких, как черно-белый рисунок, используется только один цвет, выбранный из оттенков серого. Такие изображения можно печатать на домашнем лазерном принтере. При профессиональной типографской печати изображения, содержащие более одного цвета, необходимо выводить на отдельные печатные формы: одна форма под каждый цвет. Как уже отмечалось выше, данный процесс, именуемый цветоделением, обычно сводится к печати чернилами основных четырех цветов CMYK-палитры: голубой, пурпурный, желтый и черный. Photoshop позволяет пользователю задавать параметры формирования печатных форм.
Детализация напечатанного изображения зависит от разрешения самого изображения (в пикселах на дюйм) и разрешения принтера (в точках на дюйм). Пользователи, не являющиеся типографскими работниками или сотрудниками студий печати, как правило, используют для печати настольные принтеры, а не устройства фотовывода. Разрешение большинства струйных принтеров приблизительно составляет от 300 до 600 точек на дюйм. Разрешение большинства настольных домашних лазерных принтеров PostScript составляет 600 точек на дюйм, а разрешение профессиональных устройств фотовывода PostScript - 1200 точек на дюйм или выше.




Настройка параметров печати 
Photoshop CS5

http://www.intuit.ru/EDI/17_08_15_4/1439763591-611/tutorial/1023/objects/8/files/08_02.jpg
http://www.intuit.ru/EDI/17_08_15_4/1439763591-611/tutorial/1023/objects/8/files/08_02.jpg


Диалоговое окно Печать
• Для помещения изображения в центр области печати - параметр "По 

центру".

• Для задания положения изображения самостоятельно, снять 
флажок "По центру" и ввести значения 
параметров "Сверху" и "Слева" или перетащить изображение в 
области предварительного просмотра.

• Чтобы подогнать размер изображения под размеры области печати 
выбранного носителя - "Подогнать под формат листа".

• Чтобы задать масштаб изображения в числовом виде - значения 
параметров "Высота" и "Ширина".

• Чтобы задать желаемые размеры изображения -
параметр "Ограничительная рамка", затем перетащить рукоять 
ограничительной рамки в область предварительного просмотра.
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